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ABSTRACT
Ultra low-k dielectric films are expected to widely replace SiO2 as the interlayer
dielectric for the next-generation microelectronic devices.

A challenge facing the

integration of these dielectrics in manufacturing is their interactions with gaseous
contaminants, such as moisture and isopropanol, and the resulting change in their
properties. Moisture retained in the film not only has detrimental effect on the k value of
the film but also causes reliability and adhesion problems due to gradual outgassing. The
physical and chemical interactions of moisture with porous spin-on and chemical vapor
deposited (CVD) dielectrics are investigated using temperature- and concentrationprogrammed exposure and purge sequence together with trace moisture analysis, using
atmospheric pressure ionization mass spectrometry.
The model compounds in this study are porous Methylsilsesquioxane and Black
Diamond II films, deposited and treated under typical manufacturing conditions.
Transmission Electron Microscope (TEM) studies showed that etching and ashing
processes resulted in the formation of two layers, a damaged layer and non-damaged
layer, which significantly changed moisture interaction properties.
Moisture sorption and desorption studies showed that as compared to SiO2 these
films not only have a higher uptake capacity but also a slower and more activated
moisture removal process. This could be a significant problem in successful integration
of these films in IC manufacturing process.
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A process model was developed that provided information on the mechanism and
kinetics of moisture uptake and release in thin porous films. The model elucidated the
effect of film properties on the contamination uptake as well as outgassing. The model is
a valuable tool for designing an optimum process for contamination control and removal
in porous films.
Another concern in IC manufacturing is the outgassing of impurities of
electropolished stainless steel (EPSS) surfaces used in UHP gas distribution system.
Moisture interaction with EPSS surface is studied in sub ppb range. A fundamental
model was developed to study the mechanism and kinetics of moisture uptake and release
from EPSS. The model developed would be a valuable tool for designing an optimum
process for contamination control and to predict the moisture dry down performance of
large-scale, systems.
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CHAPTER 1
INTRODUCTION

1.1 BACKGROUND
The last several decades have seen a rapid growth of the electronics industry,
which has primarily been driven by continuous shrinkage in device dimensions in
integrated circuits [1]. In the year 1965, Gordon Moore forecasted that the number of
transistors per chip will double in every 18 months [2, 3]. This later came to be known as
Moore’s Law and since then it has been the driving force of the industry. The motivation
of the industry to keep up with Moore’s Law has seen a growth from several thousands of
components per chip to millions of components per chip as shown in Figure 1.1 [4].

Figure 1.1 Moore’s law [4]
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This has resulted in enhanced performance through as increase in speed, reduction in
manufacturing cost and increase in chip complexity because of the greater number of
functions per unit area. In the last several years the electronics industry has slowly
migrated from the microelectronics era to nanoelectronics era with device dimensions
approaching less than 100 nm.
There are three main components which make up a device [5]. The heart of the
device is the semiconducting material. Silicon has been the microelectronics industry’s
semiconducting material of choice although, for some fast analog applications and for
optoelectronics devices III – V, semiconductors such as GaAs and InP are used [6]. .

Figure 1.2 Typical cross-section of multilevel interconnects [7]
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Metals form the second component of the device and it is primarily used as gate
metallization, metal interconnects and contacts. Metal lines are used to connect millions
of transistors on a chip. Figure 1.2 shows the schematic of a microprocessor with several
interconnect levels [7]. Present microprocessors consist of 8 – 10 metallization layers.
The last component of the device is the dielectrics layers. These dielectric layers are
classified into three different groups. First, the active dielectric layers: these films are
mainly used as gate oxide [8] and capacitor dielectric in memory devices [9]. Their main
function is for storage of charge.
The second groups of dielectrics are those which are used during device
processing.

These could be etch stop layers for etching and chemical mechanical

planarization processes, barrier layers to prevent metal diffusion or other impurities, and
anti-reflection coatings (ARC) for photolithography step. Their function mainly ends
after the device formation, and in some case can be detrimental as it increases the
effective dielectric constant value [5].
Insulating layers make up the last group of dielectric layers. These could be used
as gap-fill dielectric in shallow trench isolation application i.e. to isolate two neighboring
transistors [10]. In modern technology, these shallow trenches have a very high aspect
ratio, and gap fill is a challenge in order to avoid key hole formation and to fill gaps with
such high aspect ratio which in some cases could be 10:1 or more. Insulating layers are
also used as a passivation layer during electronic packaging applications to isolate the
device from ambient. These layers have to be very robust and hard, for long usage of the
device. Lastly, insulation is needed to isolate metal lines which are used as interconnects.

37

These could be used for isolating two metal lines at the same level known as inter metal
dielectric or to isolate two metal lines at different levels known as interlevel dielectrics.
These two kinds are normally known as interlayer dielectrics (ILDs) [11].
Materials have been an important and integral part of microelectronics industry.
With the industry demands and requirements keep changing there is a constant need for
development of new materials and the ability to process them, so that, it will be useful in
device fabrication.
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1.2 NEED FOR NEW DIELECTRIC MATERIALS
The continuing decrease in the dimensions of microelectronics devices presents
significant manufacturing complexities and challenges [12]. So far, silicon dioxide has
been the dielectric of choice as inter-layer dielectric material.

However, with the

decrease in feature size, SiO2 is rapidly approaching its limits in satisfying the required
dielectric properties. For Moore’s Law (doubling of the number of transistor every
eighteen months) to continue, new interlayer dielectric materials are needed to address
problems in the next generation of integrated circuits [13].
International technology Roadmap for Semiconductors 2006 update suggests that
for future technologies, new materials with dielectric constant value of 2 or less would be
required to address the increasing demand of the semiconductor industry. Table 1.1
shows the dielectric constant value requirement for MPU and ASIC Interconnect
technologies.

Table 1.1

MPU and ASIC interconnect technologies requirements [1]

Year of Production

2006

2007

2009

2011

2012

2013

3.1-3.4

2.7-3.0

2.5-2.8

2.5-2.8

2.1-2.4

2.1-2.4

2.6-3.0

2.3-2.7

2.1-2.4

2.1-2.4

1.8-2.1

1.8-2.1

ILDs – effective
dielectric constant
ILDs – bulk
dielectric constant
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•

2007 - 2011: Manufacturable solutions are known

•

2012 - 2013: Manufacturable solutions are NOT known
With the decrease in device dimensions, the switching speed in a MOSFET (metal

oxide silicon field effect transistor) is likely to increase i.e. the intrinsic gate delay
decreases as the channel length decreases. However the signal propagation delay or the
RC delay tends to increase. RC delay is associated with the metal interconnects, which
are the basic charge carriers between transistors and the insulating layers, ILDs, between
two metal layers forms the capacitance.
In 1995, M. Bohr developed a simple model to show the effect of RC delay [14].
Figure 1.3 shows the equivalent circuit for interconnect delay, where T is the thickness of
the line and P is the line pitch. CLL is the capacitance between two metal lines in the
same layer and Cv is the capacitance between metal lines in different layers [15]. RC
delay [14, 16] for the combined circuit is given by
RC = 2ρkεo (4L2/P2 + L2/T2)

…1.1

where, ρ is the metal resistivity, εo is the vacuum permittivity, k is the dielectric constant,
and L is the line length. As can be seen from the equation, with the P and T decreasing
RC is increasing, which affects the clock time.
So the only way to decrease RC time or increase speed is achieved by decreasing
the resistivity of the metal lines and the dielectric constant value of the ILDs. This has
motivated the industry to move from Al to Cu as the metal line and from SiO2 to low-k
materials for ILDs. Resistance-capacitance delay could be reduced by the integration of
Cu with low-k dielectrics [17-20]. Substitution of SiO2 with low-k materials can reduce
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the RC delay by up to 75% for materials with k values close to 1 [21]. Figure 1.4 shows
the change of different delay time as the feature sizes decreases and driving force for the
use of Cu and low-k dielectric films [22].

Upper Metal Layer
CLL

Interconnect Metal Layer

T
P

Cv

Lower Metal Layer
Figure 1.3 A typical interconnect element [15]

Figure 1.4 Effect of integration of Cu/low-k on total delay time [22]
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Another potential benefits for using low-k dielectric materials is to address the
issue of power consumption. With the increasing frequencies there is an exponential
increase in power consumption as shown in Figure 1.5 [23].
There are two factors which contribute to the power. One is dynamic power as given by
the following equation [5, 24].
P = (1/2)*fd*C*V2*f

…1.2

where, fd is the fraction of gates that switch during clock period, C is the capacitance, V
the supply voltage and f the operational frequency. Since C is proportional to k, therefore
by reducing k power consumption can be reduced. The other factor is the static power
which is due to the leakage current between metal lines [24]. Thus, new dielectric
materials should be such that they have low leakage currents. Another factor which
drives the use of low dielectric constant material is reduction in cross talk noise. We
know, N ~ C ~ k. Thus lowering k will reduce cross talk noise.

Figure 1.5 Increase in power consumption with each technology [23]
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Therefore, for Moore’s Law to keep going low dielectric constant materials are to
be the key enabler. New low dielectric constant (low-k) interlayer materials are needed
to be developed along with development of processes to address problems with power
consumption, signal propagation delays, and cross-talk between interconnects in the next
generation of integrated circuits [25, 26]. A comprehensive study is needed in order to
successfully integrate these new films in IC manufacturing.
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1.3 DIELECTRIC PROPERTIES
Finding the right interlayer dielectric materials to replace SiO2 has been a
challenge.

The influence of the dielectric constant on the system performance as

mentioned in previous section is significant. This has resulted in considerable research in
developing new dielectric materials with decreasing k values. However, the requirements
for compatibility with damascene processing imposed on these materials are very strict
and implementation of materials is often hindered by lack of process compatibility as
scaling of feature size progresses [24].

Several researchers have categorized the

properties requirements for ILD in four groups: electrical, mechanical, chemical and
thermal. Table 1.2 lists the requirements for the ILD’s [27-29]. Therefore, there is a
need to study the behavior of these low-k films from the aspect of these properties for it
to be successfully implemented in IC manufacturing.
Dielectric constant k, also called relative permittivity, is the ratio of permittivity
of the substance to that of free space. The dielectric constant of a material is increased if
it contains polar components (such as polar chemical bonds) which act as electric dipoles.
In the presence of external electric field these dipoles align themselves, thus adding the
electric field of every dipole to the overall electric field. Therefore, materials with higher
dielectric constant value will hold more charge which in turn would increase the
capacitance. In order to lower k value of the film several strategies can be used mainly
by reducing the dipole strength and by decreasing the density of material. There are very
few atoms in the periodic table of elements which can be used successfully to reduce the
dielectric constant of the material.
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Table 1.2 Low-k dielectric properties requirements [27-29]

Electrical

Mechanical

Chemical

Thermal

Isotropic k<3

Film

High chemical

High thermal

@1MHz

thickness/uniformity

resistance

stability, Tg

High etch

Low thermal

selectivity

expansion

Low moisture

Low thermal

absorption

shrinkage

Low solubility of

High thermal

H2O

conductivity

Good adhesion to
Low dissipation

metal and other
dielectrics

Low leakage current

Low charge trapping

Low stress

High hardness

High electric field

Low gas
Low shrinkage

strength
High reliability

permeability
High tensile modulus

High purity

High dielectric
No metal
breakdown voltage >

High crack resistance
corrosion

2 –3 MV/cm
Compatible with
High storage life
CMP
ESH compatible
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These atoms must have low polarizability such as C and H and high electronegativity
such as F [30]. Figure 1.6 shows the possibilities of reducing the k values of the films.
Industry has already developed certain low-k materials where Si-O bonds have been
replaced by less polar Si-F or Si-C bonds.

Several organic polymers have been

developed by using non-polar bonds such as C-C and C-H as low-k materials.

Reduction of k

Decreased
Polarizability

Decreased
Density

Less Polar
Bonds

Constitutive
Porosity

Subtractive
Porosity

Si-F
Si-C
C-C
C-H

Self-organized
free volume

Selectively
removed
material

Figure 1.6 Strategies of reducing k values of dielectric films [32]

Another approach for reducing dielectric value is by lowering the density of the
material by introducing a bulky group such as CH3 groups or by making the film porous.
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International Union for Pure and Applied Chemistry defines the nomenclature which
could be used to classify materials as constitutively porous or substractively porous.
Constitutively porous materials are those materials which self organize resulting
in pore formations without any additional treatment. Films formed by self rearrangement
results in porosity around 15% and pore sizes are roughly ~1 nm in diameter. On the
other hand, subtractive porous materials are those in which a certain portion of the
material is selectively removed to create pores. Subtractive porous low-k films can be
formed by either incorporating sacrificial materials [31] such as porogen which is
removed by annealing or by selective etching (e.g. Si-O bonds in SiOCH materials are
removed by HF).

Figure 1.7 Idealized pore structure. (a) cylindrical pores; (b) voids between packed
spheres; (c) closed (latent) pores; (d) ink bottle; (e) funnel; and (f) open pores [24].

Subtractive porous films can be formed with porosity as high as 90% and pore
sizes varying from 2 nm to tens of nanometers. According to IUPAC definitions pore
sizes less than 2 nm are considered as micropores where as, pores sizes between 2 nm
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and 50 nm are considered as mesopores.

Ultra low-k materials can be formed by

subtractive porosity.
Pore structure and interconnectivity of pores are important geometrical properties
in order to interpret characterization results. Figure 1.7 shows idealized pore structures
[24]. Porosity is defined as the ratio of the free volume formed by the pores or the pore
volume and the total volume of the film: ε = Vp/V. Vp is the pore volume and V is the
total volume of the film. Pores could be both open and close. Air, which has the
dielectric constant value of ~ 1, would be the ultimate dielectric also called air gaps to be
used ILDs. However, there are several challenges to overcome before this could be a
feasible option.
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1.4 CLASSIFICATION OF LOW-k DIELECTRICS
Wide varieties of low-k dielectric materials, which can be both porous and nonporous, are now available. They can be classified into two main groups: Si- (or more
precisely, Si-O) containing and non-Si-containing (mostly organic polymers and
amorphous carbon).
The former can be further divided into two subgroups: Silica-based and
silsesquioxane-based [32-34]. Figure 1.8 illustrates the basic classification of low-k
materials.

Porosity in low-k materials could be constitutive porosity or subtractive

porosity. Table 1.3 lists some of the candidates for low-k films.

Table 1.3 Interlayer dielectric candidates [20, 35]

Materials

Deposition Method

Dielectric Constant, k

SiO2

CVD

3.9-4.5

Fluorosilicate glass (FSG)

CVD

3.2-4.0

HSQ

Spin-on

2.7-3.1

MSQ

Spin-on

2.7-3.1

Black Diamond

CVD

2.2-2.7

Coral

CVD

2.2-2.7
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Parylene-F

CVD

2.4-2.5

Nanoglass

Spin-on

1.8-2.5

Porous MSQ

Spin-on

1.8-2.2

Porous SiLK

Spin-on

1.5-2.0

Porous Black Diamond

CVD

2.3-2.6

Air Gaps

1.0

Low-k
Materials

Non-Si
Based

Si-Based

Polymers
Amorphous
Carbon

Silica-Based

SSQ-Based

SiOF

HSSQ

SiOCH

MSSQ

Figure 1.8 Classification of low-k materials [32]
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1.4.1

Silica Based Materials
SiO2 has a tetrahedral basic structure, in which, each Si atom is bonded to four O

atoms and each O atom is bonded to 2 Si atoms, as shown in Figure 1.9. SiO2 has a
dielectric constant value of ~ 4, and it has a pretty dense structure with high thermal and
chemical stability, because of which it had been the choice of industry as ILDs. With the
requirements of ILDs becoming more stringent with decreasing feature size, the first
approach used by industry was to reduce the k value of SiO2, as it was pretty well
understood, by introducing less polarizable bonds.

Figure 1.9 Basic structure of: (a) SiO2 and (b) C doped silica glass [32]

In order to reduce the k value of SiO2, O atoms are replaced by low polarizable
atoms such as C and H or bulky group such as CH3 which reduces ionic polarization and
produces organosilicate glass (OSG). Introduction of CH3 groups not only reduces the
polarity but also reduces the density of the material by steric hindrance; this further
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reduces the k value.

Also, replacing Si-O bonds with Si-F bonds reduces electric

polarizability, since F is a highly electronegative atom and produces fluorosilicate glass
(FSG).

1.4.2

Silsesquioxane Based Materials
Silsesquioxane (SSQ) based materials are organic or inorganic polymers with the

backbone of O-Si-O and having empirical formula RSiO3/2 where every Si atom is linked
to three O atoms and every O atoms to 2 Si atoms [32]. R groups in the silsesquioxane
based materials could be H forming HSQ material or it could be terminated with methyl
group resulting in MSQ material. Silsesquioxane based materials have higher toughness
and hardness and also exhibit higher porosity. However, its disadvantage is that it is
brittle in nature and when exposed to oxidizing environments can result in formation of
hydroxyl (SiOH) groups susceptible to cracking and moisture uptake which in turn would
increase the k value of the film as k value of water is as high as 79.

Figure 1.10 HSQ ladder structure [15]
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HSQ and MSQ materials normally have either cage like structure or ladder like
structure. This network of structure results in formation of more void spaces which
decreases the density of the material and thus reduces the dielectric constant value of the
film.

Figure 1.11 HSQ cage structure [15]

Figures 1.10 and 1.11 show the ladder and cage structure for HSQ, respectively.
A similar structure for MSQ could be formed by replacing H with CH3. Dielectric
constant value of MSQ materials are lower than HSQ materials mainly because of the
presence of bulky CH3 groups which lowers the density by creating more void spaces and
since Si-CH3 bond has low polarizability as compared to Si-H bonds.

1.4.3

Organic Polymers
Polymers are long chain macromolecules with repeating monomer. Three factors

determine the chemical structure of the polymer: (a) basic structure; (b) spatial
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arrangement of monomer and (c) molecular weight. Organic polymers are mainly non Si
based low-k materials. Introduction of non polar bonds mainly C-C bonds lowers the
dielectric constant of the materials.

However, organic polymers suffer major

disadvantages because of their poor thermal and mechanical stability, which also makes
them incompatible with CMP process [32].

1.4.4

Amorphous Carbon
This class of low-k materials has not gained any importance because of its

difficulties with combining sufficient low-k values with suitable thermal and mechanical
properties [32].
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1.5 DEPOSITION OF LOW-k MATERIALS
Having identified the possible low-k materials which could be used for future
technology, another challenge the IC manufacturing industry faces are the issues related
to integration of these films. There are primarily two methods of deposition of low-k
films namely: a) spin-on and b) chemical vapor deposition (CVD). Both the deposition
techniques have their pros and cons and the debate between which of the two techniques
is best suitable for future technology has not yet been settled [36].

1.5.1

Spin-on
Spin-on deposition technique is a well known technique used for deposition of

thin films. The dielectric precursors for spin-on deposition are mainly made of a polymer
matrix mixed with solvent along with adhesion promoters and sacrificial materials (in
order to make porous films). There are several steps involved in spin coating [37, 38]:
first the substrate on which the low-k film has to be coated is placed on the spinner and
the precursors are poured onto the center of the substrate with the help of a nozzle. The
second step is to rotate the spinner to produce a uniform thin film on the substrate by the
action of centrifugal force.
The viscosity of the film, the spinning rate and the evaporation rate of the solvent
determines the thickness and uniformity of the coated film. Following this, the coated
film is baked at temperatures typically around 200 oC to remove solvents. If pores are
desired then the film is further cured either heating to temperatures typically around 400
o

C or using e-beam technology to remove organics and porogens. Baking and curing
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steps results in cross-linking of polymer chains which gives strength to the film. There
are several low-k films available which uses spin-on technology (see Table 1.3). Table
1.4 lists some of the pros and cons of spin-on.

Table 1.4 Features of spin-on low-k materials [39]

Pros

Evolutionary from photoresist

Cons

Throughput may be an issue depending
on cure time and level of control needed

No vacuum required

Uniformity and step coverage not as
good as CVD

Lower equipment cost

High cost of chemicals
ESH issues

1.5.2

Chemical Vapor Deposition (CVD)
Chemical vapor deposition has widely gained importance in depositing thin films

[40].

CVD process is mainly done in a vacuum environment.

CVD involves

thermodynamics, heat transfer, fluid mechanics, and kinetics as well as surface and
plasma reactions. In CVD, gases are introduced into the CVD chamber which reacts with
the substrate to form the desired film.

56

Table 1.5 Features of CVD low-k materials [41, 42]

Pros

Cons

Evolutionary technology derived from SiO2 Vacuum needed
Can produce uniform films

Throughput may be an issue depending
on cure time and level of control
needed

Can

effectively

coat

topography

over

severe Degradation

and

decomposition

happens when exposed to plasma

Solventless technology

It is important that the reaction producing thin films should occur on the surface. If gas
phase reaction occurs then it might result in particulate formation which will result in
causing defects in the deposited films. There are several methods of CVD deposition
such as APCVD done at atmospheric pressure, LPCVD done at low pressure and PECVD
which is a plasma enhanced CVD process. Most of the low-k films are being deposited
using PECVD method. Like spin-on methods CVD also has its own pros and cons which
are listed in Table 1.5 [41, 42].
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1.6 PORE SEALING
Integration of ultra low-k (ULK) materials is an important challenge facing the
semiconductor industry. Pore sealing holds the key to successful integration of ULK
dielectrics. However, it is important that sealing pores should not increase the effective k
value as well as gives good adhesion properties [43]. It is also important that the
dielectric constant of the material remains stable once it has been integrated. Porous
films are highly susceptible to atmospheric molecular contaminants, diffusion of
precursor molecules, solvents etc. to the bulk of the film through pores. This poses
significant reliability and integration challenges, since these foreign materials can outgas
during further processes. Moreover, porosity might also result in Cu diffusion resulting
in creation of pinholes in the barrier metal. Thus, sealing of pores becomes a critical
issue for the implementation of low-k dielectrics [44].

1.6.1

Pore Sealing Techniques
Various chemistry and compounds have been used for sealing the pores of the

low-k materials. Several pore sealing techniques are being researched. Some of these
techniques are briefly outlined below:

1.6.1.1

Pore Sealing by Surface Modification
In this technique the surface of the porous material is modified by densifying the

surface of the film using plasma treatments or ion bombardment.

However, it is

important to control the plasma since only few nm from the top surface should be
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densified in order not to increase the effective dielectric constant. The layer formed is
useful in protecting the bulk film prior to the deposition of the barrier layer. This
technique is useful for microporous dielectrics [45].

1.6.1.2

Pore Sealing by Thin- Film Deposition
In this technique a thin layer of material that is metallic in nature is deposited.

The effectiveness of sealing depends on the process of deposition and the porous
structure of the surface to be sealed. This process is useful for sealing the dielectric with
micropores or mesopores [45].

1.6.1.3

Pore Sealing by the Post-Etch Porogen Burn-Out (PEBO) Integration Sequence
This technique uses the approach of creating mesoporosity after the dielectric has

been patterned and etched, as opposed to a conventional approach where porosity is
created before etching process. This is very useful as it helps in the reliability of the film
[45].
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1.7 CONTAMINATION ISSUES IN SEMICONDUCTOR PROCESSING
In semiconductor processing, clean wafers have always been the requirement for
fast performance, long term reliability and high yields. Addressing contamination issues
in IC manufacturing have always been demanding and it is becoming all the more
challenging as the industry is moving towards the nanoelectronics era [46]. In spite of
manufacturing being done in a controlled cleanroom environment, the demands for future
manufacturing require a tighter control over the contamination.
Process yield is one of the main economic drivers in semiconductor industry.
Higher the yield, greater would be the profit for the company. The yields of integrated
circuits are greatly impacted by contamination on the wafers. Around 50% of yield
losses are due to contamination on wafers.

Therefore, having successful cleaning

processes can be an important factor in High Volume Manufacturing. Tighter control is
needed to be maintained on contamination and processes need to be developed to remove
contaminants once they are incorporated on the wafers.

1.7.1

Types of Contamination
There are generally three kinds of wafer contamination [47]:

a) Particles;
b) Films;
c) Trace-quantities of contaminants.
As the minimum feature size is decreasing the size of particles that can cause
defects is also decreasing. Any particles on the wafer surface if not removed can be
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detrimental to device performance.

Particles can be introduced into the system by

personnel, processing equipment, and atmosphere.
Film contamination on wafer surfaces often results from photoresist residues or
residues from solvents or from oils and lubrications from vacuum pumps and process
equipment.
Trace quantities of contaminations such as metallic and ionic contaminants are
accumulated on wafer surface by etchants, bulk chemicals, photoresist, ultra-pure water
supply system or resist stripper. Trace level of airborne contaminants are readily found
in the ambient or in the surrounding air. Therefore, to prevent any form of contamination
it is important to carefully monitor all processes, chemicals and the surrounding air.

1.7.2

Sources of Contamination
Contamination can be introduced into the system from various sources. It could

come either from outside the cleanroom or from inside the cleanroom. Typically when
equipment is being installed inside the cleanroom, the materials and equipment used for
construction can be prominent source of contamination. Process equipment was believed
to be the source of 75% particle contamination in IC fabrication [48]. Also humans pose
a significant risk of contamination. Oils, particles and other airborne contaminants can
be introduced in the cleanroom by humans. Particles come from human hairs, skin, and
cosmetics.

Human breath can put water vapors and particles in air, which could

potentially contaminate the wafer surface [47]. Inside the cleanroom there are several
sources for contamination. A lot of equipment uses lubricants and coolants to run which
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is a viable source of contamination.

Contamination are also introduced by several

processing steps as organic residues, slurry residues metal interconnect residues and
precipitates, metals and particulates. These contaminants originate from bulk chemicals
and processes. Chemical contaminants can also come from liquid and gaseous chemicals
as well as ultra pure water in the forms of ions, bacteria, organic particles and low level
of organic residues.
Metallic contaminants are introduced into the system from various sources:
a) Photoresist
b) Implantation
c) Plasma deposition
d) Wafer handling
e) Tubings
f) Wet benches
g) Wet chemicals and water
The ordinary air is first treated before it is allowed to be introduced in the
cleanroom environment. Normal air, which has large amounts of dust particles and
molecular contaminants, is passed through HEPA filters before being introduced into the
cleanroom. The moisture and chemical vapors namely isopropanol vapors, present in the
cleanroom ambient can also cause reliability concerns for future technology and
nanoelectronics era.
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1.7.3
1.7.3.1

Effects of Contamination
Metallic Contamination
Metal contaminants on the wafer surface can cause gate oxide integrity defects;

decrease the reliability of MOSFET gate oxide films and metal induced stacking faults
near gate oxide silicon interface [49]. It can also result in channel mobility of charge
carriers and act as scattering sites. It also causes voltage shifts which negatively affect
the device performance [50] and increases pn junction reverse bias leakage-currents.
Typical metallic contaminants are iron and copper.

1.7.3.2

Contaminant Films
Film contaminants present on the wafer surface can cause adhesion issue by

preventing the adhesion of deposited films to the wafer surface. It can also decompose
into harmful by-products.

1.7.3.3

Particulate Contamination
Particles present on the wafer surface can result in masking of various processing

steps. It may block implants or cause pattern disturbance during the lithography step.
Particles can become embedded in the film during the film deposition steps causing
pinholes, micro cracks, and producing masking defects. Particles can also cause shorts or
open between conductor lines. As feature size decreases the sizes of these particles also
need to be decreased in order to avoid defects. For nano manufacturing, particles of
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micron levels can act as killer defects which would result in device failure and reliability
problems.

1.7.3.4

Organic Contamination
Organic contaminants are widely present in the cleanroom environment as

atmospheric molecular contaminants. One of the widely used chemicals for cleaning in
IC manufacturing is isopropanol (IPA). Vapors of IPA present in the ambient can react
with wafer surfaces causing detrimental effects. There are several ways in which organic
contaminants can affect the processing and performance of semiconductor devices [5159]:
• Organics
•

adsorbed on wafer surfaces affect wetting, etching and particle removal

Due to incomplete wetting, cleaning with SC1, SC2, Piranha, HF is less effective and
contaminants are not removed properly

• Uneven

etch rates cause roughness

• Organics

can form particles or films

• Organic deposits
• Halocarbons
• Adhesion

can cause high resistivity or opens for contacts

can cause contact corrosion

between layers is affected, sometimes adversely

• Hazing of wafers
• Organics

can fog optics of particle counters, lasers, steppers

• Streaking during
• Unintentional

application of spin on glass, photoresist, polyimide

counter-doping
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• Prevention
• High

of silicon wafer bonding

temperature processing can cause silicon carbide formation

• Malfunction
• Increase in

of epitaxial growth

effective oxide thickness, which is critical for ultra-thin gate oxides

• Deterioration

1.7.3.5

of gate oxide breakdown voltage and of Gate Oxide Integrity (GOI)

Moisture Contamination
Moisture is present in cleanroom air in abundance as the relative humidity of

cleanroom is typically around 40%. It has been known that moisture has detrimental
effect on wafer surface and thin films [60, 61].

The presence of moisture in

semiconductor manufacturing tools and ultra high purity gas distribution systems causes
a significant problem and is an important issue that needs to be addressed when dealing
with contamination control [62]. Moisture is a very difficult impurity to remove because
of its small size, high polarity and ability to form hydrogen bonds. Moisture also affects
selectivity and micro-roughness and gate oxide integrity [63, 64]. It is involved in
particle forming reactions, corrosion of components in reactive gas systems, oxidations of
various thin films and substrates, and assisting the binding of other compounds to the
wafer surface [65, 66]. Moisture also adversely affects the effective dielectric constant of
porous low-k dielectric films as the dielectric constant value of water is around 79.
Moisture retained in the film causes adhesion and reliability issues due to gradual
outgassing in subsequent processing steps. Therefore, it is very important to have control
of moisture impurity in IC manufacturing.
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1.8 RESEARCH OBJECTIVES
For 45 nm node (2010) the effective dielectric constant for interlevel metal
insulator should be around 2.5–2.8 and the projected bulk dielectric constant value should
be less than 2.2 [1]. In order to achieve such low values for the dielectric constant, air
gaps (k value of ~1) are desired in the bulk film. Pores or air gaps can be fabricated by
using sacrificial materials.
Porous low-k dielectric films have an entirely different characterization as
compared to non-porous materials. There are a number of reliability concerns about
porous low-k films, such as the mechanical strength, thermal stability, and process
contamination [67, 68].

Therefore, integration and reliability issues related to high

diffusivity of precursors, solvents, and moisture in the porous material need to be
addressed.
The properties of interlayer dielectric films are sensitive to the presence of
homogeneous contaminants from various sources, which can in turn affect the process
yield and degrade the final device performance. In the ultra-low-k materials, porosity
may constitute 40 percent or more of the volume of the materials. Increasing porosity
makes these films highly susceptible to atmospheric molecular contamination (AMC),
especially moisture and organics because of their high reactivity with material surfaces.
The porous nature of the low-k dielectric films also results in retention and incorporation
of moisture which might lead to outgassing in further processing steps [15, 69].
To design a process that minimizes the impact of moisture and organic
contamination, it is necessary to have a fundamental understanding of the interactions
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between gaseous contaminants and the dielectric surface. Therefore, understanding the
transport of gases through these low-k dielectric materials will help in designing better
processes for integration of low-k materials in semiconductor processing.

The

mechanism of contaminant sorption, transport of gases through the bulk matrix as well as
pores, sorption capacity of the film, and the effect of porosity, pore structure, pore size
distribution and film thickness on the diffusion of the contaminants have not been studied
and characterized. This information is important because these materials are exposed to a
wide variety of conditions during fabrication processes. Therefore, it is necessary to have
a fundamental understanding of the interactions between molecular contaminants and
dielectric surface.
There has been a considerable amount of research on the interactions of
contaminants with high-k dielectrics [70-72]; however, the mechanism of contaminant
adsorption and diffusion in low-k materials, and the effect of porosity and pore structure
on the mobility of contaminants have not been adequately studied and characterized.
This information is critical because these materials are exposed to a wide variety of
conditions during fabrication processes. It is well known that moisture incorporated in a
dielectrics matrix interacts chemically with the dielectric and exists in a variety of forms
including both dissolved and reacted forms [73, 74]. However, the dissociated and
reacted water undergoes reverse reaction when moisture is desorbed and removed from
the matrix.

While the nature of intermediate compounds formed in the matrix is

important, the key parameter of interest for manufacturing is the overall uptake of
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moisture. Therefore, it is common to use the term incorporated or sorbed moisture to
refer to all by-products of moisture interactions with the matrix.
Previous studies have shown that certain fabrication steps, such as, plasma
etching and/or ashing, can dramatically affect the physical properties of low-k dielectric
films, [75-78] which in turn may affect moisture uptake of the film. One focus of this
study is to investigate the effect of patterning processes on moisture uptake and retention
in low-k films.
Various chemistries and compounds are used to seal the pores on the surface and
cap the porous low-k films.

These cap layers are effective barriers against metal

diffusion into the porous low-k films.

However, their effectiveness in preventing

moisture intrusion or retention in low-k has not been studied and is not clear. Moisture
uptake and clean up has a complex dependence on the solubility and diffusivity values of
the cap layers. Therefore, there is a need for greater understanding of moisture
interactions with cap layer materials.
Predicting moisture distribution within low-k film is also valuable. For instance,
during a cleaning process, sometimes the average moisture concentration within a low-k
film is low while the moisture concentration near the interface of low-k film and substrate
is much higher than the average level. The moisture concentrated at the interface may
degrade adhesion between low-k film and cap layer.
In this dissertation, a methodology is developed to study molecular interactions
with low-k dielectric materials and is used to compare the effect on blanket and cure
only, etch only, and etch and ash surfaces. A process model is set up to describe the mass
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transport of moisture in the polymer matrix and the pores (voids). A series of physical
and geometric parameters have been estimated, and the effect of porosity and film
thickness are discussed.

The results predicted by the model agree well with the

experimental data and is used to predict conditions at which experiments were not
performed or were difficult to perform. The results of this study, and the model, would
provide a valuable tool for designing desorption recipes (temperature, gas flow, and gas
purity) to ensure effective and efficient cleanup of the dielectric films.
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CHAPTER 2
ANALYTICAL INSTRUMENTATION

2.1 INTRODUCTION
In semiconductor manufacturing and pharmaceutical processing, presence of trace
level contaminants has detrimental effect on the processes. There is a great challenge in
measuring trace level impurities in parts per billion (ppb) and parts per trillion (ppt)
ranges in process gases, which is versatile, rapid, sensitive and reproducible. Therefore,
there is a need of analytical instruments which can monitor continuously impurities
concentration at such low level.
In this work experiments have been done mainly in ppb range. Several different
analytical tools have been used to perform the experiments which give reliable and
reproducible results and have high signal to noise ratios. For the gas phase study was
mainly done using three difference analytical tools, two are mass spectrometers and one
is moisture analyzer. These are Atmospheric Pressure Ionization Mass Spectrometer
(APIMS), Electron Impact Mass Spectrometer (EIMS) and Cavity Ring Down
Spectroscope (CRDS) respectively. In this chapter for each analyzer their principles and
theory of operation, potential issues, calibration, etc. are discussed in detail.
Another aspect of this research has been in-situ measurement of impurity
concentration in porous film which is used for studying adsorption and desorption
dynamics.

One such technique which is very robust and reliable to measure the
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concentration in the film by probing the sample directly is Fourier Transform Infrared
Spectroscopy (FTIR). It is a powerful technique for in-situ characterization. FTIR gives
mainly two types of information, first what kinds of chemical bonds are there in the films
and second what is the concentration of impurity in the films which is correlated using
the absorption spectrum. Details of principles of operation and theory of FITR have been
discussed in this chapter.
Surface characterization of the film was also done using Transmission Electron
Microscope (TEM).

This technique is useful in study the surface morphology and

thickness measurements.
discussed.

Details of applications and theory of TEM has also been
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2.2 ATMOSPHERIC PRESSURE IONIZATION MASS SPECTROMETER
Trace level measurement of impurities in ultra high purity gases and systems
requires highly sensitive analytical tools. Traditional mass spectrometers do not have the
capability to measure sub parts per billion (ppb) and parts per trillion (ppt) ranges of
impurity concentration in the gas. Atmospheric pressure ionization mass spectrometry
(APIMS) is one such tool which has the capability to measure concentration in sub ppb
and ppt range and today it is widely being used for trace level impurity measurements. It
has being designed in such a way that it can provide 106 times higher sensitivity than
conventional mass spectrometers and also has a much faster response times. Because the
ionization of gases happens at atmospheric pressure, APIMS can detect concentration
level in gases as low as 0.5 - 1.5 ppt [61]. Moreover, not only can it detect several
impurities simultaneously like most of the other mass spectrometers but also it can
distinguish between impurities have same mass to charge (m/e) ratio. Several authors
report in literature the history of the development of the atmospheric pressure ionization
(API) technique [79-80].
Such high detection limits comes with its own drawbacks, one such is the cost,
and APIMS is a very expensive instrument as compared to typical mass spectrometers.
Also it involves high maintenance and complex operations. APIMS are available either
as one quadrupole system or three quadrupole systems, which adds additional cost to the
system. Also, to provide precisely controlled sample gas and calibration gas it has gas
processor system. Thus, all these drives up the cost of the tool and it typically range in
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thousands of dollars. In order to achieve the best performance from the equipment, it is
important to constantly purge the system with ultra high pure carrier gas which for this
study is nitrogen.

Since, ionization happens at atmospheric pressure in the source

chamber, it results in a complex ion-molecule reactions, often times several ionized
species are formed which could cluster together making the interpretation more complex
and challenging. This cluster formation might result in similar mass to charge ratio
making the interpretation more difficult. This may complicate identification of unknown
compounds as most of the reference spectra available are for conventional mass
spectrometers operating under vacuum. In order to minimize the effect of over lapping
spectra the quadrupoles have to be tuned and this process is a very exhaustive and time
consuming process. There is a second quadrupole in which species with overlapping
mass to charge ratio are further broken down which could help to identify the species and
help in interpretation. For example, CO and N2 have same mass to charge ratio which is
28, but further breaking down CO in second quad to C and O can help in identifying
whether species present in CO or N2. This feature of APIMS is a significant advantage
over the conventional mass spectrometer. However, APIMS can be used to detect only
those trace level impurities which have ionization potential less than the carrier gas. In
this study nitrogen was used as the carrier gas; thus the concentrations of argon,
hydrogen, and helium could not be determined using APIMS.
Several users have been able to modify the instrument to detect trace levels of
hydrogen in nitrogen gas [81] as well as reactive species such a silane in nitrogen and
helium [80] gas.
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The APIMS used in this study is a VG Trace+.

It comprises of a mass

spectrometer manufactured by Vacuum Generators (VG) and a gas processor
manufactured by L’Air Liquide.

2.2.1

APIMS Principle of Operation
In this technique the ionization of the gas to be analyzed happens at atmospheric

pressure in the source chamber instead of under vacuum as done in most of the mass
spectrometers.

Typically, ionization of impurity species occurs under vacuum in

traditional mass spectrometers, this significantly reduces the detection limit for
measurement of trace level impurities concentrations in sub ppb and ppt range. In order
to overcome this serious limitation in measuring sub ppb level, APIMS ionizes the
sample gas at or near atmospheric pressure using corona discharge ionization. This result
in the creation of a large number of 'primary ions' of the bulk gas (also known as carrier
gas) by electron impact of corona created electrons on the major neutral components. In
this study N2 is used as the carrier gas and the primary ionization of the carrier gas yields
N+ and N2+ species. Since the ionization happens at atmospheric pressure, such high
pressure results in higher probability of collisions of primary species formed also the
short mean free path results in a wide-ranging series of ion/molecule reactions resulting
in secondary ions, such as:
N+, N2+ + 2N2 ------ > N3+, N4+ + N2

… 2.1
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Only small fraction of sample gas is ionized in first primary step, where as nearly
100 % of the trace impurity molecules present in the carrier gas get ionized due to a
“charge transfer phenomenon”. This phenomena result in high sensitivity of APIMS,
which allows detection of trace level impurities. For example:

N2+ + O2 ------ >

N2 + O2+

Primary ionization

… 2.2

Secondary ionization

N2
Collision

API
I

N2 + e-

N2+ + 2 e-

I + e-

I+ + 2 e-

N2+ + I

N2+ + I+

Figure 2.1 Dual mechanism of ionization in API source

This secondary ionization mechanism is also known as ‘soft’ ionization. The
sequence is shown schematically in Figure 2.1. However, the charge transfer mechanism
or ‘soft’ ionization mechanism is thermodynamically favorable only when the impurities
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of interest have a lower ionization potential than the primary or secondary ions formed
from the bulk gas. Table 2.1 lists the ionization potential of various species. Fortunately
as seen from the table most of impurities of interest can be studied as nitrogen as the
carrier gas.
It should be noted that the presence of a large amount of an impurity, i.e. >100
ppb, with a favorable ionization potential will affect the ionization of other trace level
impurities. That is that particular impurity with favorable ionization potential will get
readily ionized by the primary ions where as the other impurities might not, thus resulting
in decrease of the detection of other trace impurities in the carrier gas. Hence for the
APIMS to operate correctly and provide quantitative data there must not be high
concentrations of any impurity in the gas to be analyzed. For a gas with low levels of
impurity the preferential secondary ionization of the impurity species results in a higher
proportion of the ions formed being from the impurities. The ions and the neutral gas
from the source are sampled into the vacuum system through a series of orifices and
pressure reduction/focusing stages.
It is important that the potentials applied to the focusing elements in these stages
are appropriate for the optimum detection of the ions of interest because ion/molecule
reactions can occur in the early stages of pressure reduction. Also de-clustering of ions
will also take place in these stages.
Another potential issue with APIMS is the presence of certain kind of impurities
such as moisture which results in cluster formation.

This affects the detection of
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impurities because of formation of several ions with similar mass to charge ratio making
the interpretation difficult.

Cluster ions are readily formed in the API source, for

example,

N3+ + H2O ------ > N2

+ NH2O +

… 2.3

It is observed from the above reaction that the newly formed cluster ion NH2O+ have
mass to charge ratio of 32 which is same for O2+. Thus this cluster ion interferes in the
detection of O2+ ions. In order to limit this effect the APIMS tuning settings, such as the
source, focusing and accelerating voltages, should be optimized.

The primary and

secondary ions formed in the source are then leaked into the vacuum system through an
orifice plate where the ions are channeled into a quadrupole chamber through a series of
pressure reduction and focusing stages. The quadrupole separates the ions according to
their m/e ratios and directs the ions to a channeltron detector with a pulse counter. Figure
2.2a and 2.2b shows the general assembly and different source components respectively.
Subsequent sections would explain these phenomena in details.
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Table 2.1: Ionization potential of several gaseous species

Gaseous Species

Ionization Potential (eV)

He

22.45

Ar

15.755

N2

15.576

H2

15.427

CO

14.013

CO2

13.769

CH4

12.6

H2O

12.6

O2

12.063

C2H6

11.5

C3H8

11.1
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Figure 2.2a APIMS general assembly [82]
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Figure 2.2b APIMS source components [82]
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2.2.2

Trace+ Triple Quadrupole APIMS
Schematic of Mass spectrometer along with various key components of VG

Trace+ APIMS are shown in Figure 2.3.

Sample gas at atmospheric pressure is

introduced into the ion source. The ion source is a stainless steel volume with a needle of
low work function material which is this case is tungsten located in the middle of the
source chamber and is held in place using a ceramic to metal seal. This set up allows for
applying a high voltage, up to +5 Kv to the tungsten needle. The point of the needle is
approximately 3mm from the first orifice. The high voltage applied to the needle results
in formation of corona discharge, which ionizes the gas present in the chamber.

Figure 2.3 Schematic diagram of VG Trace+ APIMS
Source chamber has two connecting tubes. Sample gas is introduced into the
source chamber using the upper of the two connecting tubes. The gas flow is designed in
such way that the sample gas entering the corona region does not interact with the
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adsorbed species on the source wall, which minimizes the contamination effect. There is
a continuous flow of the gas in the source chamber, the remaining gas purges the
chamber and leaves the source through the second connection tubes. The source has two
heating rod which allows for the heating the chamber to as high as 160 oC.

For

experiments in this research the source was maintained at 110 oC to prevent condensation
of moisture on source walls. Normally when a new reactor is installed the chamber is
baked overnight.
First pumping stage is kept at 0.5 torr which is much less than the pressure in the
source, this pressure difference allows the ions formed in the corona to be drawn into the
first pumping stage through a 200 µm orifice, F1. This is a short chamber, pumped by a
high capacity rotary pump, to reduce the pressure to a few mbar. Since F1 is the first
orifice which the fragments see, it is very important to carefully tune the voltage of this
lens. Because the number of fragments reaching the detector area depends on how much
is allowed to pass through F1. This also determines the fragmentation energy of the ions
entering the spectrometer.

The sudden expansion through F1 also helps in the

declustering of ions. The second orifice F2 is cone shaped with pin hole at its top, it in
on the opposite side to the first orifice and protrude into the chamber. The lens is
insulated by ceramic seal and voltage between – 300 and 300 V can be applied. By
applying the correct voltage to the lens the ions entering the first pumping stage is
focused to the tip of the cone and enters the second pumping stage. Rotary-backed turbo
molecular pump is used to the pump the second stage. It is maintained at pressure of less
than 10-5 torr. Once the ions cross F2 lens then it goes through few more lenses (F3 and
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F4) and half plate (HP1 and HP2) before it reaches the quadrupole section. With each
pass the vacuum level is increased with the quadrupole region being kept around 1e-6
torr. It should be noted here that the voltages on each of the lenses and half plates are
optimized so that maximum number of ions reach the quadrupole section.
The quadrupole is made up of four electrodes arranged as a square array. These
electrodes are electrically conducting parallel hyperbolic rods. Opposite electrodes are
connected together and to each pair is applied a potential which are opposite in sign. The
potential applied is give by:

Φ (t ) = U − V ' cos(2πft )

…2.4

where, U is a DC voltage and V’ is the peak amplitude of an RF component with
frequency f. Once the ions after passing through series of lens enters the quadrupole
region it experiences RF and DC fields which are perpendicular to the direction of ions
entering the quadrupole housing, which in this case is Z- axis. Due to the effect of the
fields the ions moves in a transverse motion. Mathieu equations describe the motion of
the ions. These equations describes two types of motion, one in which the ions oscillated
along the Z-axis and comes out of the filter and the other in which ions get attracted
towards the electrodes away from the Z-axis and get neutralized. By optimizing the
various parameters V, U, f, ro for a particular of m/e ions allows that particular ions to
pass through the filter and reaches the detector while the rest get neutralized. It should be
noted, that not all other m/e ions will get neutralized some will still be able to pass
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through but the sensitivity of other ions would be less as compared to the ions for it the
parameters are optimized.
One advantage of Trace+ is that it has three quadrupoles in series. The benefit of
having three quadrupole is that species with same mass to charge ratio can be separated
and detected. First quadrupole is mainly used if there are no overlapping peaks and are,
and the other two quadrupoles are kept in total mode or full pass mode which allows the
ions to pass through without filtering. When ions of similar m/e ratio are present then all
the three quadrupoles are used. In the second quadrupole cluster of ions are further
broken into its component. There is a specially designed collision cell which houses the
second quadrupole. This quadrupole is slightly pressurized with ultra-high purity argon
collision gas and the cell is maintained at pressure about 10e-3 torr. The third quadrupole
acts as a filter for the newly formed ions broken form the original cluster ions. For
example, in order to measure the concentration of CO in N2 carrier gas, one has to use all
three quadrupoles. This is because CO and N2 have same mass to chare ratio which is 28.
Therefore, if the collision cell is not activated then it will be difficult to analyze how
much of the counts of 28 correspond to CO and how much for N2. This example shows
the advantages of using the second quadrupole collision cell and third as filter. In this
case the first quadrupole is tuned for m/e of 28. So both CO+ and N2+ ions pass through
the first quadrupole. In the second quadrupole or the collision cell, the ions further
undergo ‘collision induced dissociation’ (CID) resulting in fragmented daughter ions like
C+, O+, N+ etc. So to measure CO concentration, the third quadrupole is tuned to allow
passage of either C+ or O+ ions by tuning the quad to m/e of 12 or 16. The quadrupoles
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have to be tuned to the proper voltages so that the ions can be accelerated through the
CID cell at the optimum setting to promote fragmentation, and then decelerated for
efficient analysis in the third quadrupole.

2.2.3

Detector System
The ions leaving the quadrupole sections are directed to the channeltron detector.

The channeltron detector is made up of a curved glass tube with the inside of the tube
coated with a resistive material, usually beryllium coating. The resistive material forms a
continuous dynode on applying voltage across the tube ends. A large negative voltage is
applied to the channeltron so that it attracts the ions emerging from the quadrupoles.
These ions hit the resistive material coating, resulting in a release of lots of secondary
electrons. These secondary electrons again collide with the coating producing further
secondary electrons. The process continues till large amounts of electrons exits from the
end of the tube from every ion which enter the channeltron. The end of tube is kept at
earth potential.
The channeltron is mounted on the analyzer end flange. The flange can be
removed easily from the analyzer when replacing the channeltron. A pre-amplifier is
mounted directly on the flange to amplify the pulses and to transmit them to the pulsecounting amplifier/discriminator.
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Voltage in the range of 2.0 to 3.0 Kv can be applied to the channeltron in order to
maximize the detection limit.

As the detector age potential applied is changed to

compensate for the wear of the detector. The detector can be kept at a maximum of 3.5
Kv.
The APIMS displays the concentration of each species as counts per second (cps).
Therefore, calibration curve is needed for each impurity to relate concentration of the
impurity to counts per second. Generation of calibration curves are explained in the later
section.

2.2.4

APIMS Gas Processor
The gas processor is an integral part of the APIMS. A schematic of the Trace+

gas processor, designed by L’Air Liquide, is shown in Figure 2.4.
It has four major functions:
1. To prepare zero-gas for gas dilution and to establish a system baseline
2. To generate calibration gas through dilution loop
3. To provide exact amount of sample gas
4. To control the pressure and flow for the API source
All tubing used are made of electropolished 316L stainless steel tubing with VCR
fittings, orifice plates to control flow without adding any contaminants, and all-metal
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ultra clean MFCs are installed off-line to reduce the risk of impurity intrusion through
these units. Also in order to minimize any dead space flow is always maintained through
all the lines.
2.2.4.1

Zero Gas Preparation
Nitrogen carrier gas for this research is supplied by a bulk, cryogenic source. The

purity of the source nitrogen is 99.9999%. The nitrogen lines entering the lab are split
into two lines, one is the ‘house’ nitrogen line which is not further purified and is used for
applications where purity is not much of a concern. The second nitrogen line passes
through a 1000 L hot-metal getter purifier manufactured by Ultra-Pure Systems (Model
7000 XL).

Table 2.2 SAES getter performance
Impurity

Level

O2

< 1 ppb

H2O

< 1 ppb

THC

< 10 ppb

CO2

< 1 ppb

CO

< 1 ppb
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The nitrogen leaving this purifier has the total impurity content less than 1 ppmv.
This nitrogen is further purified by two SAES getter purifiers (Monotorr series 3000N,
model# PS3MTN1) in series. This produces an ultra high purity nitrogen gas with
impurity concentration as given in Table 2.2. The line pressure is maintained at 80 psig.

Figure 2.4 Schematic diagram of gas processor and gas delivery system
The ultra high pure nitrogen gas is further divided into two lines. One line is used
for the gas processor while the other line is directed to the direct injection system. The
gas fed to the direct injection system is further purified by two more SAES getters [83].
The nitrogen gas passing through for SAES getters produces ultra high pure nitrogen gas
with impurity concentration in single digit ppt range. This gas acts as the zero gas and is
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used to establish the baseline. This zero-gas nitrogen is used to dilute the challenge and
purge gases before it enters the API source.

2.2.4.2

Sample Gas Dilution
One important issue with APIMS operation is dilution of challenge gas. This is

because high impurity concentrations can saturate the plasma resulting in nonlinearities
and misleading data. MFC1 and MFC2 control the flow rate of challenge gas and zero
gas. Following were the conditions used for the experiments:
Challenge gas flow rate: 350 or 600 sccm
Total flow rate to the source: 3000 sccm
Sample pressure: 1- 1.5 bar

2.2.4.3

Calibration Gas Preparation
Standard research grade gas cylinders were used to prepare calibration gas. These

gas cylinders were prepared by mixing impurities such as: O2, CO, CO2, and CH4 with
balance N2. The impurities concentration was 10 ppm for each component and moisture
concentration in the gas cylinders was less than 1 ppm. Different concentration of
calibration gas was generated by mixing a small flow from the gas cylinders with zero
gas.
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In case of moisture, deuterium oxide and isopropanol (IPA), permeation devices
were used to generate calibration gas. Permeation device is cylindrical in shape with
sealed permeable tube containing moisture, deuterium or IPA permeant. The two ends of
the tube are sealed by impermeable plug. At controlled temperature of 50 oC known
amount of permeant permeates through the permeable membrane.

Permeation rate

typically varies between 75 ng/min to150 ng/min for different permeants. By passing a
known flow rate of purge gas and knowing permeation rate, it is easy to estimate the
concentration of impurity in the sample gas. By varying the gas flow rate different
concentration of impurities can be generated, which are used for calibration. Figure 2.5
shows a typical permeation device [84].

Figure 2.5 A typical Dynacal® permeation device [84]
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2.2.5

APIMS Calibration
As mentioned in previous section that APIMS measures impurity concentration as

ion counts per second (cps). This is not very useful, since counts per second do not tell
what the level of impurity concentration is.

Therefore, it is important to find a

relationship between the concentration of impurity in units of ppb/ppt and counts per
second. Varying level of impurity concentrations are generated by controlling the ratio of
the sample gas and zero gas. By knowing the concentration of impurity of interest in the
sample gas and flow rates of sample gas and zero gas, it is easy to estimate the
concentration of impurity in the calibration gas. Four different concentration levels are
used to produce calibration curve. For each concentration its corresponding counts per
second as shown by APIMS are recorded. Figure 2.6 shows the calibration curve for
carbon dioxide. Similar, curves were generated for moisture and isopropanol.

It is

observed from the Figure that counts per second and concentration gives a straight line
with the best line fit giving R2 equal to 0.97. The slope of the curve gives the sensitivity
of the impurity in counts/sec/ppb. The sensitivity factors will vary from specie to specie.
Sensitivity for each species could be enhanced by tuning the lens voltage to the optimum
value. It is good practice to check the sensitivity of the species occasionally because any
drastic change in sensitivity can help in identifying problems.
It is also observed from the Figure that the calibration curve gives a non-zero yaxis intercept. This suggests that the assumption that zero gas does not contain any
impurity is not correct, instead it has small amount of impurities present. There could be
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several sources for these impurities, such as desorption from the transfer lines, dead
spaces, outgassing from API source, and indigenous to the gas [85]. These impurities
combine together to give the actual impurity background. These sources of impurities
can be minimized by making sure that the experimental design does not have any dead
spaces, which could be as simple as not having any MFC’s in the sample gas line, always
maintaining flow through the whole set up, keeping transfer lines heated to reduce
memory effects, etc.
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Figure 2.6 APIMS carbon dioxide calibration curve
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2.2.6

Important Issues in APIMS Analysis and Technique
The previous sections so far has talked about the preparation of calibration gas,

generating calibration gas, advantages of APIMS over conventional mass spectrometers.
However, there are three main concerns with APIMS which needs to be addressed and
understood well for effectively using APIMS.

These are preparation of accurate

standards, non-linearities in calibration, and multiple component effects.

2.2.6.1
(i)

Preparation of Calibration Standards

Standard Gas
Calibration of APIMS depends very much on how accurate in the concentration of

impurities in the standard gas. It is also important that in the standard gas of a given
impurity, which has to be calibrated, the presence of other impurities should be at least
one level lower than the impurity of interest. Typically for APIMS calibration, around 10
ppm of impurity level is chosen as a standard gas. Lower levels gas cylinders would be
difficult to be certified by conventional techniques, therefore choosing impurity
concentration less than 10 ppm might not give the correct calibration curve. Standard gas
is made by mixing the impurity with balance research grade nitrogen to the desired
concentration level. Thus, any errors in certifying the standard gas would not result in
accurate calibration curve which in turn would affect the experimental data.
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(ii)

Zero Gas Generation
Another concern is the purity level of the zero gas. Ultra high pure nitrogen with

purity level less than 1 ppb is normally chosen as the carrier or the zero gas. This is
important because when diluting the challenge gas, one would not want to introduce any
impurities via the zero gas. Specially to generate accurate calibration curves at sub-ppb
level, the background of the zero gas plays a vital role.
(iii) Gas Blending System
Preparation of calibration gas depends on mixing challenge gas with zero gas
using a gas blending system. Since, concentration of impurity needs to be diluted from
10 ppm to sub-ppb levels, it is important that the blending system is capable of providing
very large dilution ratios using highly stable and accurate mass flow controllers. Also,
care should be taken that the blending system does not introduce further contaminants
into the gas processor.

2.2.6.2

Non-Linearities in APIMS Calibration
One of the issues which have to be addressed for better understanding of APIMS

operation is the issue of non-linearities in APIMS calibration. In previous section it was
mentioned that the APIMS calibration gives a linear curve between counts per second
and concentration. However, in the range of detectability both for high concentration and
low concentration, it has been observed that APIMS response does not follow linear
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behavior. The non linearity in the data at high concentrations is primarily because of
plasma saturation in the ionization source. Carrier gas ions are depleted at high impurity
levels, thus resulting in an inefficient secondary ionization. While the non linearity at
low concentration levels is due to the impurity background levels. In the range of
concentration of interest, non linear calibration data are fitted with a non linear model to
develop appropriate non-linear equation. The equation developed is then used to convert
the counts per second response obtained from APIMS to the actual concentration in the
sample gas [86].

2.2.6.3
(i)

Multiple Contaminant Interference Effects

High Concentration of One Impurity
Specie which has low ionization potential gets easily ionized and if present in

large concentration results in lower efficiency of ionization of other trace level
impurities. Thus, the APIMS would result in low signal of these trace level contaminants
which would give false results.
(ii)

Secondary Ion Interference
Fragmentation and clustering of primary ions occurs in API source resulting in

formation of several secondary ions. For example, when moisture (H2O) contaminant is
present in the N2 carrier, it results in creation secondary ions such as O+, NH2O+, and
N2O+ with mass to charge (m/e) ratios equal to 16, 32, and 44, respectively. These
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secondary ions can interfere with the detection of primary ions such CH4 +, O2 +, and
CO2+, also has same mass to charge ratios.
(iii) Impurity-Impurity Interactions
At high impurity levels, there is good chance of interactions between the species
which could be a significant cause for error. One such impurity which is a most critical
to study is moisture mainly because of its reactive nature. These reactions results in mass
spectra with overlapped peaks, new unexpected peaks, or missing peaks at expected m/e
ratios. Therefore, to resolve these issues voltages on the ion lenses and orifices have to
be optimized.
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2.3 ELECTRON IMPACT MASS SPECTROMETER
2.3.1

Introduction
Mass spectrometry or mass spectroscope is conventionally used to measure

atomic and molecular composition of a physical sample. Composition of species present
in the sample is represented as a mass spectrum or spectra of the atoms and molecules by
mass to charge ratios. In order to measure the concentration of each molecule in the
sample, the mass spectrometer converts the molecules into charged particles or ions
which could be moved around and influenced by external electric and magnetic fields
[87].

Data Handling
System

Sample

Inlet
System

Ion
Source

Mass
Analyzer

Ion
Collection System

Figure 2.7 Components of mass spectrometer
The spectrometer produces both ions and ions fragments of the original molecule.
These charged ions produced are separated by mass to charge ratios and directed to the
detector by external fields. Mass spectrometer gives the output of the concentration of
each ion presents as mass spectrum which is the intensity versus mass to charge ratio
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plot. This plot helps to perform chemical analysis [88]. There are three main functions
of a mass spectrometer and associated components are:
a) Converting molecules and compounds into ions by loss of electron – Ion Source
b) Separation of the ions and fragments by their mass to charge ratios – Mass
analyzer
c) Detection of each separated ions – Detector
Schematic of essential components of a mass spectrometer is shown in Figure 2.7.
Mass spectrometer typically has very high sensitivity and is very useful in identifying
unknown compounds which makes it’s a preferred analytical technique for chemical
analysis. The improved sensitivity of the mass spectrometer is primarily because of the
presence of mass analyzer which acts as a mass/charge filter which reduces any
background effects as well as from the sensitive electron multipliers used for detection.
The characteristic fragmentation patterns, can give information about molecular weight
and molecular structure which be useful in identifying compounds.
This technique has several applications [89]:
a) Identification of unknown compounds by mass of compounds or their fragments
b) Determining isotopic composition of elements in a compound
c) Determining the structure of a compound by observing its fragmentation
d) Quantification of the amount of compound in a sample
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Balzers QMS 421 series mass spectrometer, consisting of a QMS 421C control
unit and a QMA 400 quadrupole analyzer has been used for high concentration (ppm-%
levels). Following sections briefly describes the operation of the mass spectrometer.

2.3.2
2.3.2.1

The Mass Spectrometer
The Ion Source
The ion source is the heart of the mass spectrometer. Ionization of the sample

materials takes place in the source. There are several ways of ionizing the molecules
some of them are by electron impact, field ionization, chemical ionization, field
desorption, ion bombardment, laser desorption etc.

Figure 2.8 Electron impact ionization source
In the electron impact mass spectrometer the challenge gas is leaked through a
capillary from the dosing valve into the source chamber.

The source chamber is

maintained under vacuum. In this chamber molecules of sample are bombarded by
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electrons emitting from a heated filament which ionizes the molecules present into
positive ions by loss of electron. Figure 2.8 shows an electron impact ionization source.
The partial pressure of each molecules present in the carrier gas determines the
ionization density of each species. The ionization cross-section for most gases peak
somewhere in the 50-150 electron volts range, even though the ionization potential of
different atoms or molecules is not the same. For QMS 421 the ionization source is
operated at 70 electron volts.

2.3.2.2

Quadrupole Mass Analyzer
Mass separation in QMS 421 is achieved by using quadrupole. Quadrupole has

been proven to be one of the most reliable, accurate mass analyzer mainly because of its
excellent resolution and wide mass range. The quadrupole mass filter was first proposed
by W. Paul [90]. Figure 2.9 shows a typical mass filter which is made up of four
cylindrical molybdenum rod electrodes. It is arranged in such a way so that it provides
the closest mathematical approximation to a hyperbolic electrical field. The ions formed
in the ionization source enter the mass analyzer region where it travels parallel to z – axis
with constant velocity. Oscillating electric fields achieved by applying a direct current
voltage (U’) and a radio frequency voltage (± V’ cos ωt) to the poles is used to
selectively stabilize to destabilize ions. This technique helps in mass separation.
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Depending on the conditions of (U’, V’, ω) only a single mass to charge ratio will
have stable oscillations and traverse the entire length of the filter and reaches the
detector, while all other ions will have unstable oscillations and will strike the poles and
be lost. Wide mass range is scanned by sweeping the RF and dc potentials linearly in
time. The QMA 400 has a mass range up to m/e 511.

Figure 2.9 Quadrupole mass analyzer

2.3.2.3

The Detector
The detector is also an integral component of Electron Impact Mass Spectrometer.

QMA 400 uses SEM (secondary electron multiplier) detector. The separated ions in the
mass analyzer are directed towards the SEM detector. The ions reaching the detector
strike Cu-Be dynode thereby releasing lots of secondary electrons. These secondary
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electrons further collide with a series of dynodes; where by creating more secondary
electrons. The detector used in QMA 400 has 17 dynodes. Figure 2.10 shows the
secondary electron multiplier.

Figure 2.10 Secondary electron multiplier detector

Each ions arriving at the detector experiences an output current impulse which is
supplied by SEM. Electrometer amplifier then converts these current impulses to correct
mean values. It should also be noted that the SEM is located off-axis i.e. ions leaving the
quadrupole are deflected by 90o, this is because to eliminate any background
interferences. These background interferences are created by soft x-rays, other photons
or excited neutral particles and false mass.
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2.3.2.4

Capillary Inlet System
The gas entering the source chamber is passed through a capillary inlet. The

source chamber is maintained under vacuum conditions where as the gas stream is at
atmospheric pressure.

Therefore, the inlet system consists of a two-stage pressure

reduction in order to measure concentration of gas at atmospheric pressure. In the first
stage the pressure is reduced from atmospheric pressure to mbar by an 18 L/sec turbo
molecular drag pump backed by a diaphragm pump. Fused silica capillary of 0.152 mm
internal diameter and 1.25 m in length is use to transport the gas in this stage and the flow
regime in this section is laminar. The gas leaving the capillary is then bled to the source
chamber using an adjustable thermo mechanical leak valve. The ion source region is
maintained at a pressure of 10-6 mbar by a 180 L/s turbo molecular drag pump backed by
a diaphragm pump. The pressure gradient between the capillary inlet and the analyzer
drives the gas into the ion source. It should also be mentioned that the capillary walls are
housed in a stainless steel tube and is kept heated at 100 oC. This is primarily done to
reduce any adsorption of impurities on the capillary walls.

If the adsorption and

desorption on capillary walls are significant then it would affect the experimental results.
This is one of the drawbacks of this system.

2.3.3

Calibration and Detection Limits
As mentioned for APIMS, calibration of EIMS is also an important aspect.

Unlike APIMS where the response of the system is given as counts per second, the
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response of this mass spectrometer is given by the ion current in Amperes. In the low
ppb and ppm range the mass spectrometer gives a linear relationship between the
concentration and ion current.

Calibration gas is generated by using certified gas

mixtures containing the impurity of interest with balance nitrogen. Research grade gas
cylinders are used calibration gas. There is a gas mixing system where a known and
controlled concentration of impurity of interest is generated and is challenge to the mass
spectrometer. Once the equilibrium is achieved, ion current is recorded. Range of
impurity concentrations is generated and a calibration curve of ion current versus
concentration is obtained. There are several factors which affect the detection limits such
as detection limit of the mass spectrometer, inlet system, electrometer noise, temperature
stability and gas supply stability. The performance specifications on the system are given
in Table 2.3.

Table 2.3 Impurity detection limits of Electron Impact Mass Spectrometer
Species

Detection Limit

H2

500 ppb

H2 O

600 ppb (in argon, nitrogen and other inert gas

N2 and CO

200 ppb (in argon)

CO2

30 ppb

Ar

30 ppb (in nitrogen, helium)
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2.4 CAVITY RING DOWN SPECTROSCOPY
2.4.1

Introduction
Cavity ring down spectroscopy (CRDS) is a powerful technique used to measure

concentration of light absorbing species in gas. This technique is based on absorption of
light unlike mass spectrometers which uses mass to charge ratio to measure species
concentration. This technique has gained importance in recent years mainly because of
its extremely high sensitivity and ease of operation. CRDS works by attuning light rays
to the unique molecular fingerprint of the sample species. Accurate molecular count in
milliseconds can be achieved by measuring the time it takes the light to fade or “ring
down”. The time it takes the light to decay is converted to the concentration of the
species or contaminants in the gas. Thus this technique is rapid, non destructive and
exact [91].
There are two main advantages to CRDS over other absorption methods:
1) CRDS is not affected by the fluctuations in the laser. This is because it measures
the amount of time it takes to ring down thus is independent of brightness of laser.
Unlike other absorption methods which require the light to be stable between
measurements and any change in it will introduce errors.
2) The light travels back and forth between the mirrors increases the path length
hence it enhances the sensitivity of measurements. So even a small amount of
species present can be detected.

105

The CRDS in the lab was dedicated to measure only the concentration of moisture. The
model of CRDS used for the study was MTO-1000 by Tiger Optics.

2.4.2

How It Works
Figure 2.11 shows the schematic of CRDS. It is made up of the following

components [92].

Acousto-Optical
Modulator

Diode Laser

Mirror

Optical
Fiber

HR Mirror

Isolator

Cavity Ring-Down
Absorption Cell
HR Mirror

Mirror

Photodiode Trigger

Computer

Figure 2.11 CRDS schematic [14]
1) Diode Laser – This is the source which emits light energy.
2) Isolator – This prevents light energy feedback from interfering with the laser
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3) Acousto-optical Modulator – This is a shuttering device for the light source.
4) Absorption cell – It contains highly reflective mirror which creates a
measurement cavity
5) Photodiode – This monitors the light energy from the absorption cell
6) Trigger – This works along with photodiode and sends signal to activate the ring
down cycle.
The following steps describe how the CRDS works:
1. A Continuous Wave (CW) diode laser emits a directed beam of light energy
through an ultra-high reflective mirror into the absorption cell (cavity) as shown
in Figure 2.12.
2. Within the cavity or the absorption cell light travels over a total path length of 100
kilometers. This is achieved by light reflecting back and forth between the highly
reflective mirrors several times.
3. Once the photodiode detector sees a preset level of light energy, the light source is
shuttered or diverted from the cavity.
4. On each successive pass, a small amount of light or ring down signal emits
through the second mirror and is sensed by the light detector.
5. Once the light “rings down”, the detector achieves a point of zero light energy in
milliseconds and the measurement is complete.
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Figure 2.12 CRDS absorption cell [15]

2.4.3

Principle of CRDS
CRDS uses Beer’s Law to measure the concentration of species in the gas.

Basically there are two measurements which are done. First measurement is done when
the cell is empty called Tau empty, and the second measurement is done when the cell is
filled with contaminants. Tau empty value corresponds to a zero baseline correction. It
is determined by tuning the laser off the absorption peak for the contaminants of interest
which in this research is moisture. This corresponds to all the absorption outside the
absorption cell or cavity. Once the tau empty is calculated, the computer tunes back to
the absorption peak of the contaminants to determine the tau value, which depends on the
concentration of the contaminants present in the gas. By measuring the ring down time
during the empty cell and filled cell, the concentration of the species can be calculated.
The advantages by measuring empty cell first is that the absolute measurement is
unaffected by looses outside the ring down cavity [14].
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First Measurement:

τ empty =

d
c (1 − R m )

…2.5

Second Measurement:

τ (ν ) =

d
c (1 − Rm + σ (ν ) Nd )

…2.6

Concentration:

1  1
1 
N=
−

cσ (ν )  τ (ν ) τ empty 

…2.7

Laser temperature is a critical parameter of CRDS which has to be tuned to right
value to get the correct measurement of concentration.

Each species has its own

absorption peak and at certain value of laser temperature the peak value is highest.
Figure 2.13 shows the absorption value vs. laser temperature for two species water and
methane [93]. Laser temperature for moisture was set at 12.6 oC. Typically, laser
temperature is stable over a long period of time, but it was observed in our system that
laser temperature deteriorated with time. So after every several months, CRDS had to be
tuned to the correct laser temperature.
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Figure 2.13 Effect of laser temperature on absorption value [93]
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Figure 2.14 Calibration of laser temperature to calculate maximum moisture absorption
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Figure 2.14 shows the tuning of laser temperature done for moisture. It can be observed
from the Figure that slight variation in temperature can give different reading of moisture
concentration. Therefore, this is one parameter which has to be monitored constantly
over a period of time.

2.4.4

Modes of Operation
There are several modes of operations in MTO-1000, with each mode for a

specific purpose [94].

2.4.4.1

Measure Mode
In this mode, the concentration of the contaminant is measured. The sample gas

is introduced into the absorption cell and ring down time is measured; this gives the
concentration of the contaminant. This process of collecting of sample and processing of
ring down data is repeated to give change in concentration of impurity with time. If more
than one inlet is used for studying, then sampling time for each inlet is predefined.
Figure 2.15 shows the three multifold flow unit. The absorption cell is challenges with
the first inlet by opening its valves while the valves of other inlet are closed. The
analyzer calculates the ring down time and converts it to concentration. Then it is
switched to another inlet, first the cell is purged of the previously sample gas and then
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measurement is done. This way each concentration in each inlet is measured and the
cycle is repeated.

2.4.4.2

Service Mode
In this mode the analyzer is kept at standby to perform any maintenance or to

make any changes to the settings, such as cell flow rate, time for sampling, length of
recording the data, wavelength of the peak of interest of the contaminants. While in
service mode, no measurements are made.

2.4.4.3

Tune Mode
In this mode background ring down time is determined. The off peak ring down

time will be used to calculate the actual concentration of the contaminant by removing it
from the actual ring down time data. There are two types of TUNE cycles. First is called
the “Just Tau, empty”, in this measurement the absorption peak is changed to some value
other than the absorption peak value of the contaminant and ring down time is measured.
This TUNE cycle is done with the driest gas available. The second TUNE cycle is called
“Scan & Tau, empty” which is used for problem solving and trouble-shooting purpose.
In this cycle the laser is scanned throughout the region.
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Figure 2.15 Flow system – three manifold unit [94]
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2.5 TRANSMISSION ELECTRON MICROSCOPE
2.5.1

Introduction
Electron microscopy is a very powerful technique for surface characterization of

thin films. Unlike light microscope, it uses electrons to create an image of a specimen.
High resolution and high magnification is a characteristic of electron microscope, which
allows atomic scale imaging. German scientist Ernst Ruska and Max knoll built the first
electron microscope. It was based on the principles discovered by French scientist Louis
de Broglie. It was capable to magnify objects by four hundred times.
Electron microscope is used to examine biological specimens such as
microorganisms and cells, metals and crystalline structures. It is also used extensively
for defect analysis, quality assurance and failure analysis in semiconductor device
fabrications. Using electron microscope great details in these samples can be viewed.
Transmission electron microscope and scanning electron microscope are examples of
electron microscope [95].
In this research transmission electron microscope is used to characterize porous
low-k dielectric films. It is also used to measure the thickness of these films. The
instrument used for this study is Hitachi H8100.

It is a conventional TEM with

maximum accelerating voltage of 200 kV and with high brightness LaB6 electron source
and large specimen-tilt (> 30 degrees) capabilities. It offers phase contrast resolution of
better than 0.26 (point) and 0.14 nm (line). It is equipped with small probe forming
lenses for nano diffraction, CBED and hollow-cone illumination. A heating stage (up to
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1000 oC) and a LN2 cooling stage coupled with CCD high resolution camera allows
unique dynamic in-situ experiments.

2.5.2

Principle of Transmission Electron Microscope
Electron microscope as the name suggests uses electrons to generate image of

very small objects, which could other wise not be observed both by naked eye as well as
light microscope. One reason, why electron microscope can image very small objects as
compared to light microscope is because the wavelength of electrons is much shorter than
that of visible light. Microscope resolution is limited by the wavelength of the probing
medium, which in case of TEM is electron. It is known that smaller the wavelength, the
better the resolution. Resolution is defined as the smallest detail that can be distinguished
in an image. The minimum distance that can be resolved by the microscope is given by
the following formula:

dd =

0 . 61 λ
n sin α

… 2.8

where, dd is separation between two points, λ is the wavelength of the probing medium, n
is the refractive index and α is semi angular angle.

Since resolution is inversely

proportional to dd, therefore the above formula suggests that to improve resolution,
shorter wavelength and larger refractive index is the approach to take. However, for
TEM these are not the only properties which determines the resolution, spherical
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aberration coefficient which is the property of the development of lens of the microscope
also affects the overall resolution of the instrument. Resolution of 0.2 nm is achievable
from a very well made instrument [96].
Electron microscope utilizes these principles by using extremely short
wavelengths of accelerated electrons to form high resolution image. Electrons have both
wave and particles properties. The wavelength of a beam of electron is dependent on its
energy; De Broglie related the wavelength of electron beam to the accelerating voltage
and is given by the following equation:

λ = 0.1

150
Vv

… 2.9

where, Vv is the accelerating voltage. For a voltage of 60,000 V wavelength of 0.005 nm
can be generated which is shorter by a factor of 105 than visible light. TEM uses the
wavelike properties of the electron to create extremely small wavelengths and is capable
of imaging atomic structures.
Electrons emanating from the electron gun passes through a series of
electromagnetic lenses called condenser lens which focuses the electron beam onto the a
very thin sample. Electron beam passing through the specimen is then focused onto the
viewing screen by an objective lens, apertures and a series of intermediate and projector
lenses. Photographic film or CCD camera along with computer is used to record the
image. Next sections describe different parts of the instruments.
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2.5.3

Transmission Electron Microscope Configuration
The instrument is made up of three main components:
a) Column
b) Evacuation system
c) Electrical Supply

Figure 2.16 shows a schematic of TEM column, which consists of series of lenses and
apertures, electron gun, viewing screen [97].
2.5.3.1

Electron Gun
Electron source is an important part of TEM column because generating a stable

source of electrons to illuminate the specimen is critical to get the best images. There are
mainly two types of electron source: thermionic and field emission sources.
a) Thermionic Gun
Thermionic sources are either tungsten filaments or LaH6 crystals; it is called thermionic
because it emits electrons when it is heated. As shown in Figure 2.17 thermionic gun
consists of a cathode (filament), an anode and a Wehnelt cylinder.

The anode is

grounded by connecting it to earth potential. A high electronegative potential is applied
to the cathode between 60 to 200 keV. As the filament current increase the temperature
increases and at saturation starts emitting electrons.

The high potential difference
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between cathode and anode accelerates the electrons down the optical axis of the column.
These emitted electrons acquire energy depending on the potential difference.

Figure 2.16 Schematics of TEM column [97]
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b) Field Emission Gun
Fine tungsten needles are used as a field emitter source. Field emission gun is
made up of a cathode (needle) and two anodes. First anode generates electric field
resulting in extracting of electrons from the tip of the needle. Second anode accelerates
the electrons.

Filament
Current
Supply

Bias
Resistor

Whenelt

High
Voltage
Supply
Filament
Anode

Cross-over

Figure 2.17 Whenelt cylinder
2.5.3.2

Gun Alignment Coils
Gun alignment coils are located right below the electron guns. This is used to

direct the electron beam to the center of the optical axis. It is made up of magnetic coils
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2.5.3.3

Condenser Lenses
The instrument consists of couple of condenser lenses.

These lenses are

electromagnetic lenses and are magnetic equivalent to glass lenses in optical microscope.
First condenser lens is used control the spot size of the beam. The instrument offers three
different beam diameters nano, fine and macro for different imaging. Second condenser
lens is used to control the brightness of the electron beam. Both the lenses together focus
the electron beam onto the sample.
2.5.3.4

Condenser Apertures
Condenser aperture is used to allow only certain amount of electrons to reach the

specimen. It acts as a restriction for electrons both to protect the sample from over
heating and to limit generation of x-rays. Apertures are available in different sizes and it
is adjusted based on the applications.
2.5.3.5

Condenser Stigmator
Often times the condenser lenses introduces astigmatism into the imaging beam.

Stigmators are used to correct such astigmatism i.e. to make the beam as symmetrical as
possible. It is made up of electromagnetic poles and can adjust beam diameter in both x
and y directions.
2.5.3.6

Beam Tilt
Beam tilt is used to align the beam to the optical axis before it reaches the

specimen. It can translate the beam with respect to the specimen as well as tilt the beam.

120

2.5.3.7

Objective Lens
The objective lens is the most important part of the instrument. It is used to form

images and diffraction pattern. Typically, a strong objective lens is used to decrease the
focal length. This is because shorter focal length results in less aberration which in turn
results in better resolution. It is also difficult to make because the specimen is located
very close to the lens.
2.5.3.8

Objective Aperture
Objective aperture is placed in the back focal plane of the lens and is used to stop

any stray electrons. It comes in varying sizes, thus varying the number of electrons
leaving the aperture. It also increases the contrast of the image. It is made up pf a
refractory metal, usually molybdenum or brass.
2.5.3.9

Objective Stigmator
Like the condenser Stigmator, objective Stigmator also corrects any astigmatism

in objective lens. It also consists of normally eight electromagnetic poles which creates
field in different directions depending on the current applied to each poles.
2.5.3.10 Specimen Holder
Specimen holder is used to insert and remove the specimen into the column.
Specimen can either be a very thin disc or mounted upon an electroformed mesh known
as specimen grid.
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2.5.3.11 Intermediate and Projector Lens
These are series of electromagnetic lenses which are used to magnify the images
and to focus the image onto the viewing screen.

The first intermediate lens also

determines whether analysis being done is either electron diffraction or imaging.
2.5.3.12 Viewing Screen
The image of the specimen or the diffraction pattern of the specimen is formed on
the viewing screen.

2.5.4

Imaging Mode
There are three main imaging methods which are often used. These are Bright

field image, dark field image and high resolution image. Different mechanisms are used
for each imaging methods. The main principles used are based on elastic and inelastic
scattering. In elastic scattering electrons from the main beam interacts with the atomic
nucleus of the atoms where in the electrons are deflected by a large angles with little loss
in energy. This form of interaction occurs because the mass of the nucleus is much
greater than the electrons. In inelastic scattering the incident beam of electrons interact
with valence electrons of the atoms, resulting in loss in energy of the incident electrons
but with little change in direction. This is because of the interaction of equal mass of
bodies. These interactions results in phase contrast and amplitude contrast which is
important for image formation. Different imaging modes in TEM are very useful in
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imaging internal microstructure of materials as well as the pattern formed by the
diffracted electrons provides valuable information about crystalline structure. Images in
TEM are either formed by using the transmitted bam spot or some or all of the diffracted
electrons. In order to choose which electrons form the image, an objective aperture is
inserted into the back focal plane (the plane where the diffracted image is formed) of the
objective lens, thus blocking most of the diffraction pattern except that which is visible
through the aperture. The back focal plane is situated below the sample and the objective
lens. Objective aperture is adjusted externally so that either the transmitted electron or
some of the scattered electrons go through it.

2.5.4.1

Bright Field Imaging
Bright field image is obtained when the electrons from the direct beam is allowed

to pass through the aperture. Figure 2.18a show Bright Field imaging technique and
Figure 2.18b shows the diffraction pattern obtained in Bright Field mode [98]. This
imaging mode takes advantage of mass thickness or mass contrast and diffraction contrast
for micro structural imaging.

Some electrons passing through the sample undergo

inelastic scattering resulting in contrast in the image due to difference in scattering.
Thick areas (areas in which heavy atoms are enriched and crystalline areas) appear with
dark contrast. Bright Field mode is normally used to image grain and defect structures
(i.e. dislocations, voids, stacking faults and twins) within materials. Second phases such
as precipitates or inclusion are also easily observed by this technique [99].
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Figure 2.18a Bright Field Imaging [98]

Figure 2.18b Bright Field diffraction pattern [98]
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2.5.4.2

Dark Field Imaging
The Dark Field imaging mode makes use of the specific Bragg diffracted

electrons to image the region from which they originated. It is mainly obtained for
crystalline sample with which incident beam electrons undergo elastic scattering. There
are two different techniques of obtaining Dark Field image.

In one such method

objective aperture is moved away from the optic axis so that only diffracted beam is
passed. This is called off-axis Dark Field image as shown in Figure 2.19a [99]. The
drawback of this image is that it results in spherical aberration and astigmatism. In order
to get a better image and resolution, another method is used, in which aperture remains
on the optic axis and the diffracted beam is tilted such that it lies parallel to the optic axis
of the microscope as shown in Figure 2.19b. This is called Centered Dark Field image.
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Figure 2.19a Off-axis Dark Field [100]

125

Tilted Incident
beam

Diffracting
planes
specimen

Objective
Lens

2θ
θ

Diffracted
beam

Transmitted
beam
Objective aperture

Figure 2.19b On-axis or Centered Dark Field [98]

Figure 2.19c Dark Field diffraction pattern [100]
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Dark Field is primarily used for imaging closely planar defects, stacking faults
and particle size. Figure 2.19c gives the diffraction pattern obtained in Dark Field mode
[98].
2.5.4.3

High Resolution Imaging
High resolution imaging is one of the advantages of using TEM. Atomic scale

resolution is obtained in TEM by phase contrast technique. To obtain high resolution
image, transmitted beam along with four diffracted beam is allowed to pass through the
objectives lens aperture [101]. Following steps describes the method to obtain a good
high resolution image:
1) Instrument should have high λ and low Cs
2) Aligning the instrument well
3) Performing voltage and current centering of objective lens frequently
4) Working in a thin, flat and clean region
5) Correcting the astigmatism
6) Using small SAD aperture
Contamination and damage due to incident beam of electrons during high resolution
imaging can be a potential issue, which one need to be careful about. Do not spend more
time on a spot than needed.
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2.6 FOURIER TRANSFORM INFRARED SPECRTOSCOPY
2.6.1

Introduction
Fourier Transform Infrared Spectroscopy (FTIR) is a powerful technique to do in-

situ study. This tool is very useful in identifying different kinds of chemical bonds in any
molecules. It can be used to study gases, liquids as well as solids. It is useful to identify
unknown components. The term Fourier Transform is used because in this technique
interference pattern is converted to absorption spectrum using Fourier analysis.

In

infrared spectroscopy, IR radiation is passed through the specimen to be studied. Some of
the radiation is absorbed while some is transmitted. This produces a molecular spectrum
of the sample which is unique for the sample also called molecular fingerprint [104].
Each molecular structure produces its own spectrum which is unlike the others, this is
because each bonds in the molecules vibrates at its own frequency which is unique for
each species. No two species has the same molecule structure thus, the absorption
spectrum is also different. Thus, FTIR is very useful for different types of analysis. It
can be used identify unknown compounds, qualitative and quantitative study as well as
dynamics study. In addition the peak intensity is correlated to the concentration of
material present [103].
There are three main regions of infrared: far IR region, between 200-10 cm-1 (501000 µm wavelength), mid IR region, between 4000-200 cm-1 (2.5-50 µm wavelength)
and near IR region, between 13000-4000 cm-1 (0.78-2.5 µm wavelength). In this research
mid IR region has been used for study. Far IR is typically used for organic, inorganic and
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organometallic compounds, while near IR spectroscopy is mainly used for process
control applications. Perkin Elmer 1720X and Nicolet 6700 series FTIR instruments was
used for this research.

2.6.2

Theory of Infrared Absorption
Any molecule typically has three kinds of motion, translational, rotational and

vibrational.

The atoms in the molecule vibrate at a particular frequency, only that

vibration which has similar frequency to IR radiation absorbs the radiation.

Each

molecule has 3n-6 or 3n-5 fundamental vibrations, but only those vibrations which
produce net change in dipole moment are visible in IR and those which give
polarizability changes are observed in Raman spectroscope.
Often times, the total number of observed absorption bands in IR spectrum is
different from the total number of fundamental vibrations.

This is because some

vibrations are not IR active or a particular frequency can result in more than one mode of
motion.

Also additional bands are observed due to combination of fundamental

frequencies or overtones, all of which results in a unique IR spectrum for a particular
molecule [104].
There are two main types of molecular vibrations stretching and bending. Figure
2.20 shows different kinds of motion or vibrations. These vibrations are asymmetrical or
symmetrical stretching, In-plane bending of scissoring, Out-of-plane bending or wagging,
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Figure 2.20 Major vibrational modes for a nonlinear group, CH2 (+ indicates motion
from the plane of page toward reader; - indicates motion from the plane of page away
from reader) [104]
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Out-of-plane bending or twisting and In-plane bending or rocking. Not all molecules will
display all of these vibrations, depending on the types of bonds in molecules different
vibrations are observed.

2.6.3
2.6.3.1

The Key Components of FTIR
The Radiation Source
A glowing ceramic or a black-body source is used to emit infrared energy. This

beam of energy is passed through aperture also called Jacquinot stop which controls the
amount of the energy reaching the sample and in turn the detector.

2.6.3.2

The Interferometer
The beam after passing through the Jacquinot stop enters the interferometer

region where it splits the beam at the beamsplitter generating an optical path difference
between the beams. These beams are again recombined to produce repetitive interference
signals measured as a function of optical path difference.
The most common interferometer used is a Michelson interferometer.

It

comprises of three main parts: a moving mirror, a fixed mirror and a beamsplitter as
shown in Figure 2.21. The two mirrors are placed perpendicular to each other. The
beamsplitter is a semi reflecting device which is made of different materials; a typical
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beamsplitter is made of KBr. IR beam from the source first hits the beamsplitter, where it
is divided into two beams; half of the IR beam goes towards the fixed mirror and the
other half towards the movable mirror. The beams after reflecting from the two mirrors
are recombined again at the beamsplitter. If two paths are same or different by integral
number of wavelengths for a given frequency they add up together resulting in
constructive interference otherwise it results in destructive interference. As the movable
mirror changes it positions relative to fixed mirror, an interference pattern is generated.
Figure 2.22 shows a typical interferogram pattern. The intensity of radiation reaching the
detector varies is a sinusoidal manner.

The resulting interferogram then exit the

interferometer.

IR Source
Fixed
Mirror

Beam
Splitter

Sample

Detector

Movable
Mirror

Figure 2.21 Simplified optical layout of a typical FTIR spectrometer
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2.6.3.3

The Sample
The beam then enters the sample compartment area where it interacts with the

sample. The beam either is transmitted through the sample or is reflected off the surface
of sample, depending on the type analysis being performed. Only those vibrations which
are characteristics of the sample absorb IR radiation and the amplitude of the sinusoidal
wave is reduced by the amount proportional to the amount of sample in the beam. The
sample could be either in gas, liquid or solid form.

Center burst
All wavelengths in phase

Successive Destructive
Interference

Retardation
(Mirror Travel)
Zero Path
Difference
Figure 2.22 Typical interferogram [104]
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2.6.3.4

The Detector
The beam after passing through the sample is finally directed towards the detector

where measurement is done. There are several kinds of detectors but the two kinds of
detector used in this research are deuterated triglycine sulfate (DTGS) and mercury
cadmium telluride (MCT). The DTGS detector is a pyroelectric detector that delivers
rapid responses because it measures the changes in temperature rather than the value of
temperature. The MCT detector is a photon detector that depends on the quantum
radiation and also exhibits very fast response. DTGS detector is a room temperature
detector, where as for MCT liquid nitrogen is used for it to respond. The MCT detector
is faster and more sensitive than the DTGS detector.

2.6.3.5

The Computer
For data interpretation and analysis, transmission or absorption spectrum over the

entire range of wave number is needed. The computer converts the signal to absorption
intensity vs. wave number using Fourier Transform. The generated infrared spectrum is
then used for manipulation and interpretation. Figure 2.23 shows a typical infrared
spectrum.

2.6.4

FTIR Advantages
FTIR has several advantages over other dispersive spectrometers:
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1. Better speed and sensitivity: Since it generates a spectrum over the entire range
of frequencies at the same time, measurements are done at a faster rate. This
advantage is called Felgett advantage.
2. Increased optical throughput: Changing the size of aperture, amount of energy
passing to the interferometer is controlled. This is called Jacquinot advantage.
3. Simple Mechanical Design: There is only one moving part, the movable mirror,
resulting in less wear and better reliability.
4. Internally Calibrated: Helium Neon laser is used to calibrate the FTIR systems.
Having it set internally avoids any external calibrations. This is called Connes
advantage.

2.6.5

Problems with FTIR
There were two main problems which were observed when using the FTIR. The

background nitrogen spectrum was not stable and the spectrum would fluctuate with
time. Two main reasons were identified for the fluctuation in reading: a) fluctuation in
line voltage, b) temperature not stable. In order to overcome this problem, instrument is
kept running 24x7, so that the temperature is stabilized.
fluctuation, a voltage stabilizer is installed.

To control the voltage
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CHAPTER 3
EXPERIMENTAL DESIGN

3.1 INTRODUCTION
To determine fundamental physical and geometrical parameters, it is important to
perform a detailed and systematic study. For this study experimental methodology was
developed for determining the fundamentals of moisture interactions and outgassing in
porous ultra low-k films focusing primarily on moisture loading, molecular transport,
chemical interactions and moisture removal. The experimental design and setups are
discussed both for gas phase study using mass analyzers and in-situ characterization
using FTIR. This experimental setup is used to characterize various porous low-k films
and to generate good and reliable absorption and desorption data. The data generated
along with process model developed is used to determine some of the fundamentals
kinetic and transport parameters.
The dielectric surface was first exposed to impurity laden gas in a well designed
reactor and controlled fashion as described below. The impurity concentration was
measured in real time using different analytical tools with capability of measuring
concentration over wide range (parts per billion, ppb to percentage level). Amount of
contaminant absorbed during exposure and removed during purge were obtained by
doing mass balance around the reactor. Thus, characterizing the sorption behavior of
these porous films will help in successfully integrating these films in semiconductor
processing.
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3.2 EXPERIMENTAL SETUP FOR MASS SPECTROMETER
Figure 3.1 shows the experimental setup used to study the interactions of trace
levels of moisture with porous low-k dielectric films. The experimental set-up primarily
consists of three sections:

(a) Gas Mixing Section
The gas mixing section was designed to allow delivery of purge gas as well as
challenge mixture (carrier, N2 gas plus controlled level of moisture) in a well-defined,
rapid, and controlled manner to the test reactor. The carrier gas was Ultra High Purity N2
gas with moisture concentration less than 1 ppb. Saes getter was used as purifier to attain
UHP gas. Accurate calibrated gas mixtures could also be prepared using the gas mixing
set up. Permeation device provides stable concentration of a specific trace chemical,
which for the present study is moisture. Moisture permeation tube from G-cal was used
to generate a control concentration of moisture.

The advantages of using G-cal

permeation devices are [105]:
1) Can be operated at room temperature
2) Longer life than other kinds of permeation devices.
Moisture permeation device used for the study was certified at 50oC to give
moisture permeation rate of 75 ng/min.
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Permeation rate was certified using NIST standard.
temperature sensitivity of moisture permeation rate.

Figure 3.2 shows the

Moisture concentration was

calculated using the following formulae:

C

K * P
Fv

c =

'

…3.1

where, Cc is the moisture concentration in ppm, P’ is the permeation rate in ng/min, Fv is
carrier gas volumetric flow rate over the permeation device in standard cubic centimeter
per minute (sccm), and K is the molar constant which for moisture permeation tube is

Permeation Rate (ng/min)

1.358. K varies for different kind of impurity species.
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Figure 3.2 Temperature sensitivity of moisture permeation device
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Errors due to dead volumes were minimized by eliminating stagnant parts and by
continuously maintaining gas flow through the entire system. The gas delivery lines,
made of Electro Polished Stainless Steel (EPSS) 316L, were heated to minimize moisture
memory effects.

(b) Reactor Section
The experimental reactor for absorption/desorption experiments used in this study
was designed by past students in our group. The dielectric wafers to be studied were
diced to produce 1 cm x 2 cm coupons, which were then loaded onto nickel coated
stainless steel springs and then randomly packed in a tubular pyrex reactor. Figure 3.3
shows a typical experimental reactor. The ends of the reactor were sealed with Cajon
glass-metal seals that used stainless steel to Pyrex joints instead of the graded-glass seals.
Such a reactor design had several well designed features.
This arrangement provided complete mixing of gases, thus the reactor could be
treated as a differential reactor. In order to increase the contribution from the wafer to
the overall absorption/desorption process, high wafer to glass surface area ratio was
maintained. The total sample surface area was 648 cm2, which is 70% of the total surface
area (i.e. area of glass reactor and area of wafer surface). The reactor was made of pyrex
because its surface resembles close to surface of silicon oxide, and therefore their
outgassing characteristics can be assumed to be similar to silicon oxide surface. Also, the
area of tubing carrying the contaminants were minimized by using 1/8” tubing and it was
kept heated to reduce the effect of adsorption/desorption process.
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The packed bed reactor containing the wafer coupons was kept at a controlled
temperature using a programmable furnace. This allowed doing both isothermal study as
well as high temperature study. One drawback of using the pyrex reactor was that
moisture from ambient could permeate into the reactor at temperature higher than 300 oC
as shown by previous studies done by Verghese [106]. Therefore the temperature range
studied was from 30 oC to 250 oC.

(c) Data Acquisition
An atmospheric pressure ionization mass spectrometer (APIMS) system was set
up and utilized to monitor the reactor outlet gas-phase concentration of moisture. This
system has the ability to detect impurities at ambient pressure with high sensitivity (in
single digit parts per trillion, ppt, range) and fast response time, thus allowing the study
of adsorption/desorption kinetics at atmospheric pressure under flow conditions.
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3.3 EXPERIMENTAL SETUP FOR FTIR

As shown in Figure 3.4, a unique set up was developed in this research for real
time and in-situ characterization of porous low-k dielectric films. The experimental setup
consists of three sections: the gas mixing section, the sample cell, and the analyzer
(FTIR). Ultra high pure (UHP) N2 is used as the carrier and diluent gas. The gas mixing
system delivers purge and challenge gas to the reactor in a well controlled fashion.

In order to minimize dead spaces, flow of gas is continuously maintained
throughout the entire setup. All transfer lines are electropolished stainless steel and are
kept at about 150 ºC to minimize memory effects of contaminants.

Figure 3.5a and 3.5b shows the front view and top view of the cell. For the
purpose of increasing the sensitivity, the cell is designed in such a way that several
sample coupons (one inch by one inch) can be placed parallelly in the path of light so that
light passes through more sample length. Transmission mode has been used in this study.
Mercury Cadmium Telluride (MCT) detector is used to further enhance the sensitivity of
absorbance.
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Figure 3.4 Schematic of FTIR experimental setup
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Figure 3.5a FTIR cell (side view)
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Figure 3.5b FTIR cell (top view)
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The novel design of the cell allows well controlled purging of the samples. In
order to study the changes happening on the surface in real time, it is important to have a
good control of the surrounding medium and an effective purge process. Otherwise, the
accumulation of gas phase impurity concentration will affect the results. Figure 3.6
shows the efficiency of purging the cell. 4000 ppm of IPA was challenged into an empty
cell. After the cell was saturated with IPA, the cell was purged with UHP N2 at the flow
rate of 2 slpm. Scans are taken at every 30 s time interval from 2500 – 3500 wave
numbers. The peaks which are characteristic of IPA are CH3 asymmetric and symmetric
stretching. These occur at 2977 cm-1 and 2922 cm-1 wave number respectively. Baseline
corrected peak area between 2950 and 3000 wave number are calculated for each scan.
Integrated area is plotted against time as shown in Figure 3.6. As observed from the
Figure that 99.8 % of the IPA is removed in less than 30 s. This result suggests that cell
has very good purge efficiency. The inset to Figure 3.6 shows the time required to purge
the remaining IPA gas from the cell. This slight slow process towards such small
concentration level could be because of adsorption of IPA on the walls of the cell
window. However, this is not a big concern.

This set-up allows studying dynamics of impurity outgassing; the results could be
used to extract fundamental physical parameters such as diffusivity and solubility of
impurities in low-k films.

The cell can be used to study over a wide range of

concentration using the gas mixing setup as well as wide range of temperatures ranging
from room temperature to 200 oC. In chapter 4 experimental results of FTIR study would
be discussed in details for different porous low-k films.
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3.4 EXPERIMENTAL PROCEDURE
The experimental procedure consisted of the following steps:
1) Pre-purge/bake: The as received samples were first cleaned with UHP nitrogen
purge gas at high temperature bake. This was done to clean the surface and remove
any surface impurities during desorption process.
2) Isothermal Absorption: The cleaned sample was first exposure to impurity laden
carrier gas at a known concentration and temperature till the surface comes in
equilibrium with the challenge gas. This constituted the sorption cycle during which
moisture was incorporated by the sample.
3) Isothermal Desorption: Following isothermal sorption process, desorption cycle
was initiated by switching to ultra-pure nitrogen purge. Isothermal desorption was
carried out at the same temperature as the sorption cycle till the moisture
concentration in the reactor outlet gas reached the background level.
4) Bake Cycle: The reactor was purged and baked under ultra-pure nitrogen up to 300
o

C to desorb any residual contaminants from the wafer surface. This step wise purge

and bake was carried out successively up to 300 oC. The reactor was heated to a
higher temperature to speed up desorption rate. This step is important to achieve
similar starting surface for each experiments.
Moisture concentration at APIMS was measured by 18 mass to charge m/e ratio.
Figure 3.7 shows a cartoon of experimental procedure. By calculating the area above the
absorption profile, one can estimate the total amount of moisture absorbed in the film,
whereas, by calculating the area below desorption profile gives the amount of moisture
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removed within a certain time. Figure 3.8 shows a typical outlet-gas concentration
profile as measured by mass spectrometer.
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Figure 3.7 Schematic of experimental procedure
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Figure 3.8 A typical temporal outlet-gas impurity concentration profile as measured by
mass spectrometer (Exposure to 110 ppb at 30 oC followed by temperature programmed
desorption at higher temperatures)
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3.5 CALIBRATION OF MASS SPECTROMETER
The output of APIMS is given in counts of the impurity. Therefore calibration of
APIMS for moisture impurity is important to convert the counts to concentration in ppb.
Different concentration of moisture ranging from 2 ppb to 25 ppb was challenge to the
APIMS and respective counts were recorded. Figure 3.9 shows the moisture calibration
curve.

It is observed from the Figure that the counts vary linearly with moisture

concentration in the range of study. This curve was then further used to convert the
counts recorded by APIMS to moisture concentration for all experiments. The source
voltage was kept at 3900 V and SEM voltage was 2700 V for all measurements.
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Figure 3.9 Moisture calibration curve
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CHAPTER 4
INTERACTION OF MOLECULAR CONTAMINANTS WITH
LOW-k DIELECTRIC FILMS

4.1 INTRODUCTION
Today, commercially wide varieties of low-k materials are being developed and
used as the inter layer dielectric (ILD) in integrated circuit manufacturing. It is predicted
that for future technology node the effective dielectric constant value of the low-k films
should be 2 or less. There is also considerable research going on to use air gaps instead
of low-k films as ILD mainly because air has a dielectric constant value of 1.
Implementation of low-k dielectrics in manufacturing environment requires an
understanding of these new materials’ characteristics and the challenges that appear in the
integration of the low-k film into the semiconductor processes. These porous low-k films
have to satisfy certain thermal, mechanical, electrical and chemical characteristics for
successful integration in manufacturing process.

Although there are several low-k

materials being used in integrated circuit manufacturing, there is no clear winner. None
of the low-k materials available in the market can fulfill all the required properties and
successfully replace silicon oxide, which was used as the interlayer dielectric material for
several decades.

Reducing the k value of these films by increasing porosity and

decreasing density of the materials by using bulky groups such as methyl has a drastic
effect on their mechanical thermal and chemical properties [107-109].
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Since most of the low-k materials for current and future technologies are porous
in nature, this brings up several challenges. These low-k films are deposited mainly by
two methods, spin-on and CVD (Chemical Vapor Deposition). One such challenge is
that none of the materials available for semiconductor applications are dense in nature for
dielectric constant below 2.5 [110]. These results in problems of depositing dense etch
stop and copper layers.

Also residual gases from patterning (etching and ashing)

processes can reside in pores and can outgas later in processes. Another challenge in
integrating these low-k dielectric materials is their susceptibility to wet and dry cleaning
processes.

Most ultra low-k materials are attacked by CMP and post CMP clean

chemicals so capping with dense materials becomes an important step during processing
[111].
Moreover, as the films are made more porous and less dense, it makes the films
mechanically very fragile and causes adhesion issue with under layers and cap layers.
Processes such as CMP, electromigration reliability testing, assembly and thermal
processes introduce stress into the dual damascene structure which makes the film highly
prone to damage and cracking.
Beside their poor mechanical and thermal stability another disadvantage is their
ability to absorb chemicals, such as contaminants containing polar O-H bonds due to their
porous structure. Even a small amount of absorbed moisture can increase the total k
value since the k value of water is as high as 79 [33].
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The properties of interlayer dielectric films are sensitive to the presence of
homogeneous contaminants from various sources, which in turn can affect the process
yield and degrade the final device performance. Moisture and organics are among the
most detrimental because of their high reactivity with material surfaces. These molecular
contaminants affect in several ways [112]:
a) resist and via poisoning
b) etch rate shifts due to incomplete wetting
c) delamination, non-uniform Cu-seed deposition
d) photolithography
e) increase in k value
f) increases signal propagation delays
g) cross-talk between interconnects
h) metal corrosion
i) delamination of cap layers
j) reliability and adhesion problem due to gradual outgassing
Therefore characterizing the sorption behavior of ultra low-k materials will assist
in deciding their potential for successful integration in semiconductor processes. To
design a process that minimizes the impact of moisture and organic contamination, it is
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necessary to have a fundamental understanding of the interactions between gaseous
contaminants and the dielectric surfaces.

Therefore, understanding the transport of

impurities through these low-k dielectric materials and kinetics of interactions would help
in designing better processes for integration of low-k material in semiconductor
processing.
Niraj and Prashant did an exhaustive study of interaction of atmospheric
molecular contaminants mainly isopropanol and moisture on high-k dielectric surfaces.
The high-k surfaces they studied were silicon oxide, hafnium oxide and zirconium oxide.
Considerable studies have also been done on water diffusion in silica. Tomozawa et al.
have shown that water in glass has disproportionately large effects on various properties
of silica, such as chemical durability, mechanical strength and decrease in viscosity.
Furthermore, they observed that water in both hydroxyl and molecular form were
detected in silica [113]. Robert Doremus also showed that molecular water not only
diffuses into the silica but also reacts with the silicon-oxygen network to form SiOH
groups [114].
However,

the

mechanism

of

contaminant

absorption/desorption

and

diffusion/reaction in low-k materials, and the effect of porosity and pore structure on the
mobility of contaminants have not been adequately studied and characterized. These
films are exposed to wide variety of plasma treatments resulting in a complex matrix and
their behavior is widely different than silica. This information is critical because these
materials are exposed to a wide variety of conditions during fabrication processes. It is
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well known that moisture incorporated in a dielectric’s matrix interacts chemically with
the dielectric and exists in a variety of forms including both dissolved and reacted forms
[115, 116]. Unlike silica, the reactions with processed low-k materials involve many
intermediates (a wide spectrum of physical and chemical interactions). However, the
dissociated and reacted water undergoes reverse reaction when moisture is desorbed and
removed from the matrix. While the nature of intermediate compounds formed in the
matrix is important, the key parameters of interest for manufacturing are the overall
uptake of moisture. It is the uptake and removal of total moisture that is measured and is
of interest in the low-k dielectric processing. Therefore, it is common to use the term
incorporated or sorbed moisture to refer to all by-products of moisture interactions with
the matrix.
Fabrication process of devices involves several hundred steps, and these low-k
films are exposed to a variety of conditions.

Etching and/ or ashing are typical

processing steps which these low-k films are exposed to during fabrication. Etching and
ashing are typically done in plasma environment. Earlier studies have shown that these
processing conditions affect the physical properties of low-k films. This in turn would
affect its interaction with molecular contaminants. Eon et. al. showed that etching of
porous SiOC film in oxygen plasma environment decreases Si-CH3 bonds due to material
oxidation while increasing water adsorption [117]. Yonekura et. al. reported that treating
p-MSQ films in oxygen and hydrogen plasma environment degrades its properties [118].
These researches revealed that there are both structural and chemical composition

158

changes because of plasma etching and/or ashing processes. The focus of this study is
also to investigate the effect of patterning processes on moisture uptake and retention in
p-MSQ and BD IIx films.
Predicting moisture distribution within low-k film is also valuable. For instance,
during cleaning process, sometimes the average moisture concentration within a low-k
film is low while the moisture concentration near the interface of low-k film and substrate
is much higher than the average level. The moisture concentrated at the interface may
degrade adhesion between low-k film and cap layer.
Higher temperatures and purge gas purities usually enhance moisture removal in
low-k films. In order to lower cost and meet the thermal budget requirements during the
cleaning processes, it is also necessary to study the effect of these two operational
conditions on moisture removal rate in low-k films.
Lastly, a methodology for in-situ characterization of low-k thin films has been
developed. A unique set up was designed in this research for real time and in-situ
characterization of porous low-k dielectric films.

In order to study the changes

happening on the surface real-time, it is important to have a good control of the
surrounding medium and an effective purge process, otherwise the accumulation of gas
phase impurity will affect the results. The novel design of the cell allows well controlled
purging of the samples and can be used for dynamics study. Transmission mode has been
used in this study. For the purpose of increasing the sensitivity, the cell is designed in
such a way that several sample coupons can be placed parallely in the path of light so that
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light passes through more sample length. Mercury Cadmium Telluride (MCT) detector is
used to further enhance the sensitivity of absorbance. Ultra high pure (UHP) N2 carrier
gas is used to reduce the effect of impurities in the background. This unique set-up
allows studying dynamics of impurity outgassing; the results could be used to extract
fundamental transport parameters such as diffusivity and solubility of impurities in low-k
films. This new cell can be applied to study over a wide range of temperatures ranging
from room temperature to 350 oC.
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4.2 EXPERIMENTAL DESIGN
To determine fundamental physical and geometrical parameters, it is important to
perform a detailed and systematic study. For this study, an experimental methodology
was developed for determining the fundamentals of moisture interactions and outgassing
in porous ultra low-k films focusing primarily on moisture loading, molecular transport,
chemical interactions and moisture removal.

The dielectric surface was exposed to

impurity laden gas in a well designed reactor and in a controlled fashion as described
below. The impurity concentration was measured in real time using different analytical
tools with the capability of measuring concentration over a wide range (parts per billion,
ppb to percentage level). The amounts of contaminant absorbed during exposure and
removed during purge were obtained by doing mass balance around the reactor.

4.2.1

Experimental Setup
The setup used to study the sorption/desorption of ppb levels of moisture on p-

MSQ thin films is given in section 2.

The atmospheric pressure ionization mass

spectrometer (APIMS) was used to monitor the gas-phase concentration of the
contaminants at ppb-levels. The gas-mixing zone was designed to allow the distribution
of the challenge gas (impurity of interest) in a well-defined, rapid and controlled manner
to the test reactor. Accurate calibrated gas mixtures could also be prepared using the gasmixing zone. The packed bed reactor containing the wafer coupons was kept in a
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programmable furnace. Moisture was supplied by dedicated G-Cal and Kintek moisture
permeation devices for ppb-levels.

4.2.2

Experimental Procedure
The experimental procedure consisted of the following steps: initial purge and

bake, isothermal sorption, isothermal desorption, followed by a baking cycle.

The

detailed experimental procedure is described in section 2. Before each experiment, the
o

reactor was purged and baked under zero-gas nitrogen up to 250 C to desorb any
residual molecular contaminants from the wafer surface. Moisture concentration in the
outlet-gas from the reactor was the primary variable monitored during each experimental
run.

4.2.3

Test Samples
The test samples for this study were methylsilsesquioxane (MSQ) low-k

dielectrics (LKD 5109) with a dielectric constant of 2.2-2.3.

Eight inch wafers

underwent the following processes: 0.55 µm thermal oxide (wet oxidation), 0.35 µm
LPCVD nitride (thermal nitride on both sides of wafers), 0.40 µm Blanket JSR 5109,
standard JSR cure, partial etch, and finally partial ash. The dielectric film had a porosity
of 48% with an average pore diameter of 3 nm.
Sematech.

The samples were provided by
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Other test samples used for this study were porous methylsilsesquioxane (MSQ)
and Black Diamond IIx low-k dielectric films. The p-MSQ samples were provided by
Sematech Interconnect Group at Austin, Texas and BD II samples were provided by
Silicon Technology Development Group at Texas Instruments, Dallas, Texas.
Table 4.1 Samples used for the study
Film Type

Conditions

p-MSQ A

Partial etch @ 10s, N2/H2 ash @ 20s

p-MSQ B

Partial etch @ 10s, He/O2 ash @ 20s

p-MSQ C

Partial etch @ 10s, H2 ash @ 20s

p-MSQ D

Partial etch @ 10s, no ash

p-MSQ E

Blanket and cure only

p-MSQ F

JSR LKD 5109

BD IIx A

k-2.3, Blanket and cure only, 300nm

BD IIx B

k-2.3, E-NH3PT, 260nm

BD IIx C

k-2.3, E-NH3HePT, 260nm

Table 4.1 lists the film type and the various processing conditions. These films
were exposed to different processing environments to simulate the low-k film after
etching of pattern and ashing of the photo-resist.
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4.3 EXPERIMENTAL RESULTS AND DISCUSSIONS
4.3.1

Transmission Electron Microscope Study
Transmission Electron Microscope (TEM) was used to characterize p-MSQ A-E

films as well as to measure the thickness of these films. Figures 4.1a-c shows the TEM
micrographs for the various p-MSQ films studied. These films were deposited on silicon
substrate using spin coating method and were exposed to different plasma environments
to create different surface types. For each sample multiple TEM images were taken
which were reproducible.

This was mainly done to confirm the results which are

obtained for TEM study. The images were taken at 100KX and 50KX magnifications.
As observed from Figure 4.1a, the blanket p-MSQ film (film E) that has been cured only
has a very smooth and uniform single layer. It is evident from the micrograph that the
surface of the film is very even.

The average thickness of the film is about 200 nm.

Figure 4.1b is the TEM image for p-MSQ film (film D) which is the same blanket film
exposed to plasma environment. It was partially etched for 10 seconds to create a surface
similar to actual conditions in IC manufacturing process.

It is observed from the

micrograph that the etching process decreases the thickness of the film and also changes
the morphology of the surface, where the film is rougher as compared to film E. Only
145 nm p-MSQ film remained on the substrate after the etching process.
Figure 4.1c shows the TEM micrograph of p-MSQ film which was partially
etched for 10 s and exposed to He/O2 plasma environment for 20 s. Figure 4.1c shows
the formation of two distinct layers, a damaged top layer (section a in Figure 4.1c) and a

164

uniform unaffected bottom bulk layer (section b in Figure 4.1c). The thickness of the
film is around 125 nm; the thickness of the top layer is around 75 nm and bottom layer is
around 50 nm each. The damaged layer appears to be more porous compared to bulk
layer. This could be because O2 reacts more strongly with the methyl groups present in
the film, removing it in the form of CO2 and H2O as by products. The extent of low-k
damage depends on the exposure time to O2 plasma environment. It is concluded from
these images that He/O2 process damages the film more as compared to etch only
treatment.

It can also be concluded that etching and ashing process changes the

properties of the films which in turn would affect the behavior of moisture interactions.
Thus, studying the sorption behavior of patterned film is important for successful
integration of these films in integrated circuit manufacturing process. Similarly, TEM
images were generated for the other two films, which showed damaged and undamaged
layers. These micrographs are not shown here. Based on these results, it was assumed
that the physical properties of film E, such as, porosity, solubility, diffusivity and specific
surface area, are constant within the whole film, while patterned films have two distinct
uniform layers with different properties, and within each layer, all these physical
properties are assumed to be constant.
Energy Dispersive X-ray Spectrometers (EDS) was used to study the changes in
composition of the different films. It is believed that different processing conditions not
only affect the surface morphology of the films but also changes the composition of the
films. Table 4.2 gives the EDS results and the thickness of these films.
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Low-k

Substrate

100 nm

Figure 4.1a TEM micrograph of p-MSQ E film (blanket and cure only)

Substrate

50 nm

Low-k

Figure 4.1b TEM micrograph of p-MSQ D film (partial etch, no ash)
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a

b

Substrate

100 nm

Low-k

a: damage layer; b: bulk low-k layer

Figure 4.1c TEM micrograph of p-MSQ B film (partial etch, He/O2 ash)

Another important property which affects moisture interaction with these films is
whether the surface of these films is hydrophilic or hydrophobic.

Contact angle

measurement is a method for surface analysis which is related to surface energy and
surface tension. Contact angle describes the shape of a liquid droplet resting on a solid
surface. Contact angle of these films were determined by measuring the contact angle of
a water droplet using Goniometer. Several different locations on the films were used to
measure the contact angles and finally the average value was chosen. Table 4.3 lists the
contact angle of different films.
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Table 4.2 Energy Dispersive X-ray Spectrometer results
Approx
Film Type

Si

O

C
Thickness (nm)

p-MSQ A

Very Little
Yes

p-MSQ B

p-MSQ C

Yes

Yes

100

Yes

Yes

125

Very Little

Very Little

Oxygen

Carbon

Oxygen

Yes

125

p-MSQ D

Yes

Yes

Yes

145

p-MSQ E

Yes

Yes

Yes

200

The blanket p-MSQ film has a hydrophobic surface mainly because of the
presence of bulky methyl groups, which are non polar. Etching changes the contact angle
significantly making the surface hydrophilic. However, treating the films with reducing
chemistries which in this case are N2/H2 and H2 ash treatments restore the hydrophobicity
of the film. This could be because of formation of Si-H surface. While treating the film
with oxidizing chemistry reduces the contact angle making the film more hydrophilic.
This could be because of removal of methyl group by O2 treatment. It is important to
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know the hydrophobicity of the surfaces because this would affect the moisture
interaction behavior.
Table 4.3 Contact angle of different processed films
Film Type

Contact angle

p-MSQ A (N2/H2 ash)

102o

p-MSQ B (He/O2 ash)

50o

p-MSQ C (H2 ash)

90o

p-MSQ D (etch only)

48o

p-MSQ E (blanket)

105o

However, it should be noted here that just contact angle measurements do not
necessarily relate to moisture absorption in the films. This is because contact angle
measurement is the measure of water droplet on the surface of the film, where as
absorption of moisture on the films will depend on the how dense the film is at the top
surface because this would affect the diffusivity of the moisture in the film as well as the
solubility of moisture in the film. Moisture not only interacts at the surface but also
diffuses into the film and resides in the bulk of the film.
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4.3.2

Absorption/Desorption Study of Moisture
Absorption experiments on p-MSQ and BD IIx films (p-MSQ A, p-MSQ C, p-

MSQ F, BD IIx A, BD IIx B, BD IIx C) were carried out at different temperatures
ranging from 30 oC to 290 oC and for concentrations from 56 ppb to 200 ppb. Figure 3.8
shows typical experimental results for interaction of moisture with porous MSQ or pMSQ dielectric film (MSQ matrix and pores). The results give a temporal profile of the
reactor outlet concentration during the sorption/desorption cycle. The total amount of
moisture incorporated in the film was calculated using the area above the sorption curve.
Similarly, the area under desorption curve gives the amount of moisture desorbed during
the isothermal purge. The results show that extensive bake out is needed to remove most
of the moisture left in the film after an isothermal desorption process.

4.3.2.1

Effect of Temperature on Absorption and Desorption Dynamics
Figure 4.2a shows the normalized reactor outlet concentration when p-MSQ F

samples are exposed to 165 ppb moisture challenge concentration at three different
temperatures.

Slight variations in the mass spectrometer readouts are attributed to

sensitivity to variations in the gas flow rate and the ambient temperature. However, these
variations are secondary and transient effects and do not affect the overall profile,
average values over a long time, and trends. Figure 4.2a also indicates a delay in
response, which is significant at 30 °C but less pronounced at higher temperatures. This
delay is much greater than the residence time of the reactor and therefore is not a result of
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reactor breakthrough. The delay is caused by rapid and complete removal of moisture
from the challenge gas early in the process while the p-MSQ F surface is totally dry and
fast sorbing. At higher temperatures, desorption rate becomes more favorable; thus this
initial rapid sorption and therefore the related delay in response become less noticeable.
Another observation made is that, under the same exposure time and challenge
moisture concentration, the total amount of moisture absorbed is higher at lower
temperatures. At lower temperatures, the sorption rate is higher than the desorption rate;
this results in a more favorable equilibrium toward sorption and retention of moisture in
the film. The difference in the net sorption profiles at different temperatures, as depicted
in Figure 4.2a, can also be explained by the same effect. However, there is another way
that temperature affects the observed sorption and retention, based on the solubility of
moisture in the MSQ matrix. The solubility factor S is given as a ratio of equilibrium
matrix moisture concentration Cs0 and gas-phase moisture concentration Cgb0. Moisture
in the matrix is present in a wide variety of physical and chemical forms. As stated
earlier, the term “moisture” in MSQ refers to the moisture equivalent of all intermediate
compounds formed as a result of physical and chemical interactions with MSQ.
At equilibrium the solubility at a given temperature and concentration is
calculated using the following equation:

C film0 = Cgp0ε + Cs0 (1 − ε )

…4.1
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where, Cfilm0 is the loading in moisture molecules per unit volume of the film and Cgp0,
the moisture concentration in the pore, is equal to the challenge concentration Cgb0. Cs0 is
given by Cgb0 * S because the matrix moisture concentration is in equilibrium with the
gas-phase concentration, ε is the film porosity, and S is the solubility of moisture in the
film.
Capacity of the MSQ matrix for moisture retention decreases with temperature,
which, results in earlier breakthrough and steeper initial profiles as observed in Figure
4.2a. For example, results show that changing temperature from 150 to 250 °C only
slightly changes the sorption profile compared to the change observed by increasing from
30 to 150 °C. This is explained by the fact that dependency of solubility on temperature
decreases with increasing temperature. Figures 4.2b-f shows the effect of temperature on
sorption cycle for p-MSQ A, p-MSQ C, BD IIx A, BD IIx B, BD IIx C respectively.
Conditions for each plot are given in the figures. Similar plots were generated for other
concentrations.
The effect of temperature on desorption kinetics of moisture are shown in Figures
4.3a-f for the above low-k films (normalized outlet-gas moisture concentration is plotted
against time). Conditions for each plot are given in the figures. Similar plots were
generated for other concentrations.
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Figure 4.2a Temporal moisture profile during absorption for p-MSQ F film at 30, 150
and 250 oC (Challenge concentration 165 ppb)
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Figure 4.2b Temporal moisture profile during absorption for p-MSQ A film at 30 and
290 oC (Challenge concentration 56 ppb)
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Figure 4.2c Temporal moisture profile during absorption for p-MSQ C film at 30, 200
and 290 oC (Challenge concentration 193 ppb)
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Figure 4.2d Temporal moisture profile during absorption for BD IIx A film at 30 and
200 oC (Challenge concentration 181 ppb)
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Figure 4.2e Temporal moisture profile during absorption for BD IIx B film at 30, 200
and 290 oC (Challenge concentration 56 ppb)
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Figure 4.2f Temporal moisture profile during absorption for BD IIx C film at 30, 200
and 290 oC (Challenge concentration 181 ppb)
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Figure 4.3a Temporal moisture profile during desorption for p-MSQ F film at 30 and
250 oC (Challenge concentration 165 ppb)
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Figure 4.3b Temporal moisture profile during desorption for p-MSQ A film at 30 and
290 oC (Challenge concentration 56 ppb)
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Figure 4.3c Temporal moisture profile during desorption for p-MSQ C film at 30, 200
and 290 oC (Challenge concentration 193 ppb)
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Figure 4.3d Temporal moisture profile during desorption for BD IIx A film at 30 and
200 oC (Challenge concentration 181 ppb)
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Figure 4.3e Temporal moisture profile during desorption for BD IIx B film at 30, 200
and 290 oC (Challenge concentration 56 ppb)
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Figure 4.3f Temporal moisture profile during desorption for BD IIx C film at 30, 200
and 290 oC (Challenge concentration 181 ppb)
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4.3.2.2

Effect of Concentration on Absorption and Desorption Dynamics
The effect of moisture challenge concentration on the sorption dynamics at

constant temperature are shown in Figures 4.4a-f for p-MSQ A, p-MSQ C, p-MSQ F, BD
IIx A, BD IIx B and BD IIx C, respectively. Conditions for each plot are given in the
figures. As expected, the total amount of moisture absorbed (loading) increases as the
moisture challenge concentration increases.
Calculating the area above the absorption profile at different times, one can
estimate the total amount of moisture absorbed in the film at those particular times.
Thus, one can estimate the amount of moisture incorporated in the film for different
length of exposure. The total area estimated when the surface comes in equilibrium with
gas phase concentration gives the equilibrium loading.
Figures 4.5a-f gives the desorption dynamics for the above films. Calculating the
area below desorption profile gives the amount of moisture removed within a certain time
interval. Therefore, one can estimate the % of moisture removed after different clean up
times. Similar sorption/desorption profiles were generated for other temperatures.
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Figure 4.4a Temporal moisture profile during absorption for p-MSQ A film at 56 and
181 ppb (Temperature 30 oC)
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Figure 4.4b Temporal moisture profile during absorption for p-MSQ C film at 56 and
193 ppb (Temperature 30 oC)
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Figure 4.4c Temporal moisture profile during absorption for p-MSQ F film at 56, 111
and 193 ppb (Temperature 150 oC)
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Figure 4.4d Temporal moisture profile during absorption for BD IIx A film at 56 and
181 ppb (Temperature 30 oC)
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Figure 4.4e Temporal moisture profile during absorption for BD IIx B film at 56 and 181
ppb (Temperature 30 oC)
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Figure 4.4f Temporal moisture profile during absorption for BD IIx C film at 56 and 181
ppb (Temperature 30 oC)
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Figure 4.5a Temporal moisture profile during desorption for p-MSQ A film at 56 and
181 ppb (Temperature 30 oC)
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Figure 4.5b Temporal moisture profile during desorption for p-MSQ C film at 56 and
193 ppb (Temperature 30 oC)
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Figure 4.5c Temporal moisture profile during desorption for p-MSQ F film at 56, 111
and 165 ppb (Temperature 150 oC)
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Figure 4.5d Temporal moisture profile during desorption for BD IIx A film at 56 and
181 ppb (Temperature 30 oC)

184

Normalized Outlet-gas
Concentration

1.2
1.0
0.8
0.6
0.4

56 ppb
0.2

181 ppb
0.0
0

100

200

300

400

500

600

Time (min)
Figure 4.5e Temporal moisture profile during desorption for BD IIx B film at 56 and 181
ppb (Temperature 30 oC)
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Figure 4.5f Temporal moisture profile during desorption for BD IIx C film at 56 and 181
ppb (Temperature 30 oC)
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4.3.2.3

Comparison of Moisture Absorption Loading between p-MSQ Films
The extent of moisture retention not only depends on the material but also depend

on its processing conditions before moisture exposure. Equilibrium moisture sorption
loading for two p-MSQ films, one which has been partially etched and ashed in N2/H2
environment (p-MSQ A) and the other which has been partially etched and ashed in H2
environment (p-MSQ C) are compared. Equilibrium loading is calculated by the sorption
profile.

Equilibrium Moisture Loading
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4.0
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Figure 4.6a Comparison of equilibrium moisture absorption loading for 181 ppb
challenge for p-MSQ films
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Figures 4.6a and 4.6b compare the moisture loading between the two films for 181 and
56 ppb challenge concentration, respectively. It is observed from the figures that p-MSQ
film which has been ashed in N2/H2 environment has higher moisture loadings than the
one which has been ashed in H2 only environment; even though contact angle of film
exposed to N2/H2 environment is higher. It is also concluded that etching and ashing
chemistry affects moisture uptake.

Equilibrium Moisture Loading
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Figure 4.6b Comparison of equilibrium moisture absorption loading for 56 ppb challenge
for p-MSQ films
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4.3.2.4

Comparison of Moisture Absorption Loading between BD IIx Films
Similarly, equilibrium moisture sorption loading for three BD IIx films: k-2.3,

blanket film (BD IIx A), k-2.3 E-NH3PT (BD IIx B) and k-2.3 E-NH3HePT (BD IIx C)
are compared. Equilibrium loading was calculated by the sorption profile. Figures 4.7a
and Figure 4.7b compare the moisture loading between the two films for 56 and 181 ppb
challenge concentration, respectively. It is observed from the figures that film exposed to
NH3 and He environment has the highest moisture loading.

Equilibrium Moisture Loading
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Figure 4.7a Comparison of equilibrium moisture absorption loading for 56 ppb challenge
for BD IIx films
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Figure 4.7b Comparison of equilibrium moisture absorption loading for 181 ppb
challenge for BD IIx films

4.3.2.5

Comparison of Moisture Removal between p-MSQ Films
Processing conditions affects not only the moisture uptake as seen in previous

section but also affects moisture removal rate. Percentage of moisture removed is plotted
against time for p-MSQ A and p-MSQ C films as shown in Figure 4.8. It is observed
from the figure that even after 3 hrs of purging only around 40-50% of moisture is
removed. This suggests that moisture removal is a slow and activated process, which
could be a potential problem in integration of these films in IC Manufacturing. It is also
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observed that removal rate for film exposed to N2/H2 environment is slower than film
exposed to H2 only.

Moisture Removed (%)
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Figure 4.8 Comparison of dynamics of moisture removal for 56 ppb at 200 oC for
p-MSQ films

4.3.2.6

Comparison of Moisture Removal between BD IIx Films
Similarly, moisture removal rates for three BD IIx films (A, B and C) are

compared. Figure 4.9a and 4.9b shows percentage of moisture removed after different
purge times for film equilibrated with 56 and 181 ppb exposure, respectively. Like pMSQ, BD IIx also shows slower removal rate.
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Figure 4.9a Comparison of dynamics of moisture removal for 56 ppb at 30 oC for
BD IIx films
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Figure 4.9b Comparison of dynamics of moisture removal for 181 ppb at 30 oC for
BD IIx films
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4.3.2.7

Comparison of Moisture Adsorption Loading between SiO2 and Low-k Surfaces
SiO2 had been the material of choice for ILDs for several decades. Figure 4.10

compares the moisture loading on p-MSQ F film and BD IIx A film for 56 ppb moisture
challenge concentration at room temperature with that of silicon dioxide. Based on the
sorption profile, the film loading (total number of molecules per unit volume of the film)

Adsorption Loading
(x 1014 molecules/cm2 )

3.5
3.0
2.5
2.0
1.5
1.0
0.5
0.0

SiO2

p-MSQ

BD IIx

Figure 4.10 Comparison of equilibrium moisture adsorption loading for 56 ppb challenge

has been calculated. To compare the loadings, low-k films loading was converted to
molecules per unit area of the film. The results show that the amount of moisture sorbed
in low-k films is much greater than SiO2 surface, primarily because of high solubility of
moisture in these films. Higher sorption loading on low-k surfaces compared to SiO2
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surface suggests significant problem of integrating low-k films in semiconductor
processing.

4.3.2.8

Comparison of Moisture Retention between SiO2 and Low-k Surfaces after
Isothermal Purge
From the previous section it was observed that low-k films have much higher

uptake capacity as compared to SiO2. It is also important to know whether outgassing of
moisture is a fast process or not. To compare moisture removal between SiO2 surface
and p-MSQ and BD IIx films, the two surfaces where first exposed to 56 ppb moisture
challenge concentration and equilibrium was attained.

Moisture Removed (%)

50
40
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0

SiO2

p-MSQ

BD IIx

Figure 4.11 Comparison of % of moisture removed after 10 hours of purge
(surface was equilibrated with 56 ppb moisture)
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Following that the films were purged under UHP N2 till baseline was reached.
Figure 4.11 compares percentage of moisture removed after 10 hr of isothermal purge for
various temperatures. As observed from the figure, 45-50 % of adsorbed moisture is
removed from SiO2 surface whereas, only 25-35 % is removed from low-k films. These
results suggest that porous low-k films have much higher moisture retention capacity as
compared to oxide surface.

This could be a significant problem because gradual

outgassing of residual moisture in subsequent processes might cause reliability and
adhesion problems.

4.3.3

In-situ Characterization of Dielectric Films
Isopropanol (IPA) is widely used in the semiconductor industry for cleaning. In

this section of the research work, IPA is selected as a model contaminant.

The

interaction of IPA with porous spin-on (MSQ) and CVD (Chemical Vapor Deposition)
(BD IIx) deposited low-k dielectric films are studied using FTIR. FTIR spectroscopy is a
powerful technique because in this approach the film is probed directly and any changes
in the film can be related to changes in the absorbance spectra [3]. The wavelength of the
light absorbed is the characteristic of the chemical bond of species in the film and the
strength of the absorption is proportional to the concentration of the species present in the
film.
The sample to be studied was cut into 1 inch by 1 inch size coupons. The
coupons are dipped in liquid IPA for a long time so that the surface comes in equilibrium
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with IPA. The coupons and then placed in the sample cell where it is purged with UHP
N2. Scans are taken after every 2 min time interval in the beginning of the desorption
process and then every half hour towards the end of desorption process. Initially only
one coupon was used for the study. This did not give significant absorbance signal,
mainly because these films are around 100-200 nm thick. To enhance the signal to noise
ratio four coupons of the sample were placed parallely in the sample cell, so that the light
passes through more film thickness. To further enhance the signal to noise ratio, for each
data point 100 scans were taken. Empty cell with UHP N2 was taken as the background
for the sample scans. After each experiment coupons were cleaned externally in a
furnace at 250 oC to remove any residual impurities.
Figure 4.12 shows the transmission FTIR spectra of clean, IPA saturated (dipped
in liquid IPA for 12 hrs and purged UHP N2 for 27 hrs) BD IIx sample (k-2.6, ENH3HePT). The peaks of interest are as follows, broad hydrogen bonded region from
wave number 3150 – 3600 cm-1, and symmetric and asymmetric CH3 stretches at 2922
and 2977 cm-1 respectively [7]. As can be observed from the unexposed spectra that
there is no visible hydrogen bonded peak where as there are CH3 stretch peaks, this is
because the low-k film itself contains CH3 functional groups. After dipping the sample in
liquid IPA for 12 hrs, the exposed spectra shows an increased CH3 stretch peaks as well
as hydrogen bonded peaks. The exposed sample is then placed in the cell and purged
with UHP N2. The spectrum obtained after purging the sample for 27 hrs shows that both
hydrogen bonded peak and CH3 stretch peaks have decreased.
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Figure 4.12 Transmission spectra of clean, IPA saturated and purged samples of NH3/He
plasma treated BD IIx film (Surface was equilibrated with liquid IPA,
Signature peaks: 2950-3000 and 3150-3600 cm-1)

In order to study dynamics of IPA removal, scans of the sample are taken every 2
minutes in the beginning and then every half an hour towards the end of desorption
process. For each scan the baseline corrected area between wave numbers 2950-3000
cm-1 and 3150-3600 cm-1 are calculated. These areas correspond to the CH3 contribution
of IPA absorbed in the film and the CH3 from the film itself, and the hydrogen bonded
silanol peaks, respectively. Figures 4.13a and 4.13b show the temporal profile of the
peak area. The peak area becomes constant after 24 hrs purge; this peak area corresponds
to the CH3 groups present in the clean sample

196

1.2

Integrated Area (a.u.)

Peak Signature: 2950 – 3000 (cm-1)
1

0.8

0.6

0.4
0

500

1000

1500

2000

Time (min)
Figure 4.13a Temporal desorption profile for NH3/He plasma treated BD IIx film
(Surface was equilibrated with liquid IPA, followed by UHP N2 purge
Signature peaks: 2950-3000 cm-1)
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Figure 4.13b Temporal desorption profile for NH3/He plasma treated BD IIx film
(Surface was equilibrated with liquid IPA, followed by UHP N2 purge
Signature peaks: 3150-3600 cm-1)
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Figure 4.14 Temporal desorption profile for NH3/He plasma treated BD IIx film
(Surface was equilibrated with liquid IPA, followed by UHP N2 purge
Signature peaks: 2950-3000 cm-1)

It is important for any technique to be useful, that the experimental data is
repeatable.

The above experiment was repeated to test the repeatability of the

experiments. Figure 4.14 plots the desorption dynamics of IPA with CH3 as the peak of
interest. Like Figure 4.13a, Figure 4.14 shows similar desorption profile, however, the
starting peak area is slightly different. This could be because, the sample were exposed
to ambient when transferring the sample into the cells, which could change the initial
state of the film. Repeating the experiments in a closed sample cell might overcome this
issue.

However, the similarity of the desorption profile, does suggest that the

experiments could be repeatable, if there are tight controls on the sample ambient, even
though more experiments need to be performed to confirm this conclusion.
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Similar IPA interaction was studied with another BD IIx sample (k-2.6, E-HePT).
The sample was dipped in liquid IPA for long time to equilibrate the film with IPA.
Figure 4.15 shows transmission spectras for unexposed, exposed and cleaned sample. It
is observed from the figure that both CH3 stretches and hydrogen bonded stretch
increases with exposure to IPA and decreases after purging with UHP N2. Figures 4.16a
and 4.16b give the desorption profile for the respective peaks. The gap in data point in
the middle of the graph is because data was not taken during the night.
It is concluded from the desorption profiles for the two films studied that at room
temperature IPA removal is a very slow process. These desorption curve could be
converted to concentration against time curve to extract some of the fundamental
transport parameters.

Absorbance (a.u.)

0.66

0.62
Purge time ~ 36 hr

0.58
12 hr liquid IPA exposure

0.54
Unexposed sample

0.50
2500

3000

3500

4000

Wave number (cm-1)
Figure 4.15 Transmission spectra of clean, IPA saturated and purged samples of He
plasma treated BD IIx film (Surface was equilibrated with liquid IPA,
Signature peaks: 2950-3000 and 3150-3600 cm-1)
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Figure 4.16a Temporal desorption profile for He plasma treated BD IIx film
(Surface was equilibrated with liquid IPA, followed by UHP N2 purge
Signature peaks: 2950-3000 cm-1)
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Figure 4.16b Temporal desorption profile for He plasma treated BD IIx film
(Surface was equilibrated with liquid IPA, followed by UHP N2 purge
Signature peaks: 3150-3600 cm-1)
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Figure 4.17 Comparison of desorption profile between BD IIx films
(Surface was equilibrated with liquid IPA, followed by UHP N2 purge
Signature peaks: 2950-3000 cm-1)

Figure 4.17 compares the IPA removal of two BD IIx films: one of them has been
treated with Helium (He) plasma and the other one has been treated with NH3 and He
plasma with dielectric constant value of 2.6. Both samples were dipped in IPA for 12
hour and then purged with UHP N2. Scans were taken periodically during the desorption
process. Peak area for 2950-3000 cm-1 was calculated. As observed from the figure, the
films have different IPA removal rates. The sample treated with NH3 and He has a faster
removal rate as compared to the He treated sample. Meanwhile, it can also be concluded
that removal rate of IPA is a very slow process at room temperature. Thus, this novel
technique can differentiate between films processed under different conditions. This
again is a promising result.
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Further experiments need to be performed to test the above results to prove that
this novel technique can be used for in-situ dynamic study of molecular contaminants
with thin films. However, the initial tests seem promising.
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CHAPTER 5
MODELING OF IMPURITY ABSORPTION/DESORPTION IN
POROUS LOW-k FILMS

5.1 INTRODUCTION
As discussed in the previous section low-k dielectric films are highly susceptible
to atmospheric molecular contamination (AMC). AMCs not only degrade the quality of
low-k dielectric films but also increase its effective k value of the film. To design a
process that minimizes the impact of moisture and organic contamination, it is necessary
to have a fundamental understanding of the interactions between molecular contaminants
and the dielectric films. Absorption/desorption of contaminant is a complicated process
specific to the molecular contaminant itself.

However, modeling can facilitate in

comprehension and characterization of the kinetics and transport of absorption/desorption
process. Modeling is essential to examine the physical and chemical processes in order
to obtain information on reaction selectivity, rate coefficients and permeation rate.
Information obtained from modeling is vital to predict the time required to purge a tool
free of contaminants. These models can be directly incorporated into the reactor and
process design to improve process performance [112].
Modeling can also give vital information about the energetics of the
sorption/desorption processes. It can yield activation energies of sorption/ desorption.
Knowledge of the diffusivity and solubility of various impurities on different low-k
dielectric films can assist in discerning their vulnerability to surface contamination. It
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can also help in deciding their potential for successful integration in silicon CMOS
technology.
Having analyzed the experimental data and understanding that this porous low-k
film has much higher moisture uptake and very slow removal, a process model is
developed to simulate the moisture transport mechanisms occurring in these films.
Extensive literature is available on diffusion and permeation of gases in polymers and
porous media [119-121]. Several authors have also studied reaction and diffusion of
gases in silica [122-125].

However, the transport of moisture in porous dielectric

polymers, such as porous MSQ and Black Diamond II, has unique features not
represented by the available models. The proposed model represents the removal of
moisture from porous low-k films during the isothermal desorption process.
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5.2 MODELING OF TRANSPORT OF IMPURITY IN POROUS LOW-k FILMS
The low-k film consists of two parts, one is the solid matrix and the other is the
pores. These pores are dispersed in the matrix and could be open pores i.e. pores which
are near the surface and opened to the surrounding gas as well as closed pores inside the
film matrix.

The pores could be connected internally which allows a path for the

impurity molecules to diffuse through the pores. These pores have an average diameter
in the range of nanometer. Apart from these mesopores there are micropores, which are
the lattice cavities of the solid matrix. These arise from the structure of the matrix itself.

Gas flow

Desorption from
matrix

Transport
in pores
Permeation in matrix

Exchange between
matrix and pores

Porous low-k film
Substrate
Figure 5.1 Moisture transport pathways in porous low-k film

As shown in Figure 5.1, the process of transport in porous low-k film is assumed
to consist of the following simultaneous steps:
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(1) Local exchange of moisture between the gas phase (including the gas in the pores)
and the solid matrix across the gas–solid interphase.

This exchange in general

consists

chemisorption

of

both

physisorption

and

dissociative

(such

as

hydroxylation), leading to formation of what is called “sorbed” moisture; the reverse
process will be recombination and desorption back to the gas-phase moisture. The
rate process consists of two steps, transport of impurities to the pore surface and rate
of reaction of impurities at the surface. Locally these two rates are assumed to be
equal to each other.
(2) Transport of sorbed moisture in the solid matrix by activated diffusion.
(3) Transport of molecular moisture in micropores by diffusion.

5.2.1

Simplified Parallel Pore Model
To better understand the transport of impurity in porous film, first a simplified

parallel pore model is developed. Figures 5.2a and 5.2b shows the schematic of the top
view and the side view of the film. Following are the assumptions made to develop this
model:
a) Pores are cylindrical, periodic and parallel.
b) Transport of impurity occurs only in z-direction.
c) Diffusivity in pore and matrix are constant within the whole film.

As shown in the Figure 5.2a polymer matrix can be divided into unit cell “A”.
Since it is assumed that transport in x and y directions are negligible, the concentration
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Figure 5.2a Schematic of top view of porous low-k film
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Figure 5.2b Schematic of side view of porous low-k film
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Figure 5.2c Schematic of unit cell “A”

at a particular value of z is same in the film. Thus, the concentration profile in unit cell A
will represent the concentration profile in the whole matrix. Figure 5.2b shows the side
view of the porous low-k film. Figure 5.2c shows the magnified top view of unit cell A.

As shown in the Figure 5.2a, the diameter of pore is 2r1 and the distance between the two
pores is 2r2. Therefore, for the unit cell A:
Length,

X = 2(r1+r2)

…5.1

Width,

Y=X

…5.2

and,
Depth is equal to L which is the thickness of the low-k film.
Cross-sectional area of pore, Ap = pi ( )*r12

…5.3
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Cross-sectional area of solid matrix, As = X*Y – Ap = 4(r1+r2)2 - pi ( )*r12

…5.4

Volume of pore, Vp = Ap*L
= pi ( )*r12*L

…5.5

Volume of solid matrix, Vs = As*L
= (4(r1+r2)2- pi ( )*r12)*L

…5.6

Therefore porosity of the unit cell is given by:

ε=

5.2.1.1

Vp
Vs + V p

=

π * r12

…5.7

4 * (r1 + r2 ) 2

Mass Balance in Polymer Matrix

Writing conservation equation over the elemental element z for specie j in matrix:

As * N j |z −As * N j |z+∆z −2*π *r1 *∆z *km *(

Cs
∆C
− Cgp ) = As *∆z * s
S
∆t
…5.8

Dividing by z & As,

−

∂N j
∂z

−

2 * π * r1
Cs
∂Cs
*
k
*
(
−
C
)
=
m
gp
4(r1 + r2 ) 2 − π * r12
S
∂t
…5.9

N j = − Ds *

∂C s
∂z

…5.10
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∂ 2C s
2 * π * r1
Cs
∂Cs
Ds * 2 −
*
k
*
(
−
C
)
=
m
gp
∂z
4( r1 + r2 ) 2 − π * r12
S
∂t

…5.11

∂ 2C s
Cs
∂C s
2 *ε
Ds *
−
*
k
*
(
−
C
)
=
m
gp
∂z 2
r1 (1 − ε )
S
∂t
…5.12
Specific surface area is defined as the ratio of surface area of the pore to the volume of
the pore:

Sp =

2 * π * r1 * L 2
=
π * r12 * L
r1

…5.13

∂ 2C s
Cs
∂C s
Ds *
−
S
*
k
*
(
−
C
)
=
p
m
gp
∂z 2
S
∂t
…5.14
5.2.1.2

Mass Balance in Pore

Similarly, writing conservation equation over the elemental element z for specie j in
pore:
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Ap * N j |z −Ap * N j |z+∆z +2*π *r1 *∆z *km *(

∆Cgp
Cs
− Cgp ) = Ap *∆z *
S
∆t
…5.15

Dividing by z & Ap,

∂N j

∂C gp
2 * π * r1
Cs
−
−
* k m * ( − C gp ) =
∂z
π * r12
S
∂t
…5.16

N j = − Dg *

Dg *

Dg *

5.2.2

∂ 2C gp
∂z 2

∂ 2C gp
∂z 2

∂C gp
∂z

∂C gp
Cs
2
+ * k m * ( − C gp ) =
r1
S
∂t

∂C gp
Cs
+ S p * k m * ( − C gp ) =
S
∂t

…5.17

…5.18

…5.19

Process Model for Low-k Film
The above simplified model is used to derive the equations for transport of

impurities in low-k film. Low-k films are typically blanket film or etched and ashed film.
As seen in chapter 3 etched and ashed film results in a damaged layer and a non damaged
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layer. Thus, etching and ashing changes the physical properties of the film, therefore,
diffusivity and solubility of impurities vary along the thickness of the film. For blanket
film these properties are constant in the whole film. Figure 5.3 shows the schematic of
moisture transport in porous low-k film.

Following transport equations are written for

uniform blanket film, for non-uniform etched and ashed film, porosity, diffusivity and
solubility are written as function of independent variable ‘z’.

The governing equation for transport of moisture in the matrix is given by:

S pε
∂ 2C s
 Cs
 ∂C s
Ds
−
k
−
C

=
m
gp
2
(1 − ε )  S
∂z
∂t

…5.20

Where, the first term is the diffusion through the film matrix, the second term is the
exchange term and the last term is the transient term.

The initial and boundary conditions for Eq. 5.20 are as follows:
Initial Condition
Cs = Cgb0 S,

at t = 0

…5.20a

at z = 0

…5.20b

Boundary Condition 1

∂C s
= 0,
∂z
Boundary Condition 2
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− Ds

∂Cs
C

= k ms  s − C gb 
∂z
 S


H2O (Cg)
Moisture in gas
phase

at z = L

…5.20c

H2O (Cs )
Moisture reacted or
sorbed in the solid phase

kmgCgb kms
km
Cgp

km
Cgp

Cs
Cs
Gas

Silicon Nitride

p-MSQ Film

Figure 5.3 Schematic of moisture transport in porous low-k film
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where, Cs is the aggregate concentration (moisture equivalent) of all intermediate species
formed from reaction and incorporation of moisture with the low-k matrix; Ds is the
effective diffusivity of moisture in the matrix and is defined and calculated based on flux
of the overall moisture equivalent of these intermediate species; Cgb is concentration of
moisture in the gas phase; km is interphase transfer coefficient between the matrix and
voids; kms is interface transfer coefficient between the matrix and the gas phase in the
surrounding medium (bulk gas); Sp is the specific surface area of the porous film; and L
is thickness of the film. It is assumed that at equilibrium the concentration of moisture in
the matrix is proportional to the moisture concentration in the gas phase (Henry’s law
equivalent).

The governing equation for the transport of moisture in pores is given by:

Dg

∂ 2 C gp
∂z 2

 Cs
 ∂ C gp
+ S pkm 
− C gp  =
S
∂t



…5.21

Where, the first term is the diffusion through the film matrix, the second term is the
exchange term and the last term is the transient term.

The initial and boundary conditions for Eq 5.21 are as follows:
Initial Condition
Cgp = Cgb0,

at t = 0

…5.21a
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Boundary Condition 1

∂ C gp
∂z

=0

,

at z = 0

…5.21b

at z = L

…5.21c

Boundary Condition 2

− Dg

∂Cgp
∂z

= kmg(Cgp −Cgb )

where, Cgp is the concentration of moisture in the pores, Dg is gas phase diffusivity of
moisture in pores, kmg is the interphase transfer coefficient between pores and gas phase
in the surrounding medium.
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5.3 COUPLING GAS PHASE AND SURFACE CONSERVATION EQUATIONS
In the present study, the sorption and desorption of moisture with wafers took
place in a packed-bed of wafer modules arranged and oriented randomly. This reactor
was assumed to behave as a differential reactor. This achieved a high degree of mixing,
justifying a well-mixed reactor model and the following overall mass balance equation:

Vr

C

= Q(Cgb,in − Cgb ) + (1− ε )Atotkms  s − Cgb 
dt
S


+ εAtotkmg (Cgp − Cgb )

dCgb

z=l

z=l

…5.22
Initial Condition
Cgb = Cgb0,

at t = 0

…5.22a

where, the first term represents change in the moisture concentration with time, the
second term is the change in concentration of moisture due to incoming and outgoing gas
flow, third term accounts for the moisture desorbed from matrix to gas phase at boundary
z = L, and the fourth term represents the moisture desorbed from pore to gas phase at z =
L. Q is the volumetric flow rate, V is volume of reactor, Cgb,in is concentration of
moisture in inlet purge gas stream that is less than 1 ppb during isothermal desorption
process, and Atot is total exposed surface area available for moisture sorption.
Differential equations 5.20-5.22 were solved numerically using finite element
method. The model parameters Ds, Dg, km, kms, kmg, and S were determined by fitting the
model to the experimental data. In addition to describing the process qualitatively and
providing a tool for extracting the fundamental parameters from the experimental data,
the model can be used to predict the amount of moisture retained in such thin films when
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exposed to moisture in various environments. In practice, it is important to remove
contaminants, including moisture, from these films, the model can also be used in these
cases to design an optimum cleaning process either by isothermal or by temperature
programmed desorption, outgassing and drying.
The above model was developed for particular reactor geometry and it allows for
estimation of the impurity concentration profile within the film, the outgassing rate from
the film as well as change in uptake of the film with time. However, for different reactor
types and geometries, only the governing overall mass balance needs to be changed. The
equations for transport of impurities in the matrix and pore are same for all reactor types.
The next section describes modeling results and predicts data for which
experiments were not performed.
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5.4 MODEL VALIDATION
Application of the proposed model indicates that outgassing of moisture from
porous MSQ film follows three distinct pathways:
1. Exchange of moisture molecules between MSQ matrix and the pores
2. Desorption of moisture from MSQ matrix to the bulk gas
3. Diffusion of moisture out of the pores

Table 5.1 Parameters estimated by fitting model to experimental desorption data for 56
ppb moisture challenge for p-MSQ F (JSR LKD 5109)
Temperature, oC
Parameters
30

150

250

Ds, cm2/s

1.4e-15

1.7e-15

3.5e-15

Dg, cm2/s

8.5e-10

1.0e-9

3.0e-9

km, cm/s

5.0e-13

5.0e-13

5.0e-13

kms, cm/s

1.0e-8

1.0e-8

1.0e-8

kmg, cm/s

1.0e-7

1.0e-7

1.0e-7

S

3.65e7

1.9e7

1.0e7

The model described in the previous section was used to analyze the raw data and
extract the fundamental process parameters. Figure 5.4 shows the model fit to data for
porous MSQ (LKD 5109) for only one set of conditions 56 ppb at two temperatures, 30
o

C and 150 oC. The agreement between the model and the experimental data is good.
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Figures 5.5a-c shows model fit to experimental data for p-MSQ C (partial etch, H2 ash
only) for 193 ppb moisture challenge concentration at 30, 200 and 290 oC. Similar
results were obtained for other temperatures and challenge concentrations. Model fits
fairly well to the experimental data. The results of analysis and parameter estimation are
summarized in Tables 5.1 and 5.2

Table 5.2 Parameters estimated by fitting model to experimental desorption data for 193
ppb moisture challenge for p-MSQ C (partial etch, H2 ash only)
Temperature, oC
Parametersa

a

30

200

290

Ds1, cm2/s

3e-16

1.2e-15

2e-15

Ds2, cm2/s

5e-16

7e-16

1e-15

Dg, cm2/s

3e-10

3e-9

5e-9

ε1

0.3

0.3

0.3

ε1

0.4

0.4

0.4

S1

1.e7

7.5e6

6e6

S2

1.2e7

7e6

6.5e6

km, cm/s

2.5e-6

2.5e-6

2.5e-6

kms, cm/s

6e-1

6e-1

6e-1

kmg, cm/s

6e-1

6e-1

6e-1

1-top layer; 2-bottom layer
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Figure 5.4 Comparison of model to experimental desorption profile of p-MSQ F film at
30 oC and 150 oC for 56 ppb moisture challenge
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Figure 5.5a Comparison of model to experimental desorption profile of p-MSQ C film at
30 oC for 193 ppb moisture challenge
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Figure 5.5b Comparison of model to experimental desorption profile of p-MSQ C film at
200 oC for 193 ppb moisture challenge
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Figure 5.5c Comparison of model to experimental desorption profile of p-MSQ C film at
290 oC for 193 ppb moisture challenge
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CHAPTER 6
MODELING RESULTS AND DISCUSSIONS

6.1 INTRODUCTION
The process model developed in the previous section is a powerful tool for
predicting moisture distribution in the film under conditions in which experiments are not
feasible. It is also a useful tool for studying the effect of different process parameters on
moisture uptake and removal. In this section, a developed model will be used to study
the interaction of moisture with porous low-k films. The effect of different process and
geometric parameters, namely, surface temperature, purge flow rate, purge gas purity,
porosity and film thickness on moisture removal rate are investigated. Throughput and
thermal budget are important considerations for high volume manufacturing. The model
is also used to optimize different process parameters to minimize chemical and energy
usage. This will help in reducing both time and cost for cleaning low-k films.
Knowing where the moisture resides in the film is important, because it addresses
issues of adhesion and reliability. Moisture close to the surface causes adhesion problem
and deep inside causes reliability concerns. The model would be used to predict the
moisture distribution profile within the film at different purge times.
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6.2 MOISTURE ABSOPRTION LOADING
The total amount of moisture absorbed or incorporated and desorbed or removed
during the isothermal absorption/desorption steps were calculated from the respective
curves. Figure 6.1 gives the moisture content (loading) as a function of temperature for
the dielectric surface film (p-MSQ F) at different exposure or challenge concentrations.
The surface was exposed from 56 ppb to 165 ppb moisture challenge concentration and
temperature was varied from room temperature to 250 oC. Similar figures were produced
for other films. The model results were in good agreement with the experimental data.
The results show that at a constant temperature the total moisture loading increases with
increase in the challenge concentration.

In addition, the total amount of moisture

absorbed in the film for a particular concentration decreases with increasing temperature.
This is because of the decrease in the solubility of moisture in the dielectric film with
increase in temperature.

It is also observed that the amount of absorbed moisture

increased significantly as moisture challenge concentration increases at a constant
temperature. Based on equation 4.1 relative loading was calculated in the pore and in the
matrix from the experimental data. It is observed that majority of moisture resides in the
lattice cavities of the low-k films. This is because of high solubility of moisture in these
films.
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Figure 6.1 Comparison of model prediction and experimental data on moisture uptake of
p-MSQ F film after exposure to various challenge levels
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6.3 MODEL ESTIMATION OF MOISTURE DIFFUSIVITIES IN PORE AND
MATRIX
In chapter 5 the model was used to predict process parameters for blanket, etched
and ashed porous MSQ and BDIIx films. The value of moisture diffusivity in the pore
and matrix of low-k films are estimated.

It is observed from the results that the

diffusivity value of moisture in the pores is in the range of 1e-9 cm2/s. This could be
explained because the transport through pores is not purely Knudsen diffusion, rather it is
micro pore diffusion. This is because the diffusion process is combined with mass
transfer and exchange between gas (pore void) and MSQ matrix (pore wall).

The

moisture molecules not only collide with the pore walls but also adsorb, desorb, and
permeate into matrix simultaneously. The average pore size in the film is typically less
than 30 angstroms; this further explains the small values of diffusivity in the range of 1e9 cm2/s, which is much smaller than typical Knudsen diffusivity coefficients. The results
also show that the diffusivity coefficient for moisture in low-k matrix both in the top and
bottom layer is in the range of 1e-15 cm2/s. These low diffusivity values confirm that
diffusion of moisture through the matrix is primarily through molecular or intra-lattice
cavities and is therefore a slow process. This is a significant problem in successfully
integrating these films in integrated circuit manufacturing. Therefore, understanding the
effect of different process parameters on moisture removal rate becomes important.
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6.4 MODEL ESTIMATION OF MOISTURE SOLUBILITIES
Solubility is defined as the ratio of equilibrium matrix moisture concentration and
gas phase moisture concentration. The solubility of moisture in low-k matrix, S, was
calculated for each temperature using the sorption loading data. Figure 6.2 show that
these S values are in good agreement with the values of S determined by fitting the model
to desorption data for p-MSQ F film. Similar plots were generated for other low-k films
studied. The result shows a slight dependence of S on moisture concentration. This
could be due to slight deviation from Henry’s law equivalent. The interphase transfer
coefficients km, kms and kmg are weak functions of temperature and are constant for all
cases.
Table 6.1 Solubility values

p-MSQ F
o

p-MSQ C (partial etch, H2 only ash)

Temperature, C
(LKD 5109)

Matrix Top Layer

Matrix Bottom Layer

30

2.75e7

1.2e7

1e7

150

9.66e6

-

-

200

-

7.5e6

7e6

250

6.99e6

-

-

290

-

6.5e6

6e6

Table 6.1 gives the solubility value of moisture for different porous films. For etched and
ashed films there are two solubility values, one for the top layer and the other for bottom
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layers. As seen in Table 6.1, the solubility value for the top layer is slightly more than
the bottom layer. This could be because the etching and ashing process changes the
properties of the top part of the film either by expanding the lattice cavities or by
passivating the dangling bonds. This in turn affects the interaction of moisture through
these films and thus the difference in value of the solubility between the top and the
bottom layer.

Exp, 56 ppb
Exp, 111ppb
Exp, 165 ppb

Pred, 56 ppb
Pred, 111 ppb
Pred, 165ppb

Solubility (x 107)

4
3
2
1
0
0

100

200

300

Temp (oC)
Figure 6.2 Solubility of moisture in p-MSQ F film (LKD 5109)
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6.5 ACTIVATION ENERGIES OF DIFFUSION OF MOISTURE IN THE MATRIX
It is assumed that the effect of temperature on the diffusivity value of moisture
through the matrix and the pore has Arrhenius dependence. It is defined by the following
equation:

D = Do exp (-Ed/RT)

...6.1

Natural log of diffusivity for both the top and bottom layers were plotted against the
reciprocal of the temperature as shown in Figure 6.3 for p-MSQ C sample. Similar plots
were generated for other low-k films studied. Activation energies for diffusivity were
estimated by calculating the slope of the plot, while the pre-exponential factors were
determined by the intercept of the plot. Table 6.2 gives the activation energies for pMSQ C film. The activation energies estimated are in the range of 5-10 kJ/mol (or 0.050.1 eV) for the film. Such low activation energy suggests that the removal of moisture is
transport limited. Therefore, it is concluded that diffusion of moisture through the film is
a very slow process. Thus, it is difficult to clean the film once moisture in incorporated
into the film.

All efforts should be done not to expose these films to molecular

contaminants, especially moisture, because moisture has a detrimental effect on these
films as discussed in chapter 4.
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Table 6.2 Activation energies of diffusion

p-MSQ C (partial etch,
H2 only ash)
Ed, kJ/mol (Matrix Top Layer)

7.19 (0.074 eV)

Do, cm2/s

8.44E-19

Ed, kJ/mol (Matrix Bottom Layer)

6.4 (0.066 eV)

Do, cm2/s

3.77E-19

-42.5

Ln (Ds)

-43.0

Top layer

-43.5
-44.0
-44.5

Bottom Layer

-45.0
-45.5
1.0

1.5

2.0

2.5

3.0

3.5

1000/T (K-1)
Figure 6.3 Temperature dependence of moisture diffusivity in p-MSQ C film
(partial etch and H2 ash only)

4.0
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6.6 ACTIVATION ENERGIES OF PERMEATION OF MOISTURE IN THE MATRIX
Permeation is an important parameter which determines the removal of moisture
from these films. Permeation of an impurity through low-k films is normally given as the
product of solubility and diffusivity of the impurity in the film. The combined effect of
diffusivity and solubility is incorporated in the permeability value, thus this gives overall
transport of impurities in the film, which is not adequately understood by studying the
effect of solubility and diffusivity values alone. Permeability is typically defined as the
volumetric flow rate of gas at steady-state, under standard temperature and pressure
(STP) conditions through a unit surface area of the unit thickness of a sample at the unit
pressure difference. Like the diffusivity value, it was also assumed that the permeability
has Arrhenius dependence for temperature. It is given by the following equation:

Ps = Po exp (-Ep/RT)

...6.2

Natural log of permeability for both the top and bottom layers are plotted against the
reciprocal temperature as shown in Figure 6.4 for p-MSQ C. The slope of the plots gives
the activation energies of permeation through the film. Similar plots were generated for
other porous films. Table 6.3 lists the activation energies of permeation for the p-MSQ C
film. The activation energies are estimated to be in the range of 5 kJ/mol (0.05 eV).
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Table 6.3 Activation energies of permeability

p-MSQ C (partial etch,
H2 only ash)
Ep, kJ/mol (Matrix Top Layer)

5.73 (0.059 eV)

po, cm2/s x cm3 (gas)/cm3 (solid)

4.77E-12

Ep, kJ/mol (Matrix Bottom Layer)

4.56 (0.04 eV)

po, cm2/s x cm3 (gas)/cm3 (solid)

1.82E-12

-26.8

Ln (Ps)

-27.2

Top layer

-27.6
-28.0

Bottom Layer

-28.4
-28.8
1.0

1.5

2.0

2.5

3.0

3.5

1000/T (K-1)
Figure 6.4 Temperature dependence of moisture permeability in p-MSQ C film
(partial etch and H2 ash only)

4.0
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6.7 DYNAMICS OF MOISTURE REMOVAL
In order to understand the dynamics of moisture removal, the percentage of
moisture retained was plotted against time for a particular concentration and temperature.
Figure 6.5 compares the percentage of moisture left in the film that has been exposed to a
challenge moisture concentration of 56 ppb moisture at 150 oC; the temporal profile
shows the dynamics of the clean up and desorption as predicted by the model and as
measured directly for p-MSQ F film. After one hour of desorption, only around 5 % of
the total moisture was removed. Even after 20 hours, 75 % of total moisture remained in
the dielectric film. This very slow and highly activated overall removal of moisture
could be a significant problem in the integration of such porous dielectric films in
semiconductor processing where it is important to have adequate contamination control
while maintaining high throughput.

Left in the Film

Percentage of Moisture

105
95
Experimental

85

Model

75
65
0

5

10

15

20

T im e ( h )
Figure 6.5 Dependence of moisture residue on purge time (p-MSQ F film exposed to and
equilibrated to 56 ppb at 150 oC before purging)
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6.8 EFFECT OF DIFFERENT GEOMETRIC PARAMETERS ON MOISTURE
REMOVAL RATE
6.8.1

Effect of Porosity
An important geometric parameter which affects moisture uptake and removal is

total porosity of the film. It was discussed in chapter 4 that the etching and ashing
process results in increasing the porosity of the top layer as compared to the bottom layer,
which is typically denser and less porous. The model is used to study the effect of
porosity on the outgassing rate of moisture from the p-MSQ F film. To better understand
the effect of porosity, the film is considered as a uniform film with constant geometric
parameters throughout the film. Figure 6.6 illustrates the outgassing rate for 56 ppb
moisture challenge concentration at 30 oC over a range of porosity from 20% to 60%.
Outgassing rate is a function of concentration of moisture in the film and mass transfer
coefficient.
The figure shows that the outgassing rate decreases with increasing porosity. This
is because the total amount of moisture absorbed in the film decreases with increase in
porosity. It has been shown in chapter 4 that the greatest amount of moisture is trapped
in the bulk matrix part of the film instead of the pores. Therefore, the equilibrium
loading of moisture in the film decreases with increase in porosity; thus the outgassing
rate decreases. However, the decrease in the outgassing rate is not proportional to the
increase of porosity. This is because of various other factors that are also affected by the
change in porosity.
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Figure 6.6 Change in the outgassing rate during moisture desorption (p-MSQ F film
exposed to and equilibrated with 56 ppb moisture before desorption)

The overall mass transfer between the film and bulk gas depends on the mass
transfer between the pore and bulk gas; porosity increase leads to an increase in the mass
transport by pores; thus an increase in outgassing flux. In fact, two competing factors
determine the outgassing rate: film loading and mass transport rate. Figure 6.6 shows
that under conditions used in this study the film loading factor dominate the overall
effect.

6.8.2

Effect of Film Thickness
Another parameter which affects moisture outgassing rate is the film thickness.

Figure 6.7 shows the effect of film thickness on the outgassing dynamics for p-MSQ F
film. The thickness affects both the film mass and the overall diffusional resistance.
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Diffusional resistance is defined as the total path length for the moisture molecules to
diffuse in the film.

Decreasing thickness decreases path length and thus decreases

diffusional resistance. Therefore, decrease in diffusional resistance results in increase in
the outgassing rate. Another aspect which changes with changing thickness is the total
film mass. Therefore decrease in film thickness decreases the total amount of moisture
absorbed in the film which in turn decreases the outgassing rate.
Results show that for very thin films (less than 0.2 micron in thickness) the effect
related to the total amount of moisture is dominant. For films larger than 0.2 micron the
effect of thickness is negligible because most of the early desorption is from a thin top
section of the film; only at the late stages of desorption the effect of film thickness
becomes noticeable.

Outgassing Rate
(molecules/s/cm2x 10-10)

1 .0

0.05 µ m

0.6 µ m

0.02 µ m
0.2 µ m
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Tim e (h)
Figure 6.7 Effect of film thickness on outgassing rate (p-MSQ F film exposed to and
equilibrated with 56 ppb moisture before desorption)
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6.9

EFFECT OF DIFFERENT PROCESS PARAMETERS ON
MOISTURE REMOVAL RATE

In order to minimize the chemical and energy usage (for ESH gain and cost
reduction), as well as to decrease the effective k-value (for performance gain), it is
important to know the effect of different process flow parameters. There are primarily
three parameters which have significant effect on moisture removal rate, namely, purge
temperature, purge gas flow rate and purge gas purity. In the following sections, the
effect of different parameters on outgassing rate has been studied and the results are
applied to design an optimum purge process. The results are discussed for one such
porous low-k film: p-MSQ F, but the effect of process parameters on moisture removal
rate for all the other porous films follows the similar trend.

6.9.1

Effect of Temperature
Minimizing energy and the constraint of having purge processes to stay within the

thermal budget is an important aspect in effective cleaning of the films. Therefore, it is
important to have a fundamental understanding of the effect of temperature on moisture
removal rate. This will help in minimizing energy usage for the optimal process. The
surface was first exposed to 56 ppb moisture concentration at 30 °C and equilibrium was
attained; this was followed by purge with nitrogen with moisture concentration less than
1 ppb at three different temperatures: 30, 150 and 250 °C. Percentage removed is plotted
against time. Figure 6.8 shows the effect of temperature on the removal of moisture at
various temperatures ranging from 30 to 250 °C. It is observed from the figure that

236

increasing the temperature enhances the moisture removal rate. This is primarily due to
the dominant increase in the desorption rate as compared to sorption rate. However, the
advantages of increasing the moisture removal rate may be offset by the increase in the
energy consumption or by exceeding the thermal budget.

The thermal budget is a

measure of integrated heat treatment of the sample over the entire process time and
should be minimized.
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Figure 6.8 Effect of purge temperature on % moisture removed (p-MSQ F film was
equilibrated with 56 ppb moisture challenge at 30 oC)

It is also observed from the graph that increasing the temperature from 30 to 150
°C there is not a significant reduction in time for achieving the same percentage clean up
(for example 20 % shown as dotted line in the figure) whereas increasing temperature
from 150 to 250 °C the reduction is significant. These results suggests that there is an
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optimum extent of heating for enhancing the desorption process. However, it should be
noted that during very late stages of clean up, the primary way to enhance the removal
rate is by increasing the temperature since the concentration in the film is very small.
Also, mainly chemisorbed species are left in the film, which are much more activated.
Increasing temperature enhances the desorption rate constant which facilitates in the
removal of moisture from the film. Therefore, optimizing the temperature for minimizing
energy usage and staying within the thermal budget becomes an important aspect of
effective purge process.

6.9.2

Effect of Purge Gas Flow Rate
Another important factor which affects moisture removal rate is purge gas flow

rate. In order to increase throughput, it is important to optimize the purge flow rate and
purge time. This not only helps in increasing the throughput but also reduces the purge
gas consumption. Figure 6.9 shows the effect of purge gas flow rate on the percentage of
moisture retained for ppb level exposure. The p-MSQ film was first equilibrated with
500 ppb moisture concentration at 250 °C. The surface was then cleaned with purge gas
at three different flow rates of 300, 600 and 1000 sccm. It can be seen from the graph
that increasing flow rate enhances moisture removal from the film. For example to
achieve 75 % retention as shown in the figure, it took around 9 hrs at 300 sccm of purge
flow rate, whereas it only around 7 hr at 1000 sccm purge flow rate. This suggests that
flow rate has a significant effect on moisture removal during initial stages of the purging
process. Though increasing flow rate does help in reducing time to achieve the same
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level of clean up, on the other hand it increases the amount of purge gas consumption
which is normally ultra high purity nitrogen or argon gas. This increase in quantity
would affect the cost of drying the film. Therefore, there is need for optimizing the purge
gas flow rate.
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Figure 6.9 Dependency of moisture residue on purge flow rate (p-MSQ F film was
equilibrated with 500 ppb moisture challenge at 250 oC)

It is also observed from the gas that doubling the flow rate from 300 sccm to 600
sccm there is significant reduction in time for clean up, which for this gas is one and half
hour, whereas increasing the flow rate slightly from 600 sccm to 1000 sccm the reduction
in time is only half hour. These results also suggest that there is an optimum extent for
increasing the flow rate. After a certain level, further increase in purge flow rate does not
help in reducing time. This is an important conclusion because if one is not aware of
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what level of flow rate is required for achieving a certain percentage of clean up for
certain exposure conditions, then one might be drying the film with a much higher flow
rate than required and in turn would just be wasting gas, which would have a
considerable effect on the cost of clean up.

Moisture Removed (%)

50

1000 sccm
40

100 sccm

30

Purge Flow Rate
20
10
0
0

5

10

15

20

25

30

Time (h)
Figure 6.10 Dependency of moisture residue on purge flow rate (p-MSQ F film was
equilibrated with 1500 ppm moisture challenge at 250 oC)

The results discussed so far have been for low level of exposure; the effect of
flow rate for high level of exposure is similar but more pronounced during the initial
purge process. Figure 6.10 shows the effect of purge gas flow rate on the percentage of
moisture removed for a high level of exposure. The film was equilibrated with 1500 ppm
of moisture concentration at 250 °C, followed by isothermal purge process at two
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different flow rates, 100 and 1000 sccm. It is observed from the figure that increasing the
flow rate has a visible effect at the purge process. This corresponds to primarily the
removal of higher layer physisorbed molecules or weakly bonded molecules from the pMSQ film. Increasing flow rate also enhances the interphase transfer coefficient between
the film matrix surface and gas phase as well as interphase transfer coefficient between
pores at the surface and gas phase in the surrounding medium. During the initial purge
process most of the weakly bonded molecules are removed, however, during late stages
the effect of the flow rate becomes less important. This is because during the end process
only the chemisorbed species are left and removal of these forms of species does not
depend on purge flow rate. Thus the above results conclude that purge flow rate is an
important process parameter in the removal of moisture from the film. Its effects vary
during the purge process, and optimizing it would help in reducing both purge gas
consumption as well as time for drying.

6.9.3

Effect of Purge Gas Purity
Purge gas purity plays an important role in the removal rate of moisture. To lower

cost and reduce chemical usage, it is important to know what level of purge gas purity is
required to achieve certain level of clean up. Figure 6.11 shows the effect of purge gas
moisture concentration on the moisture retained. For these results, the p-MSQ F film
surface was equilibrated with 150 ppm moisture concentration at 250 °C. Sorption cycle
was followed by isothermal desorption process using purge gases with different moisture
concentrations of 1, 100, and 1000 ppb. The figure shows that during most of the purge
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process, purge gas purity does not play any role on moisture removal rate. Purge gas
purity plays a significant role only towards the end of the purge process. This is because
during the initial process of desorption, mainly weakly bonded molecules leave the film
and this dominates the process. The surface concentration is much higher than the
equilibrium surface concentration with bulk gas, which is to say that the purge gas is
much cleaner than the surface.

Therefore, re-adsorption of moisture molecules is

relatively small as compared to the moisture leaving from the film. Thus, the purge gas
purity does not play a key role in moisture removal rate.
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Figure 6.11 Dependency of moisture residue on purge concentration (p-MSQ F film was
equilibrated with 150 ppm moisture challenge at 250 oC)
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However, during later stages, the surface concentration decreases or it becomes
cleaner as compared to the purge gas; thus desorption rate decreases and re-adsorption of
moisture molecules to the surface becomes significant.
Figure 6.12 shows the effect of purge gas purity on moisture retained for low
level of exposure. These results were generated for p-MSQ F surface exposed to 500 ppb
moisture concentration at 250 oC until the equilibrium was reached. The surface was
then purged and cleaned with UHP nitrogen with purge gas purity level of 1, 10 and 100
ppb.
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Figure 6.12 Dependency of moisture residue on purge concentration (p-MSQ F film was
equilibrated with 500 ppb moisture challenge at 250 oC)

As observed from the figure, in order to achieve the same percentage of clean up,
increasing the purge gas purity from 100 ppb to 10 ppb significantly reduces the time,
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whereas there was not much gain in increasing the purity further. For example, for 80 %
retention, shown as a dashed line in the figure, increasing purge gas purity from 100 to 10
ppb, the time for clean up is decreased by 2 1/2 hrs whereas the reduction in time from 10
to 1 ppb is not much. Furthermore, as the time for clean up increases the difference
between the 100 ppb curve and the other curves keep increasing. This suggests that
purge purity enhances drying primarily at the late stages of the desorption process. Thus,
it is concluded from the above two figures that using UHP gas for cleaning films which
have been exposed to high level of moisture is not required, so the surface could be
cleaned with relatively impure gas during the initial part of the cleaning process and only
towards the end very pure purge gas is used. This is an important conclusion because this
optimization will help in reducing the cost of drying the film, which is an important
factor in high volume manufacturing.
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6.10

PRACTICAL APPLICATIONS OF THE MODEL

The model developed has so far been used to do parametric studies and to
understand the effect of process and geometric parameters on moisture removal rate.
Now, some practical applications of the model will be discussed. Two examples are
discussed in this section. First, an application of the model will be shown to predict the
distribution of moisture in the porous film. This will help to understand where in the film
low-k material is residing, because moisture close to the film will cause adhesion issues
while moisture deep in the film can result in reliability issues. Secondly, the model will
be used to optimize the process parameters and develop a purge recipe which will
minimize chemical and energy usage, two important aspects which drive the cost of
cleaning.

6.10.1 Model Application to Predict Distribution of Moisture in Etched and Ashed
Porous Low-k Film
Knowing where the moisture is residing within the low-k film is important and
critical. Not knowing only the percentage of moisture that has been removed after
cleaning, but also its distribution in the film is important.

This is mainly because

moisture close to the top part of the film can cause adhesion issues with other materials
deposited on top of it, whereas, moisture deep inside the film can gradually outgas during
the subsequent processes causing reliability concerns. The effect of moisture deep inside
the film may not be prominent initially, but these moisture molecules can slowly diffuse
through the film and cause problems later in the manufacturing process, resulting in
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damaged wafers and thus increase in cost of manufacturing. Therefore, knowing the
distribution within the film becomes critical. Since it is practically difficult to measure
the distribution profile of moisture within the film during the transient state, this is when
the power of model comes into play.

The model is used to predict the moisture

distribution profile for one such case. A porous etched and ashed film (p-MSQ C) was
exposed to 100 ppm of moisture concentration for 15 minutes. The film was then purged

Moisture Concentration (mol/m3)

with UHP N2 to remove the moisture incorporated in the film.
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Figure 6.13 Moisture distribution profile within p-MSQ C film (partial etch, H2 ash only)
during a purge process. (Surface was exposed to moisture challenge concentration of 100
ppm for 15 min at 200 °C; purge gas purity = 1 ppb)

246

Figure 6.13 shows the distribution of moisture within the film at different purge times.
The curve a is the distribution profile before the start of purge process i.e. after 15 min of
exposure to 1500 ppm of moisture. Curves b to g gives the distribution profile after 5,
20, 60, 120, 180 and 3600 minutes of purging. It is observed from curves b to g, that the
concentration deep inside the film has increased as compared to the initial concentration
whereas, concentration close to the surface has decreased. This is because when the
surface is exposed to purge environment, there are two driving forces which the moisture
in the film experiences.

One, between the film and the purge gas, because purge

concentration is 1 ppb, much less than the concentration in the top part of the film. The
other is between the middle and the bottom part of the film. Since, the concentration
deep inside the film is less than the middle part of the film, the moisture molecules are
attracted towards the bottom layer of the film.

These two opposing driving forces

determine the concentration profile within the film. It is observed that concentration deep
inside the film has increased and even after 10 hr of purge the concentration is higher
than the initial concentration.

This is an interesting result, because the moisture

molecules deep inside the film are more difficult to remove and would gradually outgas
causing reliability issues. Thus, the power of the model is shown in the above example,
which would not have been possible to determine experimentally.

6.10.2 Optimization of Process Parameters for Effective Cleaning
The purge process modeling would be helpful in optimizing the purge recipes
depending on the final purity requirements. This would not only help in lowering gas and
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energy consumption but also reducing the purge times. The drying of porous low-k films
during the desorption process depends on various factors: temperature, flow rate, and the
purity of the purge gas are among the most important and controllable parameters.
Figure 6.14 illustrates the model application for optimizing the purge process for ESH
gain. The p-MSQ film was exposed to 500 ppb moisture concentration at 30 oC for an
hour. Challenge flow rate was 350 sccm. Four different purge processes were used to
achieve the same percentage clean up which in this case is 80 %. 80% clean up means
that 80% of the total molecules absorbed in the film during challenge leave the film. The
time and cost for clean up is compared. In the first process the purge temperature was
instantly ramped to 350 oC from 30 oC, purge flow rate was increased almost 3 times and
purge purity was kept at 20 ppb. It is observed from the figure that under these purge
conditions it took around 3.5 hrs and slightly more than $6/wafer to achieve 80 % clean
up. The goal of the optimized purge process is to move along the arrow as shown in the
figure which reduces both cost and time of clean up
First the effect of purge purity on clean up time and cost was studied. In process
2 temperature and purge flow rate were kept the same as process 1, but purge purity was
increased to 1 ppb. Under these conditions both time and cost of clean-up was reduced;
however, the reduction in cost was not a lot as compared to reduction in time. In process
3 the purge flow rate was kept at 350 sccm, same as the challenge flow rate, purge purity
was kept at 1 ppb and desorption temperature was 350 oC. With this purge process the
cost was reduced significantly, however the time for clean up also increased. Process 4
was one such example of optimizing the various process parameters. The temperature
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was ramped from 150 oC to 350 oC and then kept constant, and flow rate was highest in
the beginning at 1500 sccm and was slowly reduced to 350 sccm. Purge purity was kept
at 1 ppb. Under these purge conditions, both the time and cost was reduced as compared
to process 1.
However, it should be noted that this is not the best optimized process; optimizing
the parameters further can help move the point further towards the arrow. Therefore,
there is a tradeoff between saving time (increasing the throughput) and lowering the
operation cost. Most conventional processes are not developed based on the above
considerations. Therefore, there is room for major improvement and cost saving using
the process model as a guiding tool and it is a powerful device for minimizing the energy
and chemical usage.
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Figure 6.14 Model application for optimizing the purge process
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6.11

CONCLUSION

Absorption, desorption, and transport characteristics of atmospheric gaseous
contaminants in general, and moisture in particular, was investigated in porous polymeric
and dielectric thin films. The moisture interactions with p-MSQ and BDIIx samples were
used as model compounds in this study. Moisture incorporation in low-k matrix involves
both hydroxylation reaction and formation of a number of intermediate compounds
depending on the exact chemistry of the dielectric matrix. However, for process analysis
and engineering applications, the aggregate concentration of intermediates can be
represented by an equivalent moisture concentration in the matrix. Moisture sorption and
desorption rates in low-k films are sensitive to temperature, moisture concentration, film
thickness, moisture solubility, and the fundamental properties of moisture transport in the
dielectric materials, in the pores and across the solid – gas interphase. The solubility of
moisture in low-k films decreases with temperature. The rate of moisture sorption is
significantly faster than the rate of moisture desorption under typical processing
condition, suggesting a significant potential problem in the removal of moisture and the
integration of such low-k dielectric materials in semiconductor processing.
A process model was developed to elucidate the interactions of moisture with
porous films. The model was used to analyze the experimental data, determine the
fundamental process parameters, and extend the direct measurements to determine the
effect of various parameters and process conditions on the moisture removal dynamics.
The results show that interphase transport and the pore diffusion coefficients are much
smaller than those predicted by bulk or Knudsen diffusion mechanism, thus indicating
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that the diffusion process is highly activated. The low outgassing rates also indicate that
porous films such as p-MSQ or BD IIx are highly susceptible to moisture contamination.
The model was used to study the effect of film porosity and film thickness on
moisture removal rate. There are two competing factors which affects moisture removal
rate when changing porosity. These are film mass and mass transport through the pores.
Depending on how long the films are exposed to a moisture environment determines
which factor has greater effect on moisture uptake and removal.

Similarly, two

competing factors determine moisture outgassing rate when changing film thickness.
These are the film mass and diffusional resistance. Depending on the condition, any of
these factors plays a role in moisture removal.
The parametric study showed the effect of different process parameters, namely
temperature, purge gas flow rate, and purge gas purity, on the removal of moisture from
the MSQ film. Increasing the purge gas flow rate primarily affects the early stages of the
purge, while increasing the gas purity helps in the final stages of outgassing. Increasing
the temperature increases the outgassing rate.
The results also illustrate the application of the model to predict residual impurity
contamination and optimize process conditions for efficient clean up of these dielectric
films during semiconductor processing. A case study was done to show the usefulness of
the model to develop an optimum purge/drying recipe. This would help in minimizing
gas and energy consumption and the required purge time, thereby saving on operation
cost.
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The model was also applied to predict distribution of moisture within the film.
During purge process, moisture molecules experience two competing driving forces: one
between the moisture in the middle of the film and ambient and the other between the
moisture in the middle of the film and the bottom of the film. During the initial part of
the purging process the concentration of moisture deep inside the film increases. These
moisture molecules are difficult to remove and will cause reliability problems during later
stages of the manufacturing process.
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CHAPTER 7
INTERACTION OF MOLECULAR CONTAMINANTS WITH ELECTROPOLISHED
STAINLESS STEEL SURFACES USED IN ULTRA HIGH PURE GAS
DISTRIBUTION SYSTEM

7.1 INTRODUCTION
As device dimensions shrink with each generation of semiconductor
manufacturing the requirements for gas purity is also becoming stringent. The level of
cleanliness required for fabrication processes is becoming more demanding and
challenging. Impurity levels in all the process gas used in wafer manufacturing have to
be within sub parts per billion range. With such strict consideration in impurity levels, it
is becoming challenging to transfer the process gas from the point of generation to the
point of use. Contamination control is becoming all the more important and integral part
of semiconductor manufacturing, with its importance increasing with each new
technology. With several semiconductor companies following “copy exactly” policy for
all its fabs, has added extra complexity in maintaining purity level in bulk and reactive
gases; mainly because the weather pattern, height from sea level is different for different
cities which affects kinetics and transport properties.
With such strict requirement for gas purity has driven the cost of construction of
ultra high pure gas delivery system. With construction cost of fabs into several billions
of dollars, it is becoming critical to design processes to lower the usage of ultra pure gas
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in purging and dry down of gas delivery system. Selection of construction materials to
reduce particulates formation and molecular contamination has gained interest in last
several years. In order to reduce construction cost and meet the required specification, it
is important to have fundamental understanding of impurity interactions with gas delivery
lines. It is important to study the impurity adsorption and desorption characteristics or in
other word impurity outgassing dynamics. One such material which is extensively used
in constructing gas delivery lines is electropolished 316L stainless steel (EPSS 316L)
tubing.

This chapter presents the study of impurity adsorption and desorption

characteristic with EPSS 316L.
Impurity adsorption and desorption causes several problems in metrology, data
interpretation, process and system design. Impurities adsorbed on a newly installed gas
delivery lines or tubing may take several days of purging to remove all the impurities and
to achieve the desired impurity level. This would require lots of gas usage and during
this process the lines would be contaminating the process gas. Omni et al. have shown
that process gases are contaminated by constant outgassing of desorbed impurities from
tubing and piping [126]. The gas when finally reaches the point of use from the source
point gets contaminated and its impurity levels rises above than what is the desired level.
Thus, the effort of manufacturing ultra high pure gas is lost [127]. Outgassing at ppb
levels is very difficult and takes very long time to clean, and often, this affects the
response time of several measuring tools due to such low level of impurity adsorption and
desorption behavior.
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The impurity which has gained the most interest is moisture. This is because
moisture is a ubiquitous impurity. It is the most difficult impurity to remove from the gas
distribution system because of its adsorption and desorption behavior. With requirements
of moisture level in most of the bulk and reactive gases being in ppb range, it has become
important to study moisture interaction with tubing and piping. Some of the issues that
affect moisture dry down are pressure fluctuations, dead spaces, perturbation, back
diffusion.

Therefore, designing gas distribution system with such consideration is

necessary to reduce cost and chemical usage. Another potential problem is the presence
of moisture in reactive and specialty gases. For example moisture present in HCl gas
delivery lines, can result in corrosion of gas lines and components if certain level of
moisture concentration is not maintained. Therefore with all these potential problems
with moisture in gas delivery lines, it is important to have a comprehensive understanding
of behavior of moisture. Moisture generally adsorbs on the surface as a chemisorbed or a
physisorbed species.
The research objectives of this study are focused on developing fundamental
understanding of the interaction of molecular contamination with electropolished 316L
stainless steel (EPSS) surface. The goals of this study are:
•

Determine the fundamentals of moisture interactions with EPSS: Loading, outgassing
dynamics, transport, and removal of moisture.

•

Develop a kinetic expression for transient adsorption/desorption process.

•

Study the effect of temperature, purge gas flow rate and purge gas purity on system
clean up.
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•

Develop a comprehensive process model that would simulate gas distribution system
and predict its response to upsets in factors like impurity levels, purge flow rates,
temperature changes, and pressure fluctuations. It could also be used to design a more
efficient and effective system dry down process.

•

Investigate the impact of piping dead-legs on moisture adsorption and desorption as a
result of system pressure changes.

•

Compare cycle purging with continuous purging for large system dry down.
In this study a methodology has been developed to characterize the physical and

chemical interactions of moisture with electropolished stainless steel (EPSS) used in Intel
manufacturing fabs.

These mechanisms of interactions are investigated using

temperature and concentration programmed exposure and purge sequence together with
trace moisture analysis, using atmospheric pressure ionization mass spectrometry
(APIMS). A process model is developed that provides information on the mechanism
and kinetics of moisture uptake and release from EPSS. The model developed would be
a valuable tool for designing an optimum process for contamination control and to predict
the moisture dry down performance of large-scale, systems. Also the effect of different
process parameters in reducing the time for dry down has also been studied.
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7.2 LITERATURE SURVEY
Several factors need to be considered when constructing an ultra high pure gas
distribution system. These are mainly the design, choice of components and surface
finishes, and manufacturing environment. It is important because these factors ensure
freedom from particulates formation, external leaks, dead zones and outgassing [128].
Sugiyama et al. suggested the use of electropolished 316L stainless steel tubing with
surface roughness of less than 10µinches to minimize particle formation and impurity
outgassing [129]. However, with requirements becoming more stringent, some authors
suggests of using EPSS with surface roughness of around 2-3µinches. Stretar discusses
methods of producing very high quality stainless steel using different surface treatment
processes [130]. Several authors have also suggested special welding techniques to
minimize cracks formation and particle generation during welding process for such high
purity applications [131, 132]. The material and the condition of interior surfaces of each
component used in gas delivery system are important for minimizing outgassing. The
Table 7.1 above gives the criteria for designing ultra clean gas delivery system.
Different components used in gas delivery system such as mass flow controller,
valves, purifiers, gas regulators, etc. are being made of all-metal electropolished and ultra
smooth surfaces [133, 134]. Double vacuum melt stainless steel and dry gas passivated
surfaces are the primary materials of choice [128].
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Table 7.1 Comparison between conventional and ultra clean technology [128]
Convention

Ultra clean

Goal

Result
Technology

Technology
Higher yields

Reduced

100-1000

Zero particles

Particles

@>0.11 µm

@>0.11 µm

Higher gas purity
Increased reliability
Longer system uptime

5 x 10-10

Reduced Leak

Higher gas purity

-7

1 x 10 atm.cc/sec
Rate

atm.cc/sec

Better system integrity
Faster gas displacement

Less Dead

Minimized by
Not addressed

Space

Higher throughput
integration
Fewer welded points
Higher gas quality

Minimized

H2O:

Outgassing

100-500 ppb

H2O: < 1 ppb

Higher gas concentration
Longer component life

Reduced
Surface

Minimized purge time
Typical Ra:

Typical Ra:

15 µinches

2-3 µinches

Roughness

Higher gas quality
Longer system life

Components not

All metal bakeable

bakeable

to 200 oC

Minimized contamination

Bakeability
Minimized outgassing
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Traditionally impurity outgassing studies were limited to filament metals under
vacuum conditions [135-143].

However, outgassing dynamics under vacuum

environment and flow conditions are very different.

Under vacuum situations,

convection, dispersion, and to certain extent impurity adsorption and desorption are not
included. While, under flow conditions, these factors plays a critical role in impurity
removal rate thus making the problem more intensive and complicated. Though several
authors have looked at the equilibrium interaction between gas and metal surface [144147], but understanding of the dynamics of the process is important because often times,
the conditions in actual environment are transient.

So with demand on level of

cleanliness increasing, several researchers have been interested in impurity adsorption
and desorption study [148, 149]. One such impurity which has got significant attention is
moisture, mainly because it is a very difficult impurity to remove.
In the last decade, several authors have developed experimental methodology to
study impurity adsorption and desorption characteristics in ultra high purity gas flow
systems [150-153]. They have presented dry down curves as a function of time for
different impurities from various stainless steel surfaces. Some other researchers have
looked at the effect of particle generation and impurity outgassing due to surface
roughness and finish, surface passivation techniques, different surface cleaning
techniques, as well as welding versus twisting or bending stainless steel tubing [150-156].
Though these studies are very useful and help in having a qualitative understanding of the
specific system studied, it lacks fundamental kinetics information. This is critical for
designing purge processes for minimizing chemical and energy usage.
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In recent years several authors have realized this problem and have studied
impurity outgassing under transient conditions.

They have designed and developed

theoretical models for extracting fundamental kinetics and transport parameters; which
will be helpful in predicting impurity dry down time. However, these models do not
address all the issues and make assumptions which do not represent the system fairly
well. Seksan et al. have modeled this system as a series of well mixed tanks, though it is
a reasonable assumption but it does not accurately represent the gas flowing system.
Their model neglects the effect of dispersion, which is important to consider because
often, different diameters of tubing are used in designing a gas delivery system [157].
Haider et al. did consider the effect of dispersion in their model and also incorporated the
effect of multilayer adsorption and desorption process; however, they used empirical
equation to represent the net rate of desorption for 1st layer and higher layers [127, 158].
Seifering et al. considers both the radial and axial dispersion of impurity in their transport
model. The moisture molecule dissociatively reacts with the surface and also considers
the variability of the surface energetic from site-to-site [159, 160].
The model developed in this research incorporates the dispersion, convection and
reaction effect. Fundamental kinetic reactions are written and no empirical formulation
has been considered. In subsequent sections the model is explained in detailed.
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7.3 EXPERIMENTAL DESIGN
To determine fundamental physical and geometrical parameters, it is important to
perform a detailed and systematic study. For this study experimental methodology was
developed for determining the fundamentals of moisture interactions and outgassing in
electropolished stainless steel surfaces.

7.3.1

Experimental Setup
The experimental setup for characterization of electropolished stainless steel

tubing is designed. Several designed factors have been considered to minimize dead
spaces and effect due to downstream tubing. The schematic of experimental setup is
shown in Figure 7.1. It consists of three parts: the gas injection system, the reactor, and
the analyzer. Figures 7.2a and b shows actual gas mixing system and the reactor used for
this study. In the gas mixing system known and controlled concentration of moisture is
generated which are delivered to the reactor. Moisture is the adsorbate in these
experiments, and ultrahigh purity (UHP) nitrogen is a carrier and diluent. Dead volumes
are minimized by continuously maintaining gas flow through the entire system. All
transport lines are kept heated to minimize moisture retention and memory effect. The
differential reactor was kept at a controlled temperature using a programmable furnace.
The analytical tool used to monitor moisture concentration is Atmospheric Pressure
Ionization Mass Spectrometer system that can detect impurities down to parts per trillion
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level.

Kintek permeation device is used to generate a known and controlled

concentration of moisture with UHP N2 as the gas carrier.

Gas Purifiers
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Gas Purifiers

Figure 7.1 Schematic of experimental setup
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Figure 7.2a Gas mixing system

Figure 7.2b Tubing in high temperature furnace
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7.3.2

Experimental Procedure
Before starting an experiment, the EPSS tubing was baked and purged with UHP

nitrogen at high temperatures. This was done to remove any residual moisture that might
have adsorbed on the surface. The tubing was first brought to the temperature at which
experiment have to be done. Isothermal adsorption and desorption study was performed.
In the adsorption cycle, the substrate was exposed to a challenge gas (nitrogen with
predetermined levels of moisture) at controlled flow rates. Once the surface comes in
equilibrium with the challenge gas i.e. the moisture concentration in the reactor outlet gas
reaches the incoming challenge level, the adsorption phase is completed and the reactor is
switched to purge (desorption). However, after an isothermal desorption, the temperature
was ramped up at steps of 50 °C up to 200 °C to desorb any residual moisture.
Experiments were carried out at different temperatures from 30 to 200 °C and for
moisture concentrations ranging from 56 ppb to 180 ppb.

7.3.3

Test Sample
The test sample used for this study was electropolished stainless steel tubing. The

tubing was 14 inches in length and 1.5 inches in diameter. The sample was provided by
Intel Corporation, Ocotillo campus, Chandler, Arizona. These tubing are typically used
in construction of the fab.
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7.4 EXPERIMENTAL RESULTS
Figure 7.3 compares the adsorption profiles at 181 ppb of moisture challenge
concentration for four different temperatures. Figure 7.3 indicates a delay in response,
o

which is significant at 30 C and decreases with increase in temperatures. The delay as
observed from the Figure is much greater than the residence time of the reactor and
therefore not due to reactor break through. This delay is due to the fact that in the
beginning of the process the EPSS surface is totally dry and clean, thus most of the
moisture entering the tubing is adsorbed on the surface.

Moisture molecules

dissociatively adsorb on the surface as a chemisorbed species.
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100 C
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Time (min)
Figure 7.3 Adsorption comparisons for 181 ppb of moisture challenge for four different
temperatures
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Physisorbed moisture molecules sit on top of the first layer because of hydrogen bonding.
Figure 7.3 shows that equilibrium is reached more rapidly as temperature is increased.
This is because an increase in temperature increases both the adsorption and desorption
rates and enhances the approach of the net process to its equilibrium state.
70
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Figure 7.4 Adsorption comparisons for 56 ppb of moisture challenge for three different
temperatures

Another observation made is that, under the same exposure time and moisture
concentration, the total amount of moisture adsorbed or loading is higher at lower
temperatures. Loading from the experimental data is calculated by integrating the total
area between the adsorption profile and the challenge level line. At lower temperatures
adsorption rate is higher than the desorption rate; this results in a more favorable
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equilibrium towards adsorption and retention of moisture on the surface. The difference
in the net adsorption profiles at different temperatures, as depicted in Figure 7.3, can also
be explained by the same effect. Similar temporal adsorption profiles were generated at
56 ppb moisture challenge concentration as shown in Figure 7.4
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Figure 7.5 Desorption comparisons for 181 ppb of moisture challenge for four different
temperatures

The effect of temperature on moisture desorption at 181 ppb of moisture
challenge conditions are shown in Figure 7.5. There are two phenomena which occurs on
increasing temperature one, that both rate of adsorption and desorption rate constant
increases (with increase in desorption being more), secondly equilibrium loading
decreases as explained above. During purging, flux or the amount of moisture per unit
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area per time desorbing from the surface would increase because of increase in
desorption rate constant, whereas the flux would decrease because the total amount of
moisture adsorbed in less. From Figure 7.5 it is observed that desorption profile at 200
and 100 oC is below than 30 oC. Thus, under the conditions studied, the amount on the
surface determines the desorption flux.

Similar temporal desorption profile was

generated at 56 ppb moisture challenge concentration as shown in Figure 7.6.
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Figure 7.6 Desorption comparisons for 56 ppb of moisture challenge for three different
temperatures

Figure 7.7 compares the outgassing flux at 100

o

C for two different

concentrations: 181 and 56 ppb. The surface was first equilibrated with the challenge
concentration at 100 oC, followed by isothermal purge process. It is observed from the
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Figure that the outgassing flux is highest at the beginning of the purge process for both
concentrations, and it decreases with time. This is because in the beginning of the
desorption process concentration of moisture on the surface of stainless steel is highest.
Also, outgassing flux is higher for 181 ppb than 56 ppb, because higher the concentration
more will be the moisture on the surface.
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Figure 7.7 Outgassing flux for 56 and 181 ppb of moisture challenge at 100 oC

Table 7.2 lists moisture equilibrium loading, and amount retained after 10 hrs of
isothermal purge for various concentration and temperatures. It is observed from the
table as the temperature increases for one particular concentration (181 ppb), total
amount of moisture adsorbed on the surface decreases at equilibrium. Comparing the %
of moisture removed, at different temperatures, it is observed that less than fifty percent
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of moisture is removed for temperatures less than 100 oC. This suggests that removal is a
slow process, especially at lower temperatures.

Table 7.2 Moisture uptake and retention in EPSS
Concentration,
ppb
Temperature, oC

56
30

181

100

200

30

50

100

200

2.04

1.01

1.09

0.07

Moisture Uptake
Loading, (molecules/cm2) * 1E14
Equilibrium

2.90

1.49

0.79

3.18

2.62

Moisture Retained, (molecules/cm2) * 1E14
After 10 hrs
cleaning

0.89

0.96

0.16

1.9

1.38

% of Moisture removed,
(Moisture removed/Equilibrium Loading × 100)
27.83

35.86

53.42

40.32

47.22

46.44

93.34
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7.5 PROCESS MODEL
To design a process that minimizes the impact of moisture contamination, it is
necessary to have a fundamental understanding of the interactions between molecular
contaminants and the EPSS surface. Adsorption/desorption of contaminant is an intricate
process specific to the molecular contaminant itself. However, modeling can facilitate in
comprehension and characterization of the kinetics of adsorption/desorption process.
Modeling is essential to examine the physical and chemical surface processes in order to
obtain information on reaction selectivity and rate coefficients. Information obtained
from modeling is vital to predict the time required to purge a tool free of contaminants.
Modeling

can

also

give

vital

information
It

can

about

the

energetics

yield

activation

of

the

energies

of

adsorption/desorption

processes.

adsorption/desorption.

Knowledge of the rate constants of adsorption/desorption of

various impurities on EPSS surfaces can assist in discerning their vulnerability to surface
contamination [115].
In this section, a process model is developed for impurity transport through
straight EPSS tubing. The proposed model uses a dispersion model along with surface
reaction. The model incorporates all aspects of transport and kinetics namely impurity
transport due to convection, dispersion and multilayer adsorption-desorption process.

7.5.1

Mechanism of Moisture Interaction with EPSS Surface
Figures 7.8 show a schematic of moisture transport and reaction occurring in

tubing. It consists of following steps:

271

1) Transport of moisture through the tubing by convection and dispersion.
2) Local exchange of moisture between the gas phase and EPSS surface across the
gas-solid interface.
Ultra high pure nitrogen as a carrier gas laden with moisture impurity flows through the
tubing at a volumetric flow rate of Q.

Impurity concentration is assumed to be

independent of radial direction and concentration at any point along the tubing is defined
as Cg. Surface reaction is couple with gas phase transport of moisture molecules. It is
assumed that both chemisorbed and physisorbed species are formed on the surface.
However, in this model all forms of moisture are combined together and represented as
Cs. Proposed reaction in this model is assumed to be reversible. No lateral interactions
between adsorbed species occur and all surface sites are assumed to be identical. Results
are averaged over surface homogeneities (roughness and defects).

ads

Uo
des

Cgo
z

Cs

Cg

z + dz

z=0

z=L

Figure 7.8 Schematic of test section
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7.5.2

Mass Balance for Surface Species
The adsorption of moisture molecule on the surface depends on the gas phase

moisture concentration and the number of vacant sites available. Reaction sites depend
on the surface roughness. Whereas, the desorption of moisture molecules depends on the
surface concentration of moisture.

∂Cs
= kads *Cg * (So − Cs ) − kdes *Cs
∂t

…7.1

Initial Condition:
Cs = Cs0

…7.1a

Where, kads is the adsorption rate constant, kdes is the desorption rate constant and So is
the total number of surface sites. The left hand side term is the change in surface
concentration of moisture with time. The first term on right hand side of the equation is
the rate of adsorption of moisture on the surface, where as the last term represents rate of
desorption of moisture from the surface.

7.5.3

Coupling Kinetics and Flow Dynamics
To solve the complete model, and estimate the kinetics parameter surface

impurity concentration has to be coupled with gas phase moisture concentration. The
stainless steel tube is modeled as a dispersion reactor. Writing the impurity conservation
equation over a control volume, gives the overall mass balance equation for gas phase
impurity concentration as given by the following equation.
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∂Cg
∂t

= Dz *

∂2Cg
∂z2

−u*

∂Cg

−

∂z

[

A
kads *Cg *(So − Cs ) − kdes *Cs
Vt

]
…7.2

Initial Condition:
Cg = Cg0

…7.2a

Boundary Condition 1:

u0 * C gin = − Dz *

∂C g
∂z

+ u * Cg
…7.2b

Boundary Condition 2:

∂C g
∂z

=0
…7.2c

The above equation incorporates the effects of dispersion, convection and reaction. It is
further assumed that impurity dispersion coefficient Dz is constant in the bulk gas and it
given

by

the

following

correlation

[161],

applicable

for

1<Re<2000

and

0.24<=Sc<=1000.

D z = D mol

( ud ) 2
+
192 D mol

…7.3

Where, Dmol is the molecular diffusion coefficient of the impurity in the bulk gas, and u is
the mean gas velocity through the tube.
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7.6 RESULTS AND DISCUSSIONS
7.6.1

Model Validation
The above developed model was fitted to the experimental data and fundamental

kinetic and transport parameters were determined. Figure 7.9 show model fit to moisture
desorption data for three different moisture challenge concentration namely 56, 111, 181
ppb. From all these curves it is observed that model fit fairly well to the experimental
data. It is also noted from the figure that during initial part of desorption process, the
model does not fit fairly well. This could be because of multilayer effect of impurities, as
well as change of mechanism during initial and latter part of desorption process. During
initial part mainly physisorbed molecules leave the surface, while during the latter part
desorption of chemisorbed takes place. A multilayer model could solve this problem.
Table 7.3 gives the process parameters estimated from the model for moisture
adsorption and desorption on electropolished 316L stainless steel surface. The model
was also used to estimate the surface site density which was found to be 6.29E13 sites per
cm2. Thus with the knowledge of all the fundamental kinetic and transport parameters,
one can fully characterize moisture interaction with electropolished 316L stainless steel
surface. With the help of the above model along with all the parameters, one can now do
parametric study to see what physical parameters affect the removal rate and are the most
critical for faster dry down time in gas distribution system. It can also predict moisture
concentration all along the tubing where it is difficult to measure the concentration. In
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the following sections, model applications and different purge schedule scenarios will be
discussed.

Smooth curves are model prediction
0.8
Concentration

Normalized Outlet-gas

1.0

0.6

56 ppb

0.4

111 ppb

0.2
181 ppb

0
0

50

100
Time (min)

150

200

Figure 7.9 Model fit to experimental data for 56, 111 and 181 ppb moisture
concentration at 25 oC

Table 7.3 Process parameters of moisture adsorption/desorption on EPSS 316L surface
kads (cm3/mol/s)

3.359 x 109

kdes (1/s)

4 x 10-4

So (# of sites /cm2)

6.29 x 1013

Dz (cm2/s)

1.82
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7.6.2

Effect of Purge Flow Rate on Moisture Removal Rate
During the construction of gas distribution system, tubings are exposed to ambient

conditions. Therefore, it is critical to know what levels of flow rate is required to clean
the pipes to low levels of moisture concentration in the shortest possible time and the
most economical way.

Therefore, understanding the effect of purge flow rate on

moisture removal rate is incumbent to reduce cost. Optimizing the purge flow rate and
purge time is important in reducing the purge gas consumption. Figure 7.10 shows the
effect of purge flow rate on moisture removed. The electropolished 316L stainless steel
surface is equilibrated with 181 moisture concentration at 25 °C. The surface is then
cleaned with purge gas at three different flow rates of 350, 700 and 1000 sccm.

Moisture Removed (%)

80
350 sccm

70

700 sccm

1000 sccm

60
50
40
30
20
10
0
0

20

40

60

80

100

120

140

160

Time (min)
Figure 7.10 Effect of purge flow rate on moisture removal rate

180

200
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It is observed from the figure that increasing the flow rate increases the moisture
removal rate; however the increase in removal rate is not linear with flow rate. For
example after 3 hr of purge, 49 % of moisture was removed with 350 sccm of purge flow
rate, where as 64 % was removed with 700 sccm and 72 % was removed with 1000 sccm
of purge flow rate. This suggests that there is an optimum extent of increasing the flow
rate, beyond which the gain in removal rate is not significant. Knowing the optimum
purge flow rate to achieve certain clean up is important because that helps in reducing gas
consumption which in turn will reduce cost.

7.6.3

Effect of Purge Gas Purity on Moisture Removal Rate
Apart from flow rate, another process parameter which affect removal rate is

purge gas purity.

The cost of generating ultra high pure purge gas is increasing.

Therefore, it is important to know what level of purge gas purity is required for effective
cleaning of the tubing. Figure 7.11 shows the effect of purge gas purity for low level of
exposure. The tubing was first equilibrated with 181 ppb of moisture concentration at 25
o

C. Purge gas with three different level of purity namely 1, 5 and 10 ppb was used to

clean the tubing. It is observed from the graph that during the first 40 minutes of the
purge process, there is not a significant effect of purge purity on moisture removal;
however, after purge purity becomes an important factor in clean up. For example after 6
hr or 180 minutes of purging, with 1 ppb of purge gas around 60% of moisture was
removed, whereas for 10 ppb only around 30% was removed. Thus, towards the later
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stage of desorption process purge purity becomes critical. The results show that the
effect of purge gas moisture concentration is only significant toward the end of the purge
process. This is because initially desorption of the physisorbed molecules dominates the
process. The purge gas is much cleaner than the surface; therefore, re-adsorption is
relatively small, and the purge gas purity does not play a key role. At later stages,
desorption rate decreases and re-adsorption of gas to the surface becomes significant.
Therefore, the purge gas purity becomes a significant factor. Thus, knowing what level
of purge gas purity is required is important because that helps in lowering the cost.

Moisture Removed (%)

70
1 ppb

60

5 ppb

10 ppb
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0
0
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Time (min)
Figure 7.11 Effect of purge gas purity on moisture removal rate
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7.6.4

Dependence of Tube length on Moisture Removal Rate
It is important to know how long a given tube length should be purged so that its

concentration falls within the acceptable limit. The issue of cleaning or purging the
tubing becomes more challenging when the tube length increases. With the increase in
tube length time required to purge and clean the tubing also increases. In order to better
understand the effect of tube length on moisture removal rate, tubing of three different
lengths: 0.9 m, 9 m and 90 m are saturated with 181 ppb of moisture concentration. The
contaminated lines are then cleaned with UHP N2 (less than 1 ppb moisture) at the flow
rate of 350 sccm. Figure 12a plots the percentage of moisture removed against time for
the three tubings. It is observed from the Figure that increasing the tube length not only
increases the time for purging but also the increase in time is not linear with tube length.
It took 10 hrs to completely clean the tube of 0.9 m length, while during the same time
only 10 % of moisture is removed from a 90 m long tube.
Another application of model is prediction of moisture concentration along the
tube length at different purge times. It is important to know the distribution of moisture
over the length of the tube because it helps in understanding how the cleaning process
works. This is an important application of the model because this information cannot be
determined experimentally. Figure 12b shows the moisture distribution profile along the
length of the tube at different purge times. It is observed from the Figure that even after
3 hr of purge though the initial part of the tube has been cleaned but the later part still has
high concentration of moisture.

Moisture Removed (%)
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Figure 7.12a Effect of tubing length on moisture removal rate
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Figure 7.12b Moisture distribution along the length of the tubing at different purge times
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This is because as the UHP gas enters the contaminated tube, the outgassing flux
is highest because surface is much more contaminated as compared to gas phase. As the
gas moves along the tube length moisture concentration increases and towards the end of
the tube the gas phase concentration becomes comparable with the surface concentration.
Thus the flux decreases along the length of the tube. Therefore, even after long time of
purge initial part of the tube gets cleaned but the later part is still unclean. Thus the
model helps in determining how long the tube should be purged to get the contamination
level within acceptable limits. One approach which could be utilized to reduce the time
of clean up is by ramping of the purge flow rate. Initially, smaller flow rate is passed
through the tubing mainly to clean the initial part of the tubing. This is then followed by
ramping of the flow rate to a higher value to clean the latter part of the tubing.
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7.7 MODEL APPLICATION
The model developed is a useful and powerful tool to predict scenarios under
which experiments cannot be performed or situations which arise unexpectedly. In this
section two different scenarios will be discussed.

7.7.1

Response of a System due to Impurity Perturbation
Impurity perturbations are common incidents which happens in a gas delivery

lines. This could arise from different situations such as fluctuation in pressure, opening
of a valve downstream, shutting of the source valve, etc. The model is used to study the
impurity response under step impurity upset. A step input of moisture impurity enters at
the inlet side and the response is measured at the outlet of the tubing or at the point of
measurement. The system is assumed to be in equilibrium and steady state with 10 ppb
of purge gas concentration. At time t = 0, a step type upset is introduced into the system.
Moisture concentration in the purge gas increases to 100 ppb for 30 minutes and then
goes back to 10 ppb. The system response for this input is simulated and studies. Three
different aspects of gas delivery lines are studied for the same step input upset. These are
the length of tubing i.e. the distance between the impurity intrusion and the point of
measurement, the tube diameter and the gas flow rate. Figure 7.13a show the system
response to step input for three different tube lengths: 1.5, 5 and 10 m. The tube diameter
for this case is 1/4 inch and gas flow rate 1000 sccm.
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Figure 7.13a Moisture levels at the outlet of the tubing for a step disturbance
for different tube lengths
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Figure 7.13b Moisture levels at the outlet of the tubing for a step disturbance
for different diameters
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Figure 7.13c Moisture levels at the outlet of the tubing for a step disturbance
for different purge flow rate

Figure 7.13b show the system response to step input for two different tube
diameters: 1/8 and 1/4 inch. The tube length is 10 m and gas flow rate is 1000 sccm.
Figure 7.13c show the system response to step input for two different gas flow rates:
1000 and 5000 sccm. The tube diameter is 1/4 inch and tube length is 10 m.
The above case studies help to have a better understanding of the system. This
study will be useful in designing gas delivery lines, and then one can decided that for
their specific system can they tolerate large upset for a short amount of time or a small
upset for a long amount of time.
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7.8 FUTURE WORK
Study of moisture interaction with EPSS surfaces has gained importance, especially due
to high construction cost in building semiconductor fabs. Following are some of the
work which could be further investigated:
a) Back Diffusion of impurities: Back diffusion of impurities especially near the tool
is gaining considerable importance. Mainly because the requirements for gas purity
in the tool has become more strict. Small variation in impurity concentration in the
tool can affect the process significantly.

Therefore, having fundamental

understanding of back diffusion theory and what level of flow rates should be
maintained in the tool so that the effect of back diffusion is minimized is an
interesting subject to investigate.
b) Comparison between cycle purge and conventional purge:

Often, in the

construction of fabs, large amount of UHP gas is used to clean the tubing. There are
mainly two approaches which could be used to clean the tubing. One is purging the
tubing with high flow rate constantly till the impurity concentration level reaches
within the acceptable limit, which is the conventional way of purging. The other
approach is to use cycle purge, in which the line is pressurized first and then the
pressure is released. This process is continued till the impurity concentration drops.
Knowing which of the two methods will reduce both gas consumption as well as time
for clean up will be helpful in reducing cost during the construction of the fabs.
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7.9 CONCLUSION
Design of ultra high pure gas delivery system has gained importance in last
several years due increase in demand of cleanliness in semiconductor processing. With
increase in construction cost of gas distribution system, it has become incumbent to have
a fundamental understanding of materials used in gas delivery lines. One such material
used is electropolished 316L stainless steel line. In this study, a methodology based on
experiments and modeling has been developed to characterize the electropolished
stainless steel surface. Moisture was chosen as the model compound in this study.
Moisture molecules exist on the surface both in the form of dissociated chemisorbed
species and physisorbed species. Experimental data shows that moisture removal from
EPSS surface is a slow process and the problem is exaggerated at low concentration level
(ppb) range.
A mathematical model which incorporates both the transport as well as kinetic
effects fits fairly well to the experimental data. The stainless steel tube is modeled as a
dispersion reactor along with reaction. It includes the effect of dispersion, convection as
well as adsorption and desorption.

Surface reactions are modeled as three layers,

chemisorptions on the first layer and physisorption on the higher layers.
The model is used to predict fundamental transport and kinetic parameters for
moisture interaction with EPSS surfaces. The parameters are estimated by fitting the
model to experimental data. Activation energies for rate of desorption of first layer is
higher than that of higher layers. The model developed is capable in prediction moisture
concentration at different locations in the gas distribution system, where measurement
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might not be possible. The model developed is also useful in predicting system response
under various system upset or moisture intrusion in certain part of gas distribution
system. It is also a useful tool in determining dry down times especially during the gas
distribution start up, where it is critical to know what levels of purge gas purity and flow
rate is required to achieve a certain level of clean up in the most efficient as well as cost
reduction way. The results of this work can be extended to study the effect of dead legs
on moisture dry down times as well as the flow rates required to prevent back diffusion.

288

CHAPTER 8
FUTURE WORK
In this research, fundamental understanding of moisture interaction with low-k
dielectric materials was investigated.

Characterization of absorption and desorption

behavior of moisture and methodology for impurity interaction with thin films have also
been developed. However, the importance of molecular impurity interaction is going to
further increase and become more complex as the minimum feature size decreases for
future technologies. Further investigation in the following areas is recommended:
1. Sorption study of other molecular impurities: Apart from moisture other molecular
impurities primarily organic based are of prime interest. Interaction of isopropanol,
ammonia and amines can interact with these films, which might outgas in subsequent
process causing integration problems.

So studying the sorption and desorption

characteristics of these films, will help to understand and design processes for effective
cleaning of these films.
2. Competitive absorption/desorption study: Often, low-k films are exposed to more
than one impurity. Therefore, it is important to study the combined effect of multiple
impurities interaction with these films.

It has been reported that for high–k films,

presence of moisture results in chemisorptions of IPA, where as IPA alone mainly
physisorbs on the surface. Thus, studying the combined effect of moisture and IPA with
low-k films is important to fully understand the outgassing effect.
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3. Effect of capping material on moisture uptake and retention: Various compounds
and materials have been used to cap or seal the pores of low-k dielectric films. These cap
layers are effective barriers against metal diffusion; however their effectiveness on
moisture intrusion and removal has not been adequately characterized. Therefore, to
understand which properties of capping materials prevent moisture uptake and enhances
moisture removal is critical and important for reliability of these films.
4. Correlating moisture uptake to the k value of the film: It is known that moisture
uptake increases the k value of the low-k dielectric films. In this research it was shown
that these films have high uptake capacity of moisture. Therefore, correlating k value to
moisture uptake will be very useful, for it will tell exactly what percentage of change in k
value is observed when exposed to certain level of moisture. Based on this study, one
can determine what level of moisture exposure is within the tolerable limit. ITRS update
for 2006 suggests that change in 2.5 % of k value is within acceptable range.
5. Relating etching and ashing chemistry to molecular interaction: As seen in this
research, that etching and ashing of low-k films changes the behavior of moisture
interaction. However, correlating and understanding why certain chemistry (oxidizing or
reducing) enhances or reduces moisture or organic impurities uptake and removal is
critical. This study will help in designing chemistry which will help in reducing impurity
uptake and outgassing.
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APPENDIX A
NUMERICAL SOLUTION FOR THE POROUS LOW-k FILM MODEL
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Numerical software Femlab was used to numerically solve the model developed for
transport of impurities in the porous low-k films (See Chapter 5). In this section step by
step method is shown how to formulate the model in Femlab.

Step 1: Define the dependent variables
There are three dependent variables used in the model.
Cs: Concentration in the matrix; f (t,z)
Cgp: Concentration in the pores; f (t,z)
Cgb: Concentration in the gas phase; f (t)
Model is solved for 1 dimension only. Open the femlab software and select 1D under
space dimension as shown below.
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To define Cs: Select COMSOL Multiphysics > Convection and Diffusion > Diffusion >
Transient Analysis.
Dependent variables: Cs; Application mode name: Matrix
Add to Multiphysics.
Similarly, define Cgp.
Dependent variables: Cgp; Application mode name: Pore
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To define Cgb: Select COMSOL Multiphysics > PDE Modes > Weak, Form Boundary >
Time-dependent analysis
Dependent variables: Cgb; Application mode name: Bulk
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Step 2: Define Geometry
The porous film is represented as a single straight line in 1D model.
Select: Draw > Draw Objects > Line
Draw a line from 0 to 1.
Given Film thickness is 100 nm or 1E-7 m.
Scale the line by factor of 1E-7. This line is known as sub-domain
Select: Draw > Scale
Line length is going to change depending on the film thickness. For etched and ashed
film two lines will need to drawn because the physical properties of damaged part are
different from non-damaged part.
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Step 3: Define Cs equation over the film thickness (sub-domain) and initial condition
Select Physics > Subdomain Settings
Based on the equation for Cs (See Equation 5.20), define Time-scaling coefficient;
Diffusion coefficient; and Reaction rate as shown below.

Under the “Init” tab define the initial value as Cgb0 * S (See Equation 5.20a)
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Step 4: Define boundary conditions for Cs
Define boundary conditions at 1 and 2 (See Equation 5.20b and c)
Select: Physics > Boundary Settings
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Step 5: Define Cgp equation over the film thickness (sub-domain) and initial condition
Select Physics > Subdomain Settings
Based on the equation for Cgp (See Equation 5.21), define Time-scaling coefficient;
Diffusion coefficient; and Reaction rate as shown below.

Under the “Init” tab define the initial value as Cgp0 (See Equation 5.21a)
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Step 6: Define boundary conditions for Cgp
Define boundary conditions at 1 and 2 (See Equation 5.21b and c)
Select: Physics > Boundary Settings
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Step 7: Define Cgb equation at the boundary 2 and initial condition
Select Physics > Boundary Settings
Based on the equation for Cgb (See Equation 5.22), define weak and dweak terms.
Deselect boundary condition 1.

Under the “Init” tab define the initial value as Cgb0 (See Equation 5.22a)
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Step 8: Define reaction terms Rs and Rg for surface moisture concentration (Cs) and pore
moisture concentration (Cgp) respectively.
Select: Options > Expressions > Subdomain Expressions
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Step 9: Define weak term W for Cgb
Select: Options > Expressions > Boundary Expressions
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Step 10: Define constants and initial value of the parameters
Select: Options > Constants
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Step 11: Mesh the subdomain
Select: Mesh > Refine Mesh
Mesh the subdomain to the desired mesh size by repeatedly selecting “Refine Mesh”
option.
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Step 12: Set Solver Parameters Settings
Select: Solve > Solver Parameters
Under “Solver Parameters Settings” set the time scale as shown below.

The above steps sets up the model defined in section 5. Solve the above model and find
the parameters that best fit the experimental data.
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APPENDIX B
NUMERICAL SOLUTION FOR THE EPSS TUBING MODEL
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Numerical software Femlab was used to numerically solve the model developed for
transport and reaction in EPSS tubing (See Chapter 7). In this section step by step
method is shown how to formulate the model in Femlab.

Step 1: Define the dependent variables
There are three dependent variables used in the model.
Cs: Concentration on the surface; f (t)
Cg: Concentration in the gas phase; f (t, z)
Model is solved for 1 dimension only. Open the femlab software and select 1D under
space dimension as shown below.
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To define Cg: Select COMSOL Multiphysics > Convection and Diffusion > Convection
and Diffusion > Transient Analysis.

Dependent variables: Cg; Application mode name: Reactor
Add to Multiphysics.
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Similarly, define Cs.
Select: COMSOL Multiphysics > PDE Modes > PDE, General Form > Time-dependent
analysis
Dependent variables: Cs; Application mode name: Surface
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Step 2: Define Geometry
The tubing is represented as a single straight line in 1D model.
Select: Draw > Draw Objects > Line
Draw a line from 0 to L. Where, L is the length of the tubing. In this example L is
chosen as 1. This line is known as sub-domain
Line length is going to change depending on the tubing length.
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Step 3: Define Cg equation over length of tubing and initial condition
Select Physics > Subdomain Settings
Based on the equation for Cg (See Equation 7.2), define Time-scaling coefficient;
Diffusion coefficient; Reaction rate; and velocity as shown below.

Under the “Init” tab define the initial value as Cg0 (See Equation 7.2a)
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Step 4: Define boundary conditions for Cg
Define boundary conditions at 1 and 2 (See Equation 7.2b n c)
Select: Physics > Boundary Settings
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Step 5: Define Cs equation over the length of tubing and initial condition
Select Physics > Subdomain Settings
Based on the equation for Cs (See Equation 7.1), define Flux vector; Source term; Mass
coefficient; and damping coefficient as shown below.

Under the “Init” tab define the initial value as Cs0 (See Equation 7.1a)
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Step 6: Define boundary conditions for Cs
Define boundary conditions at 1 and 2
Select: Physics > Boundary Settings
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Step 7: Define reaction term and dispersion coefficient term
Select: Options > Expressions > Subdomain Expressions
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Step 8: Define constants and initial value of the parameters
Select: Options > Constants
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Step 9: Mesh the subdomain
Select: Mesh > Refine Mesh
Mesh the subdomain to the desired mesh size by repeatedly selecting “Refine Mesh”
option.
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Step 10: Set Solver Parameters Settings
Select: Solve > Solver Parameters
Under “Solver Parameters Settings” set the time scale as shown below.

The above steps sets up the model defined in Chapter 7. Solve the above model and find
the parameters that best fit the experimental data.
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APPENDIX C
NOMENCLATURE
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Symbol

Description

Unit

A

Total surface area of tubing

cm2

Ap

Cross-sectional area of pore

cm2

As

Cross-sectional area of solid matrix

cm2

Total surface area of low-k film available for moisture
adsorption

cm2

c

Speed of light

cm/s

C

Capacitance

farads

Cc

Moisture concentration

Atot

ppm

Equilibrium moisture loading

mol/cm3

Cg

Gas phase moisture concentration in the tubing

mol/cm3

Cgb

Concentration of moisture in gas phase

mol/cm3

Cgb0

Initial concentration of moisture in gas phase
(challenge moisture concentration)

mol/cm3

Cgp

Concentration of moisture in pores

mol/cm3

Cgp0

Initial concentration of moisture in pores

mol/cm3

Cin

Concentration of moisture in purge gas

mol/cm3

CLL

Capacitance between two metal lines in the same layer

Cfilm0

farads
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Symbol

Description

Unit

CS

Moisture concentration in matrix

mol/cm3

CS0

Equilibrium moisture concentration in matrix

mol/cm3

Cv

Capacitance between two metal lines in different layers

d

CRDS cell length

cm

dd

Separation between two points to be
resolved in TEM

cm

Dg

Diffusivity of moisture in pore

cm2/s

Dmol

Molecular diffusion coefficient

cm2/s

D0

Pre-exponential factor for diffusivity

cm2/s

DS

Diffusivity of moisture in matrix

cm2/s

DS1

Diffusivity of moisture in the matrix of the top layer for
the patterned low-k film

cm2/s

DS2

Diffusivity of moisture in the matrix of the bottom
layer for the patterned low-k film

cm2/s

Dz

Dispersion coefficient

cm2/s

Ed

Activation energy of diffusivity

kJ/mol

Ep

Activation energy of permeability

kJ/mol

f

Frequency

farads

1/s
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Symbol

Description

Unit

fd

Fraction of gate that switches between during clock
period

none

Fv

Carrier gas volumetric flow rate

sccm

k

Dielectric constant

none

K

Permeation constant of device

none

kads

Adsorption rate constant

cm3/mol/s

kdes

Desorption rate constant

1/s

km

Interphase mass transfer coefficient between matrix and
pores

cm/s

kmg

Interphase mass transfer coefficient between pore and
bulk gas

cm/s

kms

Interphase mass transfer coefficient between matrix and
bulk gas

cm/s

l

Film thickness

cm

L

Interconnect line length

µm

n

Refractive index

N

Molecular density (concentration)

mol/cm3

Nj

Molar flux

mol/cm3

P’

Permeation rate

ng/min

None
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Symbol

Description

Unit

P

Line pitch or Line spacing

µm

P

Dynamic power

J/s

Pre-exponential factor for permeability

cm2/s x
cm3(gas)/cm3
(solid)

ps

Permeability

cm2/s x
cm3(gas)/cm3
(solid)

Q

Volumetric flow rate

r1

Radius of the pore

cm

r2

Distance between the two pores

cm

R

Resistance of the line

Ω

Rg

Universal gas constant

J/mol/K

Rm

Reflectivity of mirror

none

So

Surface site

S

Moisture solubility in matrix

cm3 (gas)/cm3
(solid)

S1

Moisture solubility in the top layer of the patterned
low-k film

cm3 (gas)/cm3
(solid)

S2

Moisture solubility in the bottom layer of the patterned
low-k film

cm3 (gas)/cm3
(solid)

p0

cm3/s

mol/cm2
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Symbol

Description

Unit

Sp

Specific surface area of porous film

1/cm

Sp1

Specific surface area of the top layer for the patterned
low-k film

1/cm

Sp2

Specific surface area of the bottom layer for the
patterned low-k film

1/cm

t

Time

s

T

Thickness of interconnect line

µm

u

Mean gas velocity

cm/s

U

DC voltage

volts

V

Supply voltage

volts

V’

Peak amplitude of an RF component

volts

Vv

Accelerating voltage

volts

Vr

Reactor volume

cm3

Vp

Volume of pore

cm3

Vs

Volume of solid matrix

cm3

Vt

Volume of tubing

cm3

X

Length of unit cell “A”

cm
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Symbol

Description

Unit

Y

Width of unit cell “A”

cm

Z

Distance from the bottom of low-k film

cm

α

Semi angular angle

none

ε

Film porosity

none

ε1

Film porosity of the top layer for the patterned film

none

ε2

Film porosity of the bottom layer for the patterned film

none

εo

Vacuum permittivity

F/m

ρ

Metal resistivity

Ωm

τ

Ring down time

s

φ

Applied potential

volts

λ

Wavelength of probing medium

σ

Absorption cross section area

υ

Laser frequency

cm
cm2/mol
hertz
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